Symantec Ghost Solution Suite 3.0 User guide

Legal Notice

Copyright © 2015 Symantec Corporation. All rights reserved.

Symantec, Altiris, the Symantec Logo, the Checkmark Logo are trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party (“Third Party Programs”). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 “Commercial Computer Software - Restricted Rights” and DFARS 227.7202, et seq. “Commercial Computer Software and Commercial Computer Software Documentation,” as applicable, and any successor regulations, whether delivered by Symantec as on premises or hosted services. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

- A range of support options that give you the flexibility to select the right amount of service for any size organization
- Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
- Upgrade assurance that delivers software upgrades
- Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
- Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

- Product release level
- Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan                customercare_apj@symantec.com
Europe, Middle-East, and Africa       seMEA@symantec.com
North America and Latin America       supportSolutions@symantec.com
Chapter 1  Introduction to Symantec Ghost Solution Suite  ................................................................. 12
  Introduction to Symantec Ghost Solution Suite ............................................................. 12
  Features of Ghost Solution Suite ...................................................................................... 15
  Managing from the Ghost Solution Suite console .......................................................... 15
  Managing computers ........................................................................................................ 16
  Building and scheduling deployment jobs ........................................................................ 17
  Imaging ............................................................................................................................. 19
  Migrating computers ........................................................................................................ 20
  Deploying and managing servers ...................................................................................... 20
  Get started ....................................................................................................................... 21

Chapter 2  Installing Ghost Solution Suite Server ....................................................................... 22
  Installing Ghost Solution Suite Server .............................................................................. 22
  Platform Support ............................................................................................................. 23
  Installing the Ghost Standard tools from the installer ....................................................... 25
  Browsing to the Ghost Recovery kit ................................................................................... 27
  Ghost Solution Suite Server components ....................................................................... 27
    Ghost Solution Suite Console ....................................................................................... 28
    Ghost Solution Suite Server ......................................................................................... 28
    Ghost Solution Suite Share ......................................................................................... 31
    PXE server .................................................................................................................... 32
  System requirements for installing Ghost Solution Suite ............................................... 33
  Simple install for Ghost Solution Suite Server .................................................................. 35
  Custom install for Ghost Solution Suite Server ............................................................... 38
  Thin client install .............................................................................................................. 42
  Component install ............................................................................................................ 45
  Installing Ghost Solution Suite Agents ........................................................................... 47
    Client connectivity and network adapters ..................................................................... 47
    Installing the Ghost Solution Suite agent ...................................................................... 48
    Remote agent installer .................................................................................................. 49
    Installing Ghost Solution Suite agent for Windows ..................................................... 52
    Automating the installation of Ghost Solution Suite agent .......................................... 52
Building new jobs ...................................................................................... 167
Job scheduling wizard ............................................................................... 168
  Select a job ......................................................................................... 168
  Select a computer or computer groups ............................................. 168
Setting conditions for task sets .............................................................. 168
Deployment tasks .................................................................................... 170
  Task names in a mixed-language environment ............................... 170
  Common Tasks .................................................................................. 170
  Supported Live Task Types .............................................................. 172
Creating a disk image ............................................................................. 174
  Creating a Mac image ....................................................................... 177
  Creating a Ghost image .................................................................... 178
  Advanced Sysprep settings for creating a disk image ...................... 179
  Advanced Sysprep settings for creating a disk image for Windows
    Vista and later versions ................................................................. 180
  Create disk image advanced ............................................................ 180
  Ghost Solution Suite Hot Imaging .................................................. 181
Distributing a disk image ........................................................................ 182
  Distributing a Mac image ............................................................... 185
  Distributing a Ghost image ............................................................ 186
  Advanced Sysprep settings for distributing a disk image ............... 187
  Advanced Sysprep settings for distributing a disk image in
    Windows Vista ................................................................................. 187
  Distribute disk image-resizing ......................................................... 187
  Distribute disk image-additional options ........................................ 188
Scripted OS install .................................................................................. 189
  Scripted install for Windows XP, Windows Server 2003 and
    earlier ............................................................................................ 190
  Select OS version and language ....................................................... 192
  Installation source files .................................................................... 193
  Operating system-source files ......................................................... 193
  Import an answer file ........................................................................ 194
  Answer file setup .............................................................................. 195
  Add a new section ............................................................................ 195
  Delete a section ............................................................................... 195
  Add a new variable .......................................................................... 196
  Command-line switches for scripted install ..................................... 196
  Ghost Solution Suite agent settings for scripted install ................. 197
  Scripted install summary ................................................................. 197
Scripted install for Windows Vista, Windows Server 2008, and
  later ..................................................................................................... 197
Scripted install for Linux ......................................................................... 199
  Scripted install summary ................................................................. 199
Introduction to Symantec Ghost Solution Suite

This chapter includes the following topics:

- Introduction to Symantec Ghost Solution Suite
- Features of Ghost Solution Suite
- Managing computers
- Building and scheduling deployment jobs
- Imaging
- Migrating computers
- Deploying and managing servers
- Get started

Introduction to Symantec Ghost Solution Suite

Take control of all your computer resources across your organization using Symantec Ghost Solution Suite deployment and management tools. Take a seat at Ghost Solution Suite console to remotely manage all types of devices—notebooks, desktops, switches, and servers—through all phases of computer deployment and lifecycle management. Schedule remote system upgrades, distribute patches and drivers, re-image computer hard drives, or migrate large groups of users to new computers without missing a single custom setting or installed program. Use Ghost Solution Suite to handle daily tasks and depend on it for occasional big jobs, such as disaster recovery or large-scale software updates. And do it all remotely from any Ghost Solution Suite console on any device with a connection to your WAN or LAN.
That is the attitude behind Ghost Solution Suite: increase access and productivity while decreasing costs and IT response time. You will appreciate the simple, easy-to-use graphical consoles to organize computer groups, schedule deployment jobs, and distribute disk image and update packages. It's easy. It's powerful. It conforms and scales to your infrastructure. Go ahead—take some time and learn to take control.

What can I do with Ghost Solution Suite?

Deploy. Manage. Migrate. Regardless of your organization's size or special IT requirements, Ghost Solution Suite provides a complete system to cut costs and improve response times for both big and small jobs.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage from a remote console.</td>
<td>Deploy, control, and manage all types of computers across your organization from a remote Ghost Solution Suite console. Use the feature-rich Ghost Solution Suite server Console for real-time management of computers. See “Managing from the Ghost Solution Suite console” on page 15.</td>
</tr>
<tr>
<td>Migrate data, applications, and personal settings.</td>
<td>Through easy-to-use wizards, migrate data and settings from a retiring computer to a new computer by capturing desktop, network, and application settings. Redeploy these personal settings remotely from a Ghost Solution Suite console. See “New job wizard” on page 162.</td>
</tr>
<tr>
<td>Upgrade and install software.</td>
<td>Manage system software on a day-to-day basis for desktops, servers, and notebooks to upgrade applications, install service packs, set up printer drivers, and modify systems as needed. Ghost Solution Suite provides upgrade capabilities for all mobile computers by deploying to remote sites as needed by traveling personnel. See “Distributing software” on page 200.</td>
</tr>
</tbody>
</table>
Table 1-1  Features of Ghost Solution Suite (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploy computers in large groups.</td>
<td>Easily deploy and configure large numbers of computers across an organization. Install hard disk images to groups of new or existing computer types using multicasting features. Install software and personality settings with common applications, data and drivers. Run post-configuration jobs or automated scripts to assign unique security IDs, configure user names, and set IP addresses using deployment jobs. See “Managing computers” on page 16.</td>
</tr>
<tr>
<td>Deploy and manage servers.</td>
<td>Manage all types of Web and network servers, including ultra high-density server board inserts. Automatically redeploy servers based on deployment history and saved server images, or use automated scripted installs with easy-to-create answer files. Operating systems can be installed as image files or run as scripted installs—or as a combination strategy (especially nice for managing ultra-dense server farms).</td>
</tr>
<tr>
<td>Respond to common help desk requests.</td>
<td>Remotely browse, diagnose, and repair problems on systems without ever leaving a Ghost Solution Suite console. Detailed hardware and software inventories, along with remote control and chat features simplify remote diagnosis of common problems. See “Remote operations using Ghost Solution Suite” on page 128.</td>
</tr>
<tr>
<td>Recover from disaster.</td>
<td>Ease the pain of accidents by automatically backing up and restoring configurations, personalities, registries, partitions, and drives remotely from a Ghost Solution Suite console. Saving the history of all deployment jobs assigned to a computer makes it easy to restore a system to a previous working state. See “Restoring a computer from its deployment history” on page 131.</td>
</tr>
</tbody>
</table>
Features of Ghost Solution Suite

Ghost Solution Suite can be installed and implemented locally as an independent Ghost Solution Suite server system on a single LAN segment or site.

Each Ghost Solution Suite server system includes services, applications, and utilities for high-bandwidth, real-time deployment.

Ghost Solution Suite server system

The Ghost Solution Suite console is a Windows user interface that provides full features to deploy computers, image hard disks, migrate user settings and programs, run scripted installs, remotely control computers, and perform other deployment tasks for all your computer resources. Daily IT requests and jobs formerly completed by visiting each desktop, server or portable computer in the organization can now be completed from your Ghost Solution Suite server Console.

Components of the Ghost Solution Suite server system can be installed on a single computer (a Simple install) or distributed across several local computers (a Custom install). A Custom installation lets you install Microsoft SQL Server and access the Ghost Solution Suite Database from a separate computer. The Ghost Solution Suite Share, Ghost Solution Suite server, PXE Server, and Ghost Solution Suite consoles can also be distributed to separate computers. The Ghost Solution Suite Console displays data directly from the Ghost Solution Suite Database.

Managing from the Ghost Solution Suite console

The Ghost Solution Suite Console (a Windows console) is included with the Ghost Solution Suite server system and provides complete deployment and management features. It is divided into several operational panes:

- The **Computers** pane displays all computer resources managed by a Ghost Solution Suite server system. It includes features to right-click and remotely execute operations on managed computers. From this pane, you can drag the computer icons to job icons to schedule deployment and management tasks.

- The **Jobs** pane executes and schedules deployment tasks for selected computers. Using one or more sequenced jobs, you can image, configure computer settings, distribute packages, and run scripts by dragging Job icons to individual computers or computer groups and scheduling a convenient time to execute. It lets you schedule deployment jobs by dragging computer icons to job icons, or vice versa.

- The **Details** pane provides information and features to filter computers by type and build deployment tasks. It extends the user interface features when working in the **Computers** and **Jobs** panes.
From the Ghost Solution Suite Console (the Windows console), a **Shortcut and Resources** pane organizes and provides easy access to .MSI files, .RIPs, image files (.img), Personality Packages (.exe), and other file types. It functions as a library for packages used when building jobs in the console.

In addition, the Ghost Solution Suite server Console provides easy-to-use wizards to simplify and expedite common deployment tasks.

See "Managing from the Ghost Solution Suite console" on page 15.

---

**Managing computers**

From the Ghost Solution Suite console, you can manage all types of computers to perform immediate deployment and management operations. From the **Computers** pane of the console, computer resources can be grouped by location, department, or type (portables, desktops or servers) and organized to reflect your environment. You can run operations, schedule deployment jobs, access computers or computer groups to change the network settings, run disk image, other deployment jobs.

The console identifies computers and computer groups with a unique icon. To access a computer, click the computer icon to view the configuration settings or run specific deployment and management operations. Computer icons can be dragged to job icons to schedule and run pre-configured deployment tasks from the Windows console. In the Ghost Solution Suite console, you can manage computers using drop-down lists, secondary dialog boxes, and other familiar web features.

See "Managing computers" on page 95.

**Managing with computer icons**

Icons displayed in the Computers pane of the console help in identifying the computer types and deployment status. Group icons can be expanded to view the member computers, and computer types can be identified by specific icons: desktops and notebooks, servers, computer groups, and Linux computers. Computer icons can also identify the state of the managed computer—a logged-on user, a computer waiting for further instructions, a user not logged on and other states of deployment-when performing operations or executing deployment tasks on a selected computer.

See “Viewing computer details” on page 97.

This icon identifies a managed desktop or notebook computer that is active and has a user logged on.
This icon identifies a managed Windows network or Web server that is active and has a user logged on.

This icon identifies a Linux computer.

This icon identifies a pre-configured computer account with user account settings that are not associated with a new computer.

Additional icons represent deployment status, inactive computers, computers running a deployment job, and new computers.

See “Viewing computer details” on page 97.

**Immediate management access from the console**

From a Ghost Solution Suite console, you can select a computer and start various computer configuration and management operations for a specific computer in your system. You can create new deployment tasks, restart, restore the hard drive, view deployment history, and perform other advanced tasks using the commands on this menu. Some operations—such as changing configuration settings, copying files, and creating quick disk images—create job files automatically.

**Remote operations using Ghost Solution Suite** For complete information about Ghost Solution Suite consoles, See “Managing from the Ghost Solution Suite console” on page 15.

**Building and scheduling deployment jobs**

Jobs are designed as objects with defined deployment tasks. Jobs can be built, organized, and scheduled to run on selected computers or computer groups from a Ghost Solution Suite console. You can build and schedule jobs from any of the Ghost Solution Suite consoles.

Deployment jobs give you the ability to organize, store, and assign administration tasks for each computer or computer group. You can create and deploy images, back up registry files, run scripted installs, or make post-imaging changes such as adding printers and applications. You can deploy and run packages—RIPs, images, personality packages, MIS programs, and others—to migrate applications, configure computer settings, deploy complete hard disk images, and much more. You can also assign jobs with conditions to run only on defined computer types.

See “Building and scheduling jobs” on page 159.
Jobs are built in the Ghost Solution Suite server Console by creating a job name (identified by a job icon in the console) and adding predefined deployment tasks. Tasks such as Distribute Software, Run Script, or Create Disk Image are added and executed sequentially when scheduled to run on computers or computer groups. And even within computer groups, different jobs can be assigned to different computer types based on the operating system, hardware, or other specified conditions.

See “Deployment tasks” on page 170.

When a job is built, it can be scheduled to run immediately, at desired intervals, or at any other convenient time when the bandwidth is low. In addition, you can use bandwidth throttling features to schedule and run deployment tasks to large groups without affecting network traffic.

See “Deployment tasks” on page 170.

From the Ghost Solution Suite Console, you have several options to create deployment jobs:

- Create common deployment tasks quickly and easily using the New Event Wizard.
- Import jobs from other Ghost Solution Suite systems.
- Manually create deployment tasks from the console.
- Copy and paste deployment tasks from within the console.

See “Building new jobs” on page 167.

In the Jobs pane, you can create and organize deployment jobs. You can then assign jobs by dragging icons to the desired computer or computer group.

Building jobs

Building jobs includes creating a new job and then adding tasks to the job to run in sequence when scheduled on selected computers. You can build jobs by adding tasks manually or you can step through the New Job Wizard to create common jobs and schedule them. Sample tasks are also included with Ghost Solution Suite to use as installed or to easily customize and run.

See “New job wizard” on page 162.

After creating and building a job, you can then assign it to a computer and schedule it to run at any time—immediately, after a specified time, or on a daily, weekly, or monthly schedule. The deployment status of each job is reflected in the console.

Assigning deployment jobs with icons

Computer icons are used to identify the types of computers in a console. Similarly, job icons identify the status and success of a scheduled deployment job. After
scheduling jobs, you can monitor the progress as the job icons are updated at each step of execution.

This job is assigned to a computer, but is not scheduled to run. Until scheduled, this job icon remains unchanged.

This job is assigned to the computer and is scheduled to run either immediately or in the future.

This job is currently in process.

This job has completed successfully.

See “Viewing job details” on page 160.

Scheduling jobs

From the Schedule Job dialog, you can run jobs immediately or schedule the job to run in batches at defined intervals. You can also assign the job to repeat every hour, day, or week. Scheduling jobs can be as simple as clicking OK to run immediately or as sophisticated as required to meet your deployment needs.

For complete information about building and scheduling deployment jobs, See “Building and scheduling jobs” on page 159.

Imaging

A primary task of Ghost Solution Suite is to capture an image (a clone of the hard drive) from a reference computer and distribute the image to set up new computers or reinstall computers to their basic configuration. You can create a library of image files on the Ghost Solution Suite Share (file server storage) and schedule image jobs to different computer types as required.

Ghost Solution Suite server lets you push down a boot image remotely and execute the image using PXE Server, eliminating the need to physically attend and boot each managed computer.
Imaging from Ghost Solution Suite server

Ghost Solution Suite server includes multiple features to capture an image and lay it down to a new or existing computer. You can use the Ghost Solution Suite Console to create and distribute disk images using deployment tasks, such as the Quick Disk Image wizard shown below:

Pre-boot environments let you boot to automation to create and deploy images, back up and restore a computer's registry file, or run other automation tasks. You can also boot to a Network Server and run imaging files and other commands.

See Boot Disk Creator Help and PXE Configuration Utility Help.

Migrating computers

Ghost Solution Suite provides various options to migrate operating systems, computer personalities, software, or entire hard disk images. You can accomplish migration tasks individually or as a single job.

The New Job Wizard steps you through each migration option, letting you capture a complete hard disk image (to upgrade to a new computer), migrate a user to another operating system with the same personality settings and applications, or to simply move personality settings from one computer to the another. Using the New Job Wizard is one of the easiest ways to build deployment tasks to migrate user data and settings.

Ghost Solution Suite lets you build sophisticated deployment jobs that automatically migrate personalities, including deployment tasks to capture the user's personality, migrate the operating system and software, and reconfigure the computer with the user's original personality settings. You can also edit Personality Packages or Rapid Install Packages (.RIPs) using the PC Transplant Editor and the Wise MSI Editor tools from the Ghost Solution Suite server Console.

Deploying and managing servers

Ghost Solution Suite includes features designed specifically for deploying and managing network or Web servers. Server-specific features include scripted installs for initial installation, and support for remote management cards, multiple network adapters, history transfers to support rip and replace redeployment, and additional functionality required for automating server management.

Ghost Solution Suite also integrates with other hardware vendors to provide systems and tools to manage large server installations and support automatic deployment.
strategies. These unified systems simplify and automate server configurations and large-scale migrations, and support emerging hardware for ultra high-density server systems.

From a Ghost Solution Suite console you can build deployment jobs to run scripted installs for Windows and Linux servers. You can run these unattended installs directly over the network for individual Web or network servers. You can create answer files for each scripted install from a Ghost Solution Suite console.

You can also run server-specific scripts and redeployment tasks. Enhanced task logging and history tracking features let you recall deployment actions to quickly redeploy mission-critical servers.

Get started

Ghost Solution Suite is a full-featured remote deployment system designed to manage computer devices across all types and sizes of small to medium organizations and large enterprises. It includes Windows components to design and scale a system for your specific IT needs and challenges. Ghost Solution Suite provides a wide array of tools, utilities, and applications to design a system for your specific needs. Ghost Solution Suite is easy-to-use and adaptable to your environment.

You can design and install a Ghost Solution Suite server system specific to your hardware, organizational structure, network architecture, and other environmental variables. The installation and configuration process lets you install Ghost Solution Suite components (database, services, network share, user interface console) to a single computer or distribute components to separate role servers.
Installing Ghost Solution Suite Server

This chapter includes the following topics:

- Installing Ghost Solution Suite Server
- Platform Support
- Installing the Ghost Standard tools from the installer
- Browsing to the Ghost Recovery kit
- Ghost Solution Suite Server components
- System requirements for installing Ghost Solution Suite
- Simple install for Ghost Solution Suite Server
- Custom install for Ghost Solution Suite Server
- Thin client install
- Component install
- Installing Ghost Solution Suite Agents

Installing Ghost Solution Suite Server

Ghost Solution Suite Server is a flexible, scalable computer deployment and management system that can be installed and configured on a single computer, or installed across several computers to distribute processing for large enterprise environments. You can run a Simple install to position all Ghost Solution Suite Server Components on a single computer (most frequently used), or plan and
perform a Custom install to distribute installation of components across separate computers in the site.

See “Ghost Solution Suite Server components” on page 27.

After installing Ghost Solution Suite Server components, you can remotely install Ghost Solution Suite Agents on all types of computer resources across your organization: laptops, LAN and Web servers, network switches, and so on. Windows computers and Linux computers can be managed as a unified environment, with each client communicating through its own Ghost Solution Suite agent to update inventory data and react to Ghost Solution Suite Server commands and deployment tasks.

Select one of the following methods for installing a Ghost Solution Suite Server system:

- Simple install for Ghost Solution Suite Server
  Install all components on local computer

- Custom install for Ghost Solution Suite Server
  Installs components on remote or local computers and lets you customize options.

- Thin client install
  Installs GSS Thin client view.

- Component install
  Installs additional Ghost Solution components.

- Ghost Recovery Kit
  Lets you browse to the Ghost Recovery Kit.

- Ghost Standard Tools
  Launches the Symantec Ghost Standard Tools installer that lets you install the Symantec Ghost Standard Tools.

To install Ghost Solution Suite Agents on the client computer, refer to the following section:

See “Installing Ghost Solution Suite Agents” on page 47.

Platform Support

This section lists the supported platforms for Ghost Solution Suite 3.0:
<table>
<thead>
<tr>
<th>Platform</th>
<th>Client</th>
<th>Server</th>
<th>File Server</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7, including Embedded Standard, Professional, Enterprise, and Ultimate editions</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 2008 Core</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008 (x86 and x86_64), including R2 and SP2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows XP SP3</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMWare ESX Server 4.0 (vSphere)</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMWare ESX Server 3.5</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMWare ESX Server 3.0</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.6</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.7</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.8</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.9</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Support is provided for VMware ESX Server scripted installations.
## Table 2-1  
**Platform support matrix for Ghost Solution Suite 3.0 (continued)**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Client</th>
<th>Server</th>
<th>File Server</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X 10.10</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 6.5</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 11</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 11 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 11</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 10</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 10 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 10</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 9</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 9 x86_64</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux Enterprise Server 9</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debian Linux 5 (and prior) Stable</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solaris SPARC 8, 9 (production agent only)</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetWare 6.5</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

**Installing the Ghost Standard tools from the installer**

Ghost Solution Suite lets you install the Ghost Standard tools from the link that is provided in the installer. The Ghost Standard tools include the following:

- Boot Disk Creator.exe
- Ghost Explorer x64.exe
The Ghost Standard tools are installed at the following location and are accessible from the Start menu:

<Install_dir>/Program Files(x86)/Symantec/Ghost

To install Ghost Standard tools

1. Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.

2. Launch the appropriate Symantec Ghost Solution Suite installation file and follow the setup steps.

3. The Symantec Packager Self-Extracting Executable Options dialog appears.

4. Select the **Use current temp folder** option to use the current temporary folder to download installation files or the **Extract to a specific folder** option to set a path to an existing folder to download the installation files.

5. Click **Extract and Execute App** to extract and execute the application immediately.
   
The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll already exists, a prompt appears, asking whether you want to overwrite this file. Click **Yes to All**. You may have to wait for some time while Symantec Packager extracts files from this archive.

**Note:** Click **Extract Only** to only extract the application and execute the application later. You must run the axInstall.exe file to start the installation.

6. In the Ghost Solution Suite Server Install Configuration dialog, click on Ghost Standard Tools.

7. In the Symantec Ghost Standard Tools wizard, the default path where the Ghost Standard Tools executables are installed is displayed as follows:

   C:\Program Files(x86)\Symantec\Ghost

   To change the path where the Ghost Standard Tools executables are installed, click on **Change**.

8. Click **Next >**.

9. Click **Install**.
Browsing to the Ghost Recovery kit

The Ghost Solution Suite lets you browse to the Ghost Recovery Tool kit at the following location:

<Install_Dir>:\DSSetup\Ghost_recovery_Kit.zip

Symantec Ghost Recovery Kit is a suite of tools designed for original equipment manufacturers (OEMs) and value-added resellers (VARs). It adds tools and functionality to the applications included in Symantec Ghost Solution Suite. Symantec Ghost Recovery Kit includes the following tools:

- GhostOEM32
  GhostOEM32 is a Win32 version of GhostOEM and is designed to run on Microsoft Windows Preinstallation Environment (WinPE).

- GhostOEM64
  GhostOEM32 is a Win64 version of GhostOEM and is designed to run on Microsoft Windows Preinstallation Environment (WinPE).

- PQIDeploy
  PQIDeploy is an OEM version of Symantec ImageCenter that provides restore-only capabilities. It contains the full scripting capabilities that are included in ImageCenter. It does not include any graphical user interface (GUI). All commands are specified in a script command file.

- PQIDplyD

- SRFixMbr
  The System Recovery Fix MBR executable installs the Boot Partition Selector in the Master Boot Record (MBR).
  The Boot Partition Selector requests which partition the end user wants to launch when the computer is booted from the primary hard drive. If no response is made within the timeout interval, then the user partition is launched. Alternatively, the end user can launch the recovery partition. The end user can access the recovery partition only through the Boot Partition Selector.

Ghost Solution Suite Server components

The Ghost Solution Suite Server system includes the following components:

- Ghost Solution Suite Console
  See “Ghost Solution Suite Console” on page 28.

- Ghost Solution Suite Server
  See “Ghost Solution Suite Server” on page 28.

- Ghost Solution Suite Database
You can install all these components on the same computer or distribute them across multiple computers, depending on the environment.

**Ghost Solution Suite Console**

The Ghost Solution Suite Console is the Win32 user interface for Ghost Solution Suite. You can install this Windows console on computers across the network to view and manage resources from different locations. In addition, from this console, you can access the Ghost Solution Suite Database on other Ghost Solution Suite Server systems to manage sites across the enterprise.

See “Ghost Solution Suite Database” on page 30.

See “Connecting to another Ghost Solution Suite server” on page 92.

The Ghost Solution Suite Console communicates with the Ghost Solution Suite Database and Deployment services. In a Simple Install for Ghost Solution Suite Server, the Ghost Solution Suite Console is installed on the same computer similar to all other components. In a Custom Install for Ghost Solution Suite Server, you must ensure that a connection is available to these computers and security rights are set. You must have administrative rights on any computer running the Ghost Solution Suite Console.

See “Simple install for Ghost Solution Suite Server” on page 35.

See “Custom install for Ghost Solution Suite Server” on page 38.

**Ghost Solution Suite Server**

Ghost Solution Suite Server controls the flow of the work and information between the managed computers and the other Ghost Solution Suite Server components (Ghost Solution Suite Console, Ghost Solution Suite Database, and the Ghost Solution Suite Share). Managed computers connect and communicate with the Ghost Solution Suite Server to register inventory and configuration information and
to run deployment and management tasks. The computer and deployment data for each managed computer is stored in the Ghost Solution Suite Database.

**Note:** To view, start, or stop Ghost Solution Suite Server, go to the Symantec Server services in your Windows Manager.

Managed computers require access to the Ghost Solution Suite Server at all times, requiring that you have administrative rights on the computer running the Ghost Solution Suite Server.

Create a user account to run the Ghost Solution Suite Server. The service runs as a logged-on user, not as a system account. You must create this account on all Ghost Solution Suite Server computers. The account must have full rights to the Ghost Solution Suite Share. The account must have a non-expiring password.

See “Ghost Solution Suite Share” on page 31.

Assign a static IP address to the Ghost Solution Suite Server computer. Other components cannot connect to the Ghost Solution Suite Server if you use DHCP and dynamically change the IP address.

To install the Ghost Solution Suite Server on a remote computer, the default administration shares must be present. Restore any shares that have been removed before you install the Ghost Solution Suite Server.

**Note:** It is easier to create an administrative account using the same name and password on all computers than to use the existing name and password of each account.

Most packages (.RIP, Personality Packages, and .MSI files) pass through the Ghost Solution Suite Server. Therefore, if you store these files on the Ghost Solution Suite Server, the deployment of these packages is faster. Image files, however, are sent directly from the Ghost Solution Suite Share to the client computer when you run an imaging task.

See “Ghost Solution Suite Server components” on page 27.
Ghost Solution Suite Database

You can install the Ghost Solution Suite Database on Microsoft SQL Server™ 2014 Express edition.

**Note:** In Ghost Solution Suite 3.0 and later, if you have already set up multiple instances of the Microsoft SQL Server, you can identify a specific instance using this format: `<database instance>\express`. Example: If you have a clustered Microsoft SQL Server named SQLClusterSvr to manage multiple Ghost Solution Suite systems on different network segments, you can enter the name SQLClusterSvr\salesSegment or SQLClusterSvr\marketingSegment during the Ghost Solution Suite Server setup, depending on the previously established database instance. This feature is supported in the silent install .INI file and the GUI install executable.

The database maintains the following information about the managed computers:

- **Hardware.** RAM, asset tag, and serial numbers
- **General Information.** Computer name and MAC address
- **Configuration.** TCP/IP, Microsoft networking, and user information
- **Applications.** The installed applications and information about these applications, such as the name of the application, publisher, and product ID
- **Services.** Installed Windows services
- **Devices.** Installed Windows devices, such as network adapter, keyboard, and monitors
- **Location information.** Contact name, phone, e-mail, department, mail stop, and site

The Ghost Solution Suite Server Database also contains jobs and other data used to manage your computers.

**Note:** You can install a single Ghost Solution Suite Database in each Ghost Solution Suite Server system—you cannot have two databases storing data for a single computer. If the computer you are installing the database on has an existing Microsoft SQL Server™, the Ghost Solution Suite Database is added to that instance of the database engine.

Support for multiple database instances

In Ghost Solution Suite 3.0, you can identify a named instance of the Microsoft SQL Server when installing Ghost Solution Suite. You can now identify other named
instances of Microsoft SQL Servers instead of accessing only the default instance. This feature lets you identify and run multiple databases from one clustered Microsoft SQL Server to manage multiple sites or network segments. This feature is supported in the silent install .INI file and the GUI install executable. Ghost Solution Suite also supports a different name for the Ghost Solution Suite Database instead of the default name, eXpress.

See “Custom install for Ghost Solution Suite Server” on page 38.

See “Ghost Solution Suite Server components” on page 27.

Ghost Solution Suite Share

The Ghost Solution Suite Share is a file server or shared directory where Ghost Solution Suite program files and packages are stored. The Ghost Solution Suite Share can be a shared directory (default Simple install in Program Files\Altiris\eXpress\Deployment Server) or another file server (in the Custom install, you can assign a Microsoft Windows or Novell NetWare file server).

Ghost Solution Suite Share is where you store image files, registry files, .MSI packages, Personality Packages, script files, and more. When you are deploying or managing a computer, the Ghost Solution Suite Server stores and retrieves these packages from the Ghost Solution Suite Share as needed.

If you want to install Ghost Solution Suite on a remote file server (not the computer where you are running the install program), create a share (or give Read/Write rights for NetWare) on the file server where you want to install the Ghost Solution Suite Server. This share must allow access to all other components, including managed computers and the user account that runs the Ghost Solution Suite Server.

You must create this share before you begin installing. If you are not installing on a remote computer, you can select the option to create the share during the installation.

Note: You can install only one Ghost Solution Suite Share for each Ghost Solution Suite Server system. However, if the Ghost Solution Suite Share’s hard drive gets full, other computers can be used as additional backup storage points. In some cases, other systems emulating a Microsoft or NetWare environment can be used as the Ghost Solution Suite Share.
Note for NetWare users: If you have a problem using the Novell NetWare server as a Ghost Solution Suite Share, install the Novell Client instead of the Microsoft NetWare Client.

See “Ghost Solution Suite Server components” on page 27.

**PXE server**

The PXE Server provides service to client computers on a subnet. When the Ghost Solution Suite Server sends a deployment job, the client computer receives a request to boot to automation and the PXE-enabled computers connect to the first PXE Server that they discover, which communicates with the Ghost Solution Suite Server and the client computers.

You can install a PXE Server on a Microsoft Server 2003, Windows 2000 Server, Advanced Server. The PXE Server also functions on the same protocols as a standard DHCP Server, so you can place the PXE Server wherever you would place a DHCP server. You can also install as many PXE Servers as required in your system, but you must also install a DHCP Server.

The PXE Server sends a boot menu option list to the client when the computer performs a PXE boot. The deployment job, which contains at least one automation task, uses the default automation environment or the environment specified by a user who has the permission to create a deployment job. Use the boot menu option to request the PXE Server for the boot menu files and download the boot menu files from the PXE Server to the client computer's RAM storage. The client computer always boots according to the request and reply communications taking place between the Deployment and PXE Servers.

Ghost Solution Suite supports Linux, and Windows PreInstallation Environment (WinPE) as pre-boot environments. These options let you create a single job, but may contain multiple automation tasks. The default automation environment (the first pre-boot operating system files installed during the Ghost Solution Suite installation) is used for Initial Deployment, unless you specify otherwise.

Using a PXE Server to boot client computers to automation saves you from having to install an automation partition on each client computer's hard disk, or from manually starting computers using Symantec Ghost Solution Suite supported bootable media.

See Boot Disk Creator Help and see PXE Configuration Utility Help.

See “Pre-boot operating system (simple)” on page 59.

See “Install automation partition ” on page 142.
DHCP Server

The DHCP (Dynamic Host Configuration Protocol) server is a server set up to assign TCP/IP addresses to the client computers. This server is not a Symantec product, but is required if you want to use the PXE Server.

We recommend that you use DHCP to manage the TCP/IP address in your network, whether you use PXE or not. This greatly reduces the amount of time required to set up and manage your computers.

See “Ghost Solution Suite Server components” on page 27.

System requirements for installing Ghost Solution Suite

The following list includes the minimum system requirements for installing Ghost Solution Suite:

System requirements for installing Ghost Solution Suite:

- Ghost Solution Suite (GSS) Agent
  GSS Agents require network connectivity and around 9 MB disk space. Other system requirements are the same as the host operating system.

- Ghost Solution Suite Server
  Symantec recommends running the GSS Server components on a modern, dedicated server with Pentium 4 processor and 2GB of RAM.

- Computers hosting additional PXE servers and file shares should meet the requirements of the operating system hosting these components.

- Automation Requirements
  Microsoft recommends 512 MB of memory for computers booting WinPE. At a minimum, you should have 384 MB to avoid boot errors.

- If the SQL Server 2014 Express database is installed from within the GSS 3.0 installer, then .NET framework 3.5 must be installed.
  For more information on system requirements for installing SQL Server 2014 Express, see the following URL:

  **Note:** If you face an error while installing SQL Server Express, Symantec recommends checking if all the Windows updates are installed.

- For WinPE 5.1, .NET 4.5 Framework should be installed before importing the Windows ADK 8.1.
## Ports and Protocols used in Ghost Solution Suite 3.0

The following table lists the ports that are used in Ghost Solution Suite 3.0:

### Table 2-2  
Ports used in Ghost Solution Suite

<table>
<thead>
<tr>
<th>Component</th>
<th>Service</th>
<th>Port(s)</th>
<th>Protocol</th>
<th>Where is this port connected?</th>
<th>Is this port configurable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>PXE MTFTP</td>
<td>MTFTP</td>
<td>69</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1758</td>
<td>UDP (Multicast)</td>
<td>PXE Client</td>
<td>Yes [Configure by editing PXE.ini file]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1759</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PXE Server</td>
<td>PXE Server</td>
<td>67</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>68</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4011</td>
<td>UDP</td>
<td>PXE Client</td>
<td>No</td>
</tr>
<tr>
<td>PXE Manager</td>
<td>PXE Manager</td>
<td>405</td>
<td>TCP</td>
<td>PXEConfig</td>
<td>Yes [Configure by editing RPC.ini file]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>406</td>
<td>TCP</td>
<td>PXECfg Service</td>
<td>Yes [Configure by editing RPC.ini file]</td>
</tr>
<tr>
<td>PXECfg Service</td>
<td>PXECfg Service</td>
<td>407</td>
<td>TCP</td>
<td>PXE Server and PXE MTFTP</td>
<td>Yes [Configure by editing RPC.ini file]</td>
</tr>
<tr>
<td>DB Management (mm)</td>
<td>DB Management</td>
<td>505</td>
<td>TCP</td>
<td>Win32 console, axengine, pxemanager</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ghost Solution</td>
<td>Axengine</td>
<td>402</td>
<td>TCP/UDP (multicast)</td>
<td>Agents, pxeserver, DataManager, PXEManager</td>
<td>Yes</td>
</tr>
<tr>
<td>Suite Server</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 2-2  Ports used in Ghost Solution Suite (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Service</th>
<th>Port(s)</th>
<th>Protocol</th>
<th>Where is this port connected?</th>
<th>Is this port configurable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux Agent</td>
<td>ADLagent</td>
<td>415</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AClient</td>
<td>AClient</td>
<td>402</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PCT Real-time Destination Agents</td>
<td></td>
<td>4949</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3829</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4950</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4951</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4952</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Simple install for Ghost Solution Suite Server

The Simple Install option places all the Ghost Solution Suite Server Components - Ghost Solution Suite Server, Ghost Solution Suite Console, Ghost Solution Suite Share, and Ghost Solution Suite Database - on the same computer.

See “Ghost Solution Suite Server components” on page 27.

You can install the Ghost Solution Suite Server with a Microsoft Desktop Engine (MSDE) by using the Simple Install.

SYMANTEC ghostsolutionSolutionWin\_ (version) installs all Windows components of Ghost Solution Suite. Using the Simple Install option, you can install MSDE 2000 on a local computer if a database is not already installed.

**Note:** Simple installation works only with a default Microsoft SQL 2000, SQL 2005, SQL 2014, or MSDE install.
To run a simple install

1. Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.
   
   See “PXE server” on page 32.

2. Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

   The Symantec Packager Self-Extracting Executable Options dialog appears.

3. Select the Use current temp folder option to use the current temporary folder to download installation files or the Extract to a specific folder option to set a path to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.

   The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll already exists, a prompt appears, asking whether you want to overwrite this file. Click Yes to All. You may have to wait for some time while Symantec Packager extracts files from this archive.

   **Note:** Click Extract Only to only extract the application and execute the application later. You must run the axInstall.exe file to start the installation.

5. Select the Simple Install option from the installation types listed in the Ghost Solution Suite Server Install Configuration dialog.

6. (Optional) Select the Include PXE Server option to install the PXE Server and click Install.

   See “PXE server” on page 32.

7. Click Yes on the Software License Agreement page.

8. Enter the following information on the Ghost Solution Suite Share Information page:

   - In the File Server path field, enter or browse to the path to install the Ghost Solution Suite Server program files. The default path is C:\Program Files\Altiris\eXpress\Deployment Server.
   - Select the Create Ghost Solution Suite Share option to create a Ghost Solution Suite Share on the computer. The Ghost Solution Suite Share lets you store files on the computer and run Ghost Solution Suite Server system applications.

   See “Ghost Solution Suite Share ” on page 31.
- Browse and select the licence file.
- You must enter an administrator user name and password for the Ghost Solution Suite Server. This account must already exist on the Ghost Solution Suite Share and the Ghost Solution Suite Server. By default, the name you are currently logged on as appears. If you use a domain account, enter the domain and the user name (Example: Domain1\administrator).

    **Note:** If a previous installation of the Ghost Solution Suite Database is detected, an axinstall prompt appears, asking whether you want to preserve or overwrite the existing database. Click Yes to preserve the data in your Ghost Solution Suite Database.

9  Click **Next**. The **Pre-boot Operating System** page appears.

10 Select a default pre-boot operating system from any one of the options, such as Linux, WinPE, or **None**. Browse to locate the FIRM file Linux operating systems or the operating system files and WinPE. Click **Next**. The **Installation Information** page appears, displaying the components that you selected to install.

11 Click **Install** to install the listed components, or click **Back** to modify the settings before starting the installation. The installation process begins and can take several minutes. The **Installation Information Summary** page appears after the installation completes.

    **Note:** If you are upgrading your installation, the message **Do you want to replace the share?** appears. Click Yes and continue. If you click No, a message appears, stating that the share is already in use and you need to manually set the share to point to the correct directory. Click **OK**.

12 (Optional) You can select the following option to install agents.

    - **Remotely install Ghost Solution Suite agent (Windows Vista, 2008 or later only)**. Select this option if you want to push the Ghost Solution Suite
agent to computers running Windows Vista, Windows 2008, or later operating systems.

13 Click Finish.

You have successfully completed a Simple Install for a Ghost Solution Suite Server system. Click the Ghost Solution Suite Console icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

**Note:** Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Ghost Solution Suite Server Win32 Console, the "Unable to connect to the Symantec Ghost Solution Suite Server Management Server. Please ensure this service is started and running currently." error appears. This occurs because the service files are deleted by the antivirus application during scanning. To resolve this issue, disable the antivirus software and reinstall the Ghost Solution Suite Server.

See "Custom install for Ghost Solution Suite Server" on page 38.

**Custom install for Ghost Solution Suite Server**

The Custom Install option lets you distribute all the Ghost Solution Suite Server Components - Ghost Solution Suite Server, Ghost Solution Suite Console, Ghost Solution Suite Share, and Ghost Solution Suite Database - on different computers. You can install Ghost Solution Suite Server with a Microsoft Data Engine (MSDE) or install it on an existing SQL Server.

See “Ghost Solution Suite Server components” on page 27.

To run a custom install

1 Start the server and log on as the administrator account you created for the Ghost Solution Suite Server.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

   The **Symantec Packager Self-Extracting Executable Options** dialog appears.
3 Click the **Use current temp folder** option to use the current temporary folder to download installation files or the **Extract to a specific folder** option to set a path to an existing folder to download the installation files.

4 Click **Extract and Execute App** to extract and execute the application immediately.

   The default installation directory is `C:\DSSetup`. If the file `C:\DSSetup\AppLic.dll` already exists, a prompt appears, asking whether you want to overwrite this file. Click **Yes to All**. You may have to wait for some time while Symantec Packager extracts files from this archive.

   **Note:** (Optional) Click **Extract Only** to only extract the application and execute the application later. You must run the `axInstall.exe` file to start the installation.

5 Select the **Custom Install** option from the installation types listed in the **Ghost Solution Suite Server Install Configuration** dialog if any of the following conditions exist:

   - You are using the NetWare file server as a Ghost Solution Suite Share.
   - You are managing many computers and require a distributed architecture to meet bandwidth restrictions and other design requirements.

6 Click **Install**. Click **Yes** on the **Software License Agreement** page.

7 Enter the following information on the **Ghost Solution Suite Share Information** page:

   - In the **File Server path** field, enter or browse to the path to install the Ghost Solution Suite Server program files. The default path is `C:\Program Files\Altiris\eXpress\Ghost Solution Suite Server`.

   - Select the **Create Ghost Solution Suite Share** option to create a Ghost Solution Suite Share on the computer. The Ghost Solution Suite Share lets you store files on the computer and run Ghost Solution Suite Server system applications. The Ghost Solution Suite Share can exist on a Microsoft Windows server or Novell NetWare server.

   **Note:** You can only create the share if it is on a Microsoft Windows Server; the Novell share should already be set up. See “**Ghost Solution Suite Share**” on page 31.

   - Browse and select the (.SLF) licence file.
Enter the following information on the **Ghost Solution Suite Server Information** page:

- Select the computer where you want to install the Ghost Solution Suite Server. You can install the Ghost Solution Suite Server on the local computer or on a remote computer. The IP address and the port information for the selected computer are displayed by default.
- Enter the path where you want to install the Ghost Solution Suite Server.
- You must enter an administrator user name and password for the Ghost Solution Suite Server. This account must already exist on the Ghost Solution Suite Share and the Ghost Solution Suite Server. By default, the name you are currently logged on as appears. If you use a domain account, enter the domain and the user name (Example: Domain1\administrator). (See "Installing Ghost Solution Suite Server" on page 22.) Click **Next**.

Enter the **Ghost Solution Suite Database** information and click **Next**.

- Specify the Microsoft SQL Server Instance where you want to install the database. See Ghost Solution Suite Database

---

**Note:** If you have already set up multiple instances of the Microsoft SQL Server, you can identify a specific database instance in this field using the format: `<SQL Server Name>\<database instance>`.

- Depending upon the selection of the SQL Server instance, the default port at which the selected instance is listening appears in the **SQL Port Number** field. You can edit the port number if you have manually entered the SQL Server name or if the port number does not appear automatically due to some firewall restriction.
- You can enter a name other than eXpress in the **Database Name** field.
10 Select the type of Ghost Solution Suite Database authentication to be used. You must enter the user name and password if you want to use SQL Server authentication.

**Note:** You cannot use the remote SQL database with NT authentication on a remote computer if you do not have administrative rights on the computer.

Click **Next**. The **Pre-boot Operating Systems** page appears.

**Note:** If a previous installation of the Ghost Solution Suite Database is detected, an **axinstall** prompt appears, asking whether you want to preserve or overwrite the existing database. Click **Yes** to preserve the data in your Ghost Solution Suite Database.

11 Select a default pre-boot operating system from any one of the options, such as Linux, or WinPE. Browse to locate the FIRM file (for Linux operating systems) or enter the path for the operating system files (for WinPE). Click **Next**.

**Note:** If you are using a free evaluation license, you cannot use the WinPE Add-On Packages.

12 Enter the PXE Server information. (See “PXE server” on page 32.) Select the pre-boot operating system to use as the default PXE boot menu item. You can select, Linux, or WinPE. If you want to use the previously installed pre-boot operating system, select the **Keep current default** option. Click **Next**.

13 Specify how you want to connect your managed computer to the Ghost Solution Suite Server by selecting one of the following options.

- Select the **Connect directly to Ghost Solution Suite Server** option and enter the Ghost Solution Suite Server IP address and port.

- Select the **Discover Ghost Solution Suite Server using TCP/IP multicast** option and provide the Server name.

**Note:** If you leave the **Server name** field blank, the Ghost Solution Suite agent connects to the first Ghost Solution Suite Server that responds. Click **Next**.
14 Click **Install** to install the listed components or click **Back** to modify the settings before starting the installation. The installation process begins and can take several minutes. The **Installation Information Summary** page appears after the installation completes.

**Note:** If you are upgrading your installation, the message **Do you want to replace the share?** appears. Click **Yes** and continue. If you click **No**, a message appears stating that the share is already in use and you must manually set the share to point to the correct directory. Click **OK**.

15 (Optional) You can the following option to install agents on the managed computers.

- **Remotely Install Ghost Solution Suite agent (Windows Vista, 2008 or later only).** Select this option if you want to push the Ghost Solution Suite agent to Windows computers directly after the installation. This can be done any time by selecting **Tools > Remote Agent Installer**.

16 Click **Finish**.

You have successfully completed a Custom Install for a Ghost Solution Suite Server system. Click the Ghost Solution Suite Console icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

See “Simple install for Ghost Solution Suite Server” on page 35.

**Thin client install**

The thin client install option lets you install the Thin Client view of the Ghost Solution Suite Console on your computer. You can install Ghost Solution Suite Server with a Microsoft Data Engine (MSDE) or install it on an existing SQL Server. You need not provide a license file for the Thin Client installation.

**To run a thin client install**

1 Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

The **Symantec Packager Self-Extracting Executable Options** dialog appears.
3 Select the **Use current temp folder** option to use the current temporary folder to download installation files or the **Extract to a specific folder** option to set a path to an existing folder to download the installation files.

4 Click **Extract and Execute App** to extract and execute the application immediately.

The default installation directory is `C:\DSSetup`. If the file `C:\DSSetup\AppLic.dll` already exists, a prompt appears, asking whether you want to overwrite this file. Click **Yes to All**. You may have to wait for some time while Symantec Packager extracts files from this archive.

---

**Note:** Click **Extract Only** to only extract the application and execute the application later. You must run the `axInstall.exe` file to start the installation.

---

5 Select the **Thin Client Install** option from the installation types listed in the **Ghost Solution Suite Server Install Configuration** dialog.

6 (Optional) Select the **Include PXE Server** option to install the PXE Server. (See "PXE server" on page 32.) Click **Install**.

7 Click **Yes** on the **Software License Agreement** page.

8 Enter the following information on the **Ghost Solution Suite Share Information** page:

- In the **File Server path** field, enter or browse to the path to install the Ghost Solution Suite Server program files. The default path is `C:\Program Files\Altiris\eXpress\Ghost Solution Suite Server`.

- Select the **Create Ghost Solution Suite Share** option to create a Ghost Solution Suite Share on the computer. The Ghost Solution Suite Share lets you store files on the computer and run Ghost Solution Suite Server system applications. See “**Ghost Solution Suite Share**” on page 31.

- You must enter an administrator user name and password for the Ghost Solution Suite Server system. This account must already exist on the Ghost Solution Suite Share and the Ghost Solution Suite Server. By default, the name you are currently logged on as appears. If you use a domain account, enter the domain and the user name (Example: Domain1\administrator). See “**Ghost Solution Suite Server**” on page 28.

If a previous installation of the Ghost Solution Suite Database is detected, an **axinstall** prompt appears, asking whether you want to preserve or overwrite the existing database. Click **Yes** to preserve the data in your Ghost Solution Suite Database.
Click Next. The Pre-boot Operating System page appears.

9 Select a default pre-boot operating system from any one of the options, such as Linux, WinPE, or None. Browse to locate the FIRM file (for Linux operating systems) or enter the path for the operating system files (for WinPE). Click Next. The Installation Information page appears, displaying the components that you selected to install.

10 Click Install to install the listed components, or click Back to modify the settings before starting the installation. The installation process begins and can take several minutes. The Installation Information Summary page appears after the installation completes.

---

**Note:** If you are upgrading your installation, the message *Do you want to replace the share?* appears. Click Yes and continue. If you click No, a message appears, stating that the share is already in use and you must manually set the share to point to the correct directory. Click OK.

---

11 (Optional) You can select the following option to install agents.

- Remotely install Ghost Solution Suite agent (Windows Vista, Windows 2008 or later only). Select this option if you want to push the Ghost Solution Suite agent to computers running Windows Vista, Windows 2008, and later operating systems.

12 Click Finish.

You have successfully completed a Thin Client install for a Ghost Solution Suite Server system. Click the Ghost Solution Suite Console icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

---

**Note:** Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Ghost Solution Suite Server Win32 Console, the "Unable to connect to the Symantec Ghost Solution Suite Server Management Server. Please ensure this service is started and running currently." error appears. This occurs because the service files are deleted by the antivirus application during scanning. To resolve this issue, disable the antivirus software and reinstall the Ghost Solution Suite Server.
Component install

The component install option lets you add selected Ghost Solution Suite Server Components - Ghost Solution Suite Console, PXE Server, and Ghost Solution Suite Agents to the existing Ghost Solution Suite Share. You can also add Microsoft Sysprep files.

See “Ghost Solution Suite Server components” on page 27.

To run a component install

1. Start the server and log on using the administrator account you created for the Ghost Solution Suite Server.

2. Launch the appropriate Symantec Ghost Solution Suite Server installation file and follow the setup steps.

   The Symantec Packager Self-Extracting Executable Options dialog appears.

3. Select the Use current temp folder option to use the current temporary folder to download installation files or the Extract to a specific folder option to set a path to an existing folder to download the installation files.

4. Click Extract and Execute App to extract and execute the application immediately.

   The default installation directory is `C:\DSSetup`. If the file `C:\DSSetup\AppLic.dll` already exists, a prompt appears, asking whether you want to overwrite this file. Click Yes to All. You may have to wait for some time while Symantec Packager extracts files from this archive.

   **Note:** (Optional) Click Extract Only to only extract the application and execute the application later. You must run the axInstall.exe file to start the installation.

5. Select the Component Install option from the installation types listed in the Ghost Solution Suite Server Install Configuration dialog and click Install.

6. Click Yes on the Software License Agreement page.

7. Enter a path for the Ghost Solution Suite Share and click Next.

8. Select the components you want to install and click Next.

   - **Install an additional Ghost Solution Suite Console.** Select this option to install another Ghost Solution Suite Console (a Windows executable) on another computer. You can add as many Ghost Solution Suite Consoles as required to manage from multiple consoles across your system, but you
can install only one at a time. The **Ghost Solution Suite Console Information** dialog appears.

- **Install an additional Symantec PXE Server.** Select this option to add additional PXE Servers across a network segment to handle boot requests for large environments. The **PXE Server Information** dialog appears.

  **Master PXE Server.** When you add another PXE Server, the PXE Server that you initially installed is designated as the Master PXE Server. The Master PXE Server works concurrently with any additional PXE Server to handle boot requests across the network segment, but it also allocates additional blocks of IP addresses to other PXE Servers in the system. For all the available options for installing PXE Server, refer to the following section:
  See “PXE server” on page 32.

- **Install additional Ghost Solution Suite Agents.** Select this option to install additional Ghost Solution Suite Agents on client computers, setting up managed computers in the Ghost Solution Suite Server system. The **Remote Agent Install** dialog appears. Enter common administrator credentials for all client computers.
  See “Enter administrator account information” on page 50.

- **Add Microsoft Sysprep files.** Select this option to install the Microsoft Sysprep files, if you did not install them earlier. The Sysprep dialog appears.
  See “PXE server” on page 32.

  9 Select the computer where you want to install the selected components and click **Next.** The **Installation Information** page appears.

  **Note:** If you select the **On a remote computer** option, you must browse and select the remote computer.

  10 Click **Install** to install the listed components or click **Back** to modify settings before starting the installation. The installation process begins and can take several minutes. The **Installation Information Summary** page appears, specifying that the installation was successful.

  11 Select the **Install add-ons to provision server hardware** option to install the add-ons for Dell computers. Click **Finish.**

  **Note:** This option is enabled on Dell computers only when add-ons are present in the **oeminstall-addons** section of the **oeminstall.ini** file, which is located in the eXpress directory. This is the only option available on the **Installation Information Summary** page when you select **Component Install.**
You have successfully completed a Component Install for a Ghost Solution Suite Server system. Click the **Ghost Solution Suite Console** icon on your desktop to view all the computer resources running Ghost Solution Suite Agents configured for your Ghost Solution Suite Server.

## Installing Ghost Solution Suite Agents

Each client computer requires the Ghost Solution Suite Agent to run as the Production Agent on a local hard disk, which communicates with the Ghost Solution Suite Server and registers in the Ghost Solution Suite Database. For Windows and Linux client computers, Ghost Solution Suite lets you push agent software to a client computer. See “Installing the automation agent” on page 56. from a Ghost Solution Suite Console, or you can pull the Ghost Solution Suite Agent to the client computer from the Ghost Solution Suite Share.

You can install an embedded (recommended) or hidden automation partition, which contains an Automation Agent that establishes communications with the Ghost Solution Suite Server to run the deployment jobs that are assigned to the client computer.

See “Install automation partition” on page 142.

- **Ghost Solution Suite agent.** Install a Production Agent to a Windows desktop, notebook, or server computer. You can also install this agent on any supported Linux workstation or server.
  See “Installing Ghost Solution Suite agent for Windows” on page 52.

- **Ghost Solution Suite agent on Linux.** Install on any supported Linux workstation or server.
  See “Installing Ghost Solution Suite agent on Linux” on page 54.

- **Automation Agent.** Install on any Windows desktop, notebook, or server computer.

- **Ghost Solution Suite agent on XP, 2003, Vista (Business) and 2008 Server.** Install the Ghost Solution Suite agent on the selected Windows XP, Server 2003, Vista (Business), and Server 2008 computers.

## Client connectivity and network adapters

Symantec supports all standard network adapter cards and includes many drivers with the installation of Ghost Solution Suite. However, sometimes outdated drivers (including default drivers that come with the hardware) cause problems when clients are in automation mode. To avoid these problems, you should check the manufacturer's Web site for your network adapter to ensure you use their latest driver in your pre-boot operating system configuration file.
Some common client problems that can be solved by updating drivers are:

- Locking when loading drivers or failing to connect to the server
- Locking when imaging (downloading, uploading, or multicasting)

**Microsoft client drivers**

The Boot Disk Creator is set up to work with drivers that follow a certain standard. Because not all NIC drivers follow that standard, you may have to move the files to a different location.

Ensure that the following files are in the same directory:

- The sample *protocol.ini* that comes with your driver (*protocol.ini*)
- The OEM setup file that specifies the DOS driver (*oemsetup.inf*)

Example: The OEM setup file may contain lines similar to the following:

```
[netcard]
NGRPCI="NETGEAR FA310TX Fast Ethernet PCI Adapter",0,ndis,ethernet,real,NGRPCI,NGRPCI_NIF
[NGRPCI] (This header must be the sixth item listed in the line above)
Device=NGRPCI.DOS (If this line is missing, add it. The syntax is device=drivername.)
```

If there is no *protocol.ini* file, create a text file that contains the following command: `DriverName=drivername`.

**Novell client drivers**

The Boot Disk Creator performs the following functions:

- Searches all subdirectories for a directory that contains *.ins, *.com, and net.cfg files. (These files must be in the same directory.) The .INS file is opened to get information about the network card.
- Searches the file for a line starting with a carat (^). This line must have at least two values listed, separated by a comma. The two values needed are the description of the card (value1) and the .com driver file name (value2).

**Installing the Ghost Solution Suite agent**

For client computers running a Windows operating system, Ghost Solution Suite lets you install agent software using the Remote Agent Installer to "push" the agent to a client computer from a Ghost Solution Suite Console. (See "Remote agent installer" on page 49.) You can also pull the Ghost Solution Suite agent to the client computer by accessing the Windows share. You must have administrative rights...
to the client computers and File and Print Sharing must be enabled to install the agent software.

Click Remote Agent Installer on the Ghost Solution Suite Console toolbar, or click Tool > Remote Agent Installer to open the utility program. You can also download aclient.exe from the network share to install a Ghost Solution Suite agent.

Remote agent installer

DAgent replaced AClient as the default agent for the following Windows platforms:

- Windows 2000 SP4 or higher
- Windows 2003 Server
- Windows XP SP2 or higher
- Windows Vista
- Windows 2008 Server
- Windows 2008 Server R2
- Windows 7
- Windows 8
- Windows 8.1
- Windows Server 2012
- Windows Server 2012 R2

Windows XP

To install, each XP computer must have the following items:

- An Administrator account with a password. This account must be able to browse \\hostname\admin$ on the selected computer.
- Disabled simple file sharing. This option can be disabled in Windows Explorer by selecting Tools > Folder Options > View tab and clearing the **Use simple file sharing** check box in the Advanced settings section.
- Enabled **File and printer sharing** in the Windows Firewall.

Windows 2003, Vista, 2008 servers, and Windows 7

You must enable file and print sharing in the Windows Firewall.
Enter administrator account information

Enter common administrator credentials for all client computers, or keep the default credentials to be prompted for each client computer.

**Let me specify a username and password for each machine as it's installed.** Prompts for an administrative user name password for each computer in the remote install list. This is the default option.

**Use this username and password for all clients.** Enter credentials for an administrator account that has rights to all the client computers that you add to the remote install list.

Specify install directory

Enter a location to install the Ghost Solution Suite agent.

**Install directory.** Enter the path to install the Ghost Solution Suite agent on the client computer.

**Enable this agent to use SIDgen and/or Microsoft Sysprep.** If you plan to use SIDgen or Sysprep to configure this computer the required files can be copied when the agent is installed.

Click **Change Settings** to set the Ghost Solution Suite agent settings.

Automatically add to a group

You can select one of the following options to automatically add new computers to the group that you specify.

**Add client(s) to default group.** Adds new computers to the All Computers group.

**Add client(s) to a specific group.** Adds new computers to another group. Use back slashes to separate subgroups.

Select computers on the network

Identify client computers on the network and add them to a list of computers to remotely install the Ghost Solution Suite agent.

**Add.** Select the computers by the name in the list, or enter a computer name or IP address.

**Computer Name.** Enter the name of a computer on the network or its IP address.

**Properties.** Select a computer and view the agent install settings. You can also change SID and Agent settings from the **Agent Properties** dialog.

**Import.** Import new computers from a file. This file has the following parameters: `-c:[computer] -u:[username] -p:[password] -i:[input file]. The**
parameters must be entered in this order. The password parameter is not required if the administrator account does not have one assigned. If you are using the default settings, you do not need to specify an input filename. Each computer entry must be on a separate line.

**Export.** You can export the listed computers into an export file to use later. The default extension is *.RCI*. Remote Agent Installer first looks for an RCI file extension.

When the computers appear in the installer list and the properties are set, click **Finish.** The status of the agent install appears.

After the Ghost Solution Suite agent is installed, it automatically connects to the Ghost Solution Suite Server and appears in the **Computers** pane of the Ghost Solution Suite Console.

### Download Microsoft sysprep

If you select **Enable this agent to use SIDgen and/or Microsoft Sysprep** on the previous dialog, the **Remote Agent Installer** dialog locates the required installation files for the specific versions of Sysprep.

**Update file system permissions when changing SIDs.** Select this option to automatically update file system permissions to maintain the individual file permissions that you may have set. This also includes the individual network shares that may exist on this client. On selecting this option, SID conversion takes a long time.

---

**Note:** SIDgen is no longer supported and should not be used. Symantec recommends using Microsoft Sysprep in situations where SID replacement is required.

---

To install Microsoft Sysprep, you must download the installation files required for the Windows operating systems running on the client computer.

**Windows 2000/XP/2003 (deploy.cab)**

We recommend installing these files from a Windows 2003 server CD. Windows Vista and 2008 Server include sysprep files by default.
Change settings
Click Change Settings to modify access, security and other settings on the Ghost Solution Suite agent to be installed.

Get server security key
This page appears only if you select the Enable key-based authentication to Ghost Solution Suite Server option in the Default Agent Settings dialog.
Enter the security key file path for the Ghost Solution Suite Server or browse and select a file containing the security key file path.

Installing Ghost Solution Suite agent for Windows
Run `dagent.msi` from the Ghost Solution Suite Share (shared folder).

1. On the Symantec Client Service dialog, enter a location to install the Ghost Solution Suite agent. Select one of these options, if required, and click Next:
   - Secure modification of server properties. Select to prohibit users from changing any agent settings.
   - Enable changing of Security ID. Select to manage the security IDs to run a SID utility as part of an imaging job.
   - Advanced. Click to open the Computer Configuration Properties dialog and enter the settings for the Ghost Solution Suite agent you are installing. See “Computer configuration properties” on page 103.

2. If you have enabled the security IDs, a page listing the options for managing the SIDs appears. Select the utilities you want to use and enter the path where the utilities are stored. Click Next to install the Ghost Solution Suite agent.

3. (Optional) Select a group in the Ghost Solution Suite Console to add the client to. You can also leave it at the default group.

After the Ghost Solution Suite agent is installed, it connects to the Ghost Solution Suite Server and appears in the Computers pane of the Ghost Solution Suite Console.
See "Installing Ghost Solution Suite Agents" on page 47.

Automating the installation of Ghost Solution Suite agent
If you do not select Remote Agent Installer to install the Ghost Solution Suite agent, install the Ghost Solution Suite agent using log-on scripts or batch files. However, this requires that you manually complete the installation at each client computer. Instead, you can use a template file to set applicable options and properties.
The template file is a text file that can be used to automate configuration of the properties when installing the Ghost Solution Suite agent from a batch file, login script, or manually from a client computer.

The template file can be created using two methods: editing the sample.inp file or using Remote Agent Installer.

**Editing the sample.inp file**

Ghost Solution Suite ships with a sample template file named sample.inp, which contains the commands to configure installation options and properties. This file is located in `Program Files\Altiris\eXpress\Ghost Solution Suite Server`.

Most of the parameters are disabled in this file. To enable an option, remove the semicolon. Example: To specify an IP address and port number for the client to locate the Ghost Solution Suite Server, remove the semicolon from the `TcpAddr` and `TcpPort` lines and change the address and port number to the correct values.

**Using remote agent installer**

You can create a template file when running Remote Agent Installer. After modifying agent properties and adding computers to the Selecting Clients window, click Export to create a template file to import computers (*.rci) as well as the template file (*.inp).

Example: If you have computers named PC-1 and PC-2 listed in the Selecting Clients window and you export these computers using the file name `Export.rci`, the following two template files are created:

- Export_PC-1.inp
- Export_PC-2.inp

**Using the template file**

To use the template file you create, run the AClient.exe installation program specifying the template file and using the -install switch.

Example:

```bash
\\FX1\eXpress\AClient.exe aclient.inp -install
```

The following command-line options are available:
### Option Definition

- **-install**
  - AClient.exe runs and installs the Ghost Solution Suite agent on the computer instead of just running it in memory.

- **-remove**
  - Permanently removes the Ghost Solution Suite agent from the computer where it is installed.

- **-silent**
  - Lets you use the options without being prompted for further input.

- **-stop**
  - Stops the Ghost Solution Suite agent from running, but does not remove it. The next time the computer is booted, the Ghost Solution Suite agent runs in production mode.

- **-start**
  - Starts the Ghost Solution Suite agent. This option works only when Ghost Solution Suite agent is installed on the computer.

### Installing Ghost Solution Suite agent on Linux

You can install the Ghost Solution Suite agent on any supported Linux workstation or server by downloading and running the Ghost Solution Suite agent for Linux installation file (.BIN file) on the client computer. The Ghost Solution Suite agent is updated automatically on Linux computers when you upgrade to a new version of Ghost Solution Suite. The creation date of the Ghost Solution Suite agent is checked and updated when a new agent is available.

#### Installing the Ghost Solution Suite agent for Linux

1. **After downloading the .BIN file to a local directory, you can install from the command line.**

   - Browse to the directory where you saved the .BIN file, switch to the root user (su) and change the directory to the location of the .BIN file by entering (cd < directory>)

   - After changing the directory, you must have the permission to execute the .BIN file; to obtain the permission, enter chmod 544 <filename>

   - Enter: ./<file name>
The Ghost Solution Suite agent for Linux is installed in the
/opt/altiris/deployment/adlagent directory.

2 To change the adlagent configuration file settings, update the adlagent.conf file. This file is located in the /opt/altiris/deployment/adlagent/conf directory. You can also change the adlagent configuration file settings by executing the configure script from the
/opt/altiris/deployment/adlagent/bin directory.
   ■ To edit the configure file directly, open the adlagent.conf file located in the /opt/altiris/deployment/adlagent/conf directory and make the required changes. You can also edit the configuration file to change the functionality or properties. Example: You can open the adlagent.conf file in an editor and scroll to the [Transport] section and the UseMcast line. Change UseMcast=true to UseMcast=false. In the TCPAddr=<IP address> line, enter the IP address of the specific Ghost Solution Suite Server you want to manage the client computer. You can also identify and edit additional configuration settings in the configuration file.

   ■ To run the script to change the settings for the adlagent configuration file, browse to the /opt/altiris/deployment/adlagent/bin directory from the shell and enter ./configure
You are prompted to select Multicast options to identify a Ghost Solution Suite Server to manage the current client computer, or you can select a specific Ghost Solution Suite Server by setting the Multicast option to false and adding the IP address of the required Ghost Solution Suite Server.

3 After editing the configuration file, restart the Ghost Solution Suite agent for Linux.

   To start and stop the Ghost Solution Suite agent for Linux, enter the full path or browse to the /etc/rc.d/init.d directory (with administrator/root rights). You can use either the adlagent stop and adlagent start commands, or only the adlagent restart command. You can also use the Package Manager installed with Linux to restart the Ghost Solution Suite agent for Linux.

   By stopping and starting the Ghost Solution Suite agent for Linux, the service updates the changes made in the adlagent configuration file.

You can now view the Linux managed computer from a Ghost Solution Suite Console.

See “Installing Ghost Solution Suite Agents” on page 47.
Installing the automation agent

After Ghost Solution Suite Server has detected a managed computer through the Ghost Solution Suite agent in a production environment, you can install an Automation Partition from the Computers pane.

Here are some other ways to create and install an Automation Agent, which is saved in an embedded (recommended) or hidden partition on the client computer's hard disk.

- For Ghost Solution Suite systems running the PXE Server, create boot menu options from the PXE Configuration Utility, using one of the following methods: Boot Disk Creator, Direct from floppy, or User Specified. See PXE Configuration Utility Help.

- To install an Automation Partition you can create a Microsoft Install Package (MSI) and deploy it using a job from the console. You can also create floppy disks, bootable CDs with an ISO image, or bootable USB devices. See Boot Disk Creator Help. See “Distributing software” on page 200.

To install an automation partition

See “Install automation partition ” on page 142.

Installation help

The following are the help file topics for the Ghost Solution Suite Server installation program that you can access by clicking Help or pressing the F1 key. These topics identify and explain the elements on the dialogs used in the installation process.

Configuration

The Ghost Solution Suite Server system supports a Simple Install as well as a Custom Install option. A Simple installation lets you install all components on a single computer. The Custom installation lets you distribute individual components of a Ghost Solution Suite Server system on multiple computers. The Thin Client Install lets you install the Thin Client view of the Ghost Solution Suite Console on your computer. The Component Install option lets you install additional components on your system.

Installation type

Simple install. Select this option to install all Ghost Solution Suite Server components on a single computer. This configuration is recommended for managing computers on a single LAN or across a site with few subnets.

See “Simple install for Ghost Solution Suite Server” on page 35.
Include PXE server. Select this option to install the PXE Server when running the Simple install option. The PXE Server requires a DHCP server also installed on your network.

See “PXE server” on page 32.

Custom install. Select this option to install Ghost Solution Suite Server components on multiple computers across your system. A Custom Install lets you balance network activity for large enterprises with multiple subnets. Example: Use this option to distribute the Ghost Solution Suite Database on another computer or assign another file server as the Ghost Solution Suite Share to store image and package files.

See “Custom install for Ghost Solution Suite Server” on page 38.

Thin client install. Select this option to install the Thin Client view of the Ghost Solution Suite Console on your computer. You do not require a license file to install this view.

See “Thin client install” on page 42.

Component install. Select this option to install additional Ghost Solution Suite Server components on your system. Example: Use this option if you want to add a PXE Server to your Simple or Custom installation, or if you need multiple Ghost Solution Suite Consoles.

See “Component install” on page 45.

If you have multiple network adapter cards, a secondary dialog appears asking you to select the IP address for the Ghost Solution Suite Server interface.

Note: If you run the Ghost Solution Suite Server on a MS Windows Server 2003 Domain Controller with SMB Signing enabled, you cannot execute any imaging jobs. When running jobs on MS Windows Server 2003, you must change the SMB Signing Registry Key to execute deployment jobs.

To disable SMB signing on the Windows 2003 server


2 Locate the Microsoft network server: Digitally sign communications (always) policy setting, right-click it, and select Properties > Disabled.

3 Disable the Microsoft network server: Digitally sign communications (if client agrees) policy setting as well. This is enabled by default.
Installing Ghost Solution Suite Server

Specify the Ghost Solution Suite Share (shared directory) where you want to store the image files, .RIPs, and other package files. Before installing the Ghost Solution Suite Server, ensure that you have a shared Windows or NetWare directory with free disk space and appropriate security rights.

**File server path.** Select the drive letter and directory path where you want to install the Ghost Solution Suite Server. The default path is the Program Files directory on the local computer.

**Create Ghost Solution Suite Share.** If you are installing the Ghost Solution Suite Server on a local Windows computer, select this option to create a shared directory as your Ghost Solution Suite Share. If you are installing on a remote file server or if you select an invalid path, this option is unavailable.

---

**Note:** If you are installing the Ghost Solution Suite Server on a remote file server, create a share or grant access rights to the Ghost Solution Suite Server directory on the file server before you start the installation. For Windows XP, you must run the Network Setup Wizard accessed from **My Network Places** to enable sharing.

---

See “Ghost Solution Suite Share” on page 31.

Select one of the following options to configure the licensing information:

See “Ghost Solution Suite Server components” on page 27.

See “Installing Ghost Solution Suite Server” on page 58.

---

**Installing Ghost Solution Suite Server using component install**

Specify the Ghost Solution Suite Share (shared directory) where the image files, RIPs, and other package files are stored. Ensure that you have a shared Windows or NetWare directory with available disk space and security rights before installing.

See “Ghost Solution Suite Share” on page 31.

---

**Ghost Solution Suite Server install**

Install the Ghost Solution Suite Server on a computer. The service is identified in the Services section of the Windows Computer Management as **Altiris eXpress Server**.

See “Ghost Solution Suite Server” on page 28.

**To install service on a local computer**

1. Select the **On this computer** option.
2. Enter the Ghost Solution Suite Server IP address and port information.
3 Enter the path to install the Ghost Solution Suite Server.

4 Enter the user name and password of the Ghost Solution Suite Server. For a domain account, enter the domain and user name. Create this account before starting the installation.

To install service on a remote computer

1 Select the **On a remote computer** option.

2 Enter the name of the computer or browse to where you want to install. By default, the destination path and IP address of the computer appear.

3 Enter the user name and password of an administrator account for the Ghost Solution Suite Server computer. For domain accounts, include the domain name (Example: orgDomain\admin). The user account must have rights to the Ghost Solution Suite Share. Create the administrator domain account before starting the installation.

See “**Ghost Solution Suite Share**” on page 31.

See “**Ghost Solution Suite Server components**” on page 27.

See “**Installing Ghost Solution Suite Server**” on page 58.

**Pre-boot operating system (simple)**

Select a pre-boot operating system, which the Ghost Solution Suite Server can use as the default, when creating a deployment job with an automation task. You can also install additional pre-boot operating system files later by using Boot Disk Creator.

If you are running a PXE Server in your system environment, the first pre-boot operating system that you install becomes the default boot menu option for Initial Deployment. The menu options display Linux Managed, or Windows Managed.

You can assign an automation pre-boot operating system to an automation task when it is added to a deployment job. This flexibility lets you run several automation tasks within a single job, and each task can boot to the automation environment you want.

- **None.** Select this option if you do not want to provide a default automation operating system. You can also select this later through the Boot Disk Creator utility.

- **Linux.** Browse to the BDCgpl.frm file that is present in the GPL folder.

- **WinPE.** Browse to the WinPE files.

- See **Boot Disk Creator Help and PXE Configuration Help.**
**Pre-boot operating system (custom)**

Select a pre-boot operating system that the Ghost Solution Suite Server can use as the default when creating a deployment job with an automation task. You can also install additional pre-boot operating system files later by using Boot Disk Creator.

If you are running a PXE Server in your system environment, the first pre-boot operating system that you install becomes the default boot menu option for Initial Deployment.

You can assign an automation pre-boot operating system to an automation task when it is added to a deployment job. This flexibility lets you run several automation tasks within a single job, and each task can boot to the automation environment you want.

- **Linux.** Browse to the BDCgpl.frm file that is present in the GPL folder.
- **WinPE.** Browse to the WinPE files.

See *Boot Disk Creator Help* and *PXE Configuration Help*.

**Ghost Solution Suite Database install**

Install the Ghost Solution Suite Database on a local or remote server with or without an existing Microsoft Data Engine (MSDE) or Microsoft SQL Server. To install the database, you must have administration rights to the selected server.

See “Ghost Solution Suite Database” on page 30.

---

**Note:** If you have multiple instances of the Microsoft SQL Server already set up, you can identify a specific instance using this format: `<SQL Server Name>\<database instance>`. The instance of the database can vary. Example: If you have a clustered Microsoft SQL Server to manage multiple Ghost Solution Suite systems on different network segments, you can enter the name `salesSegment\express` or `marketingSegment\express` depending on the previously established database instance.

Install the Ghost Solution Suite Database using these options:

- Select the Microsoft SQL Server instance where you want to install your Ghost Solution Suite Database.
- You can also change the default SQL Port number.
- You can rename the Ghost Solution Suite Database default name, eXpress, by entering a different name in the **Database Name** field. However, this does not alter the Ghost Solution Suite Share name.
See “Ghost Solution Suite Server components” on page 27.

**PXE server install**

Select the options to boot locally using the Symantec Automation Partition. For PXE-compliant computers, you can boot across the network using the Intel Pre-boot eXecution Environment option in the PXE Server.

See “PXE server” on page 32.

**Note:** If you have a Novell NetWare file server, you must set up the PXE Server after installing the Ghost Solution Suite Server. The Universal Network Device Interface (UNDI) default driver is not supported by Novell NetWare.

- Select the **No I will be using an Symantec automation partition on each client computer** option, if you do not want to use PXE and prefer to use embedded (preferred) or hidden partitions, or bootable media to run tasks.

  **Note:** This option is unavailable for installing the PXE Servers using the Component Install option.

- Select the **Yes, I want to install PXE Server on this computer** option to install the PXE Server on the local computer.

  **Note:** This option is selected by default for the Component Install.

- Select **Yes, I want to install PXE Server on a remote computer** to install the PXE Server on a remote computer. Enter the name of the computer and the path.

- Enter the IP address for the PXE Server and the Ghost Solution Suite Server.

- Enter the path where you want to install the PXE Server.

- Select the pre-boot operating system that can be used as the default PXE boot menu item. The pre-boot operating system options that are enabled depend on the options you selected for the pre-boot operating systems in the **Pre-boot Operating Systems** page. Example: If you select Linux in the **Pre-boot Operating Systems** page, the **Linux** option is enabled as the default PXE boot menu item. For more information, **PXE Configuration Utility Help**.

See “Installing the automation agent” on page 56.

See “Pre-boot operating system (simple)” on page 59.
Client connection to server
Select the protocol your managed computers can use to connect to the Ghost Solution Suite Server.

**Connect directly to Ghost Solution Suite Server.** Installs the PXE Server using the Intel Pre-boot eXecution Environment (for PXE-compliant computers only). You can use this without PXE for faster access, as it goes directly to the IP address without searching.

If managed computers are on a different segment or if you are using the PXE Server with an UNDI driver, click **Connect directly to Ghost Solution Suite Server** and enter the IP address of the Ghost Solution Suite Server that the managed computers can connect to. Do not change the port number unless the default is already being used.

---

**Note:** If you change the port number, you must change the client configurations.

**Discover Ghost Solution Suite Server using TCP/IP multicast.** Lets the managed computers connect to any Ghost Solution Suite Server. To use multicasting and connect to a specific Ghost Solution Suite Server, enter the name of the Ghost Solution Suite Server computer.

Multicasting cannot be used with the UNDI driver. If you want to use different drivers on the PXE Server, you can create multiple PXE boot files after installing.

See “Ghost Solution Suite Agents” on page 115.

**Sysprep**
Enter the location of the Microsoft Sysprep files according to the operating system. Specify the location or browse and select the required files.

**Installing components**
Click **Install**, or click **Back** to change the settings.

See “Ghost Solution Suite Server components” on page 27.

**Installation information summary**
The components are installed.

You can remotely install Ghost Solution Suite Agents.

**Remotely install Ghost Solution Suite agent (Windows Vista, 2000 or later only).** Select this option to push the Ghost Solution Suite agent.
Click Finish.

See “Ghost Solution Suite Server components” on page 27.

Add components summary
The components in the list are installed.

Download Adobe Acrobat. Select this option to download the Adobe Acrobat Reader to read the documentation in the .PDF format.
Click Finish.
See “Ghost Solution Suite Server components” on page 27.

Ghost Solution Suite Database authentication
Specify the type of authentication the Ghost Solution Suite Database will use. You can select Windows authentication or SQL Server authentication. If you select SQL authentication, enter the user credentials with administrative rights for the SQL database.

Use Windows NT authentication. Select this option to use the Windows network or Active Directory authentication.

Use SQL Server authentication. Enter the user name and password set for the Microsoft SQL Server. If using MSDE, the default "sa" user name is used and no password is required.
See “Ghost Solution Suite Server components” on page 27.
See “Installing Ghost Solution Suite Server” on page 22.

Add components
If you have already installed Ghost Solution Suite Server, you can add components to the existing system. Select the type of component you want to add.
See “Ghost Solution Suite Server components” on page 27.

Console install
You can install the Ghost Solution Suite Console either on the local computer or on multiple remote computers. Installing the Ghost Solution Suite Console on remote computers lets you manage computers from multiple Ghost Solution Suite Consoles across the Ghost Solution Suite Server installation.
See “Ghost Solution Suite Console” on page 28.
Select the **On this computer** option to install the Ghost Solution Suite Console on the local computer.

Select the **On a remote computer** option to install the Ghost Solution Suite Console on a remote computer. Enter the computer name or browse and select a computer.

See “Installing Ghost Solution Suite Server” on page 22.

See “Ghost Solution Suite Server components” on page 27.
Managing from the Ghost Solution Suite Console

This chapter includes the following topics:

- Managing from the Ghost Solution Suite Console

Managing from the Ghost Solution Suite Console

Ghost Solution Suite provides Windows interface consoles to deploy and manage computer devices across local or wide area networks. It also provides a Thin Client view of the Ghost Solution Suite Console. As an IT administrator, you can manage all computer devices from one of these Ghost Solution Suite Consoles:

The Ghost Solution Suite Console is a Windows-based console with complete deployment and management features, including remote control, security, PXE Server configuration, image editing, and other deployment utilities and features. See Ghost Solution Suite Console basics.

The Thin Client View of the Ghost Solution Suite Console provides a simplified experience when dealing exclusively with Thin Clients. The functionality of the Thin Client Console is identical to that of the current Ghost Solution Suite Console. However, you can toggle from Full View to Thin Client View.

Deployment from the Symantec Management Console combines management and reporting features across multiple Ghost Solution Suite server systems and lets you integrate additional Web applications in the client and server management suites, including Inventory, Software Delivery, Recovery, HelpDesk, Patch Management, and Application Metering solutions.

To launch the Ghost Solution Suite Console, click the icon on the desktop, or click Start > Programs > Altiris > Deployment Solution > Console.
Features of the Ghost Solution Suite Console

The Windows console for Ghost Solution Suite provides standard Computers, Jobs, and Details panes to drag and drop icons, view properties, and identify the state and status of Deployment objects. In addition, the Ghost Solution Suite Console also includes a Shortcuts and Resources view and provides the tools, utilities, and features required for complete computer resource management.

Set program options. From the Tools > Options dialog, you can set preferences for each Ghost Solution Suite server system. See General options.

Set security. From the Tools > Security dialog, you can set security rights and permissions for all Ghost Solution Suite Consoles. See Security in Ghost Solution Suite.

Connecting to other Ghost Solution Suite server systems. Connect to other Ghost Solution Suite server connections from your current Ghost Solution Suite Console and manage computers outside of your current network segment or site. See Connecting to another Ghost Solution Suite server.

Customize the Tools menu. You can add commands to the Tools menu to open commonly-used deployment programs and utilities.

See “Extending the tools menu” on page 72.

Ghost Solution Suite Console basics

The Ghost Solution Suite Console is your main portal to Ghost Solution Suite. It is a feature-rich Win 32 program with real-time access to computer resources, deployment jobs, and package files, each represented by distinct icons to identify the status and settings. From the Ghost Solution Suite Console, you can build simple or complex deployment jobs, assign them to a computer group, and verify deployment execution.

Because the Ghost Solution Suite Console can reside on its own computer, you can have multiple consoles running from different locations. The Ghost Solution Suite Console needs to be running only while creating assignments or viewing information about the managed computers. You can turn on the console, run management tasks, and turn off the console.

Scheduling information is saved in the Ghost Solution Suite Database and tasks are executed at their scheduled time. If an assignment to a managed computer is made from two different consoles at approximately the same time, the computer is assigned those tasks in the order they are received.

See “Console options” on page 79. to set refresh intervals for the Ghost Solution Suite Console.
Thin client view of the Ghost Solution Suite Console

The Thin Client view of the Ghost Solution Suite Console provides a simplified experience when dealing exclusively with Thin Clients. The functionality of the Thin Client view is identical to that of the current Ghost Solution Suite Console. However, you can switch from Full view to Thin Client view.

The Thin Client Console has the following panes:

- Computers
- Resources
- Software Packages
- Inventory

The Computers, Resources, and Software Packages panes are on the left side of the Thin Client view, while the Inventory pane is on the right side of the Thin Client view.

Installing the thin client view

During installation, you can install the Ghost Solution Suite Thin Client view. By default, the traditional Ghost Solution Suite Console is installed.

If you select Thin Client view, a Thin Client Jobs system folder is created. All the jobs created from the Ghost Solution Suite Thin Client view are stored in this folder.

During the installation process, the following folders are created in this hierarchy for the Thin Client resources:

- Configuration Packages
- Images
- Software Packages

Ghost Solution Suite for Thin Clients uses the same installation program as Ghost Solution Suite. No licensing is required even if you select Thin Client Install.

To install Thin Client, choose one of the following options:

To install thin client

- On the Ghost Solution Suite server Install Configuration dialog, select the Thin Client Install option. The Ghost Solution Suite Console Thin Client View appears.
Switching between two views

When you switch between the traditional view and the Thin Client view, you can maintain the last state in which you viewed the console. This ensures that you open the console in the same view that you last closed it in.

To switch between the traditional and the thin client view

1. Click View.
2. Select Show Thin Client View.

**Note:** By default, the Thin Client view is visible if you select Thin Client Install.

When you switch to the Thin Client view, all the menus and items that are not necessary for the Thin Client view are unavailable. These are visible when you switch to the traditional view.

Computers pane

This pane is the same as that in the traditional view. However, only thin clients are displayed. You can right-click this pane to view a new menu. When you right-click a thin client, you can view the following options:

- Capture Configuration
- Capture Images
- Deploy Configuration
- Install Automation Partition
- Get Inventory
- Power Control
- Properties
- Remote Control
- Delete
- Manage Inventory View

If you select a Capture option, a text field appears, prompting you for the name of the captured resource. By default, the name is the same as the serial number on the Thin Client, which you can change.

If you select a deploy option, a list of the available resources appears for the selected type, such as Configurations, Images, or Software Packages. You can select a resource from this list.
Resources pane

This pane is a tree view listing all the resources that you can drag and drop to the thin clients and vice versa. The following types of resources appear in this pane:

■ Configuration Packages. Example: Captured Registry Settings.
■ Images
■ Software Packages. Example: HP Tools.

*Note:* All these resources reside in the eXpress share in the ThinClient directory.

When you click any of the submenus corresponding to the subdirectories within the ThinClient directory, the tree expands and displays all the resources included in the directory. If the folder is empty, an appropriate message appears. You can rename or delete the resources.

Software packages

The **Software Packages** pane displays the software packages that can be created for the available computers. You can drag and drop this resource to the thin clients and vice versa.

When you right-click the **Software Packages** pane, you can view the following options:

■ New folder. Select this option to create a new folder.
■ Import. Select this option to import a job. See To import a job.
■ Rename. Select this option to rename a folder.

*Note:* You cannot rename the Software Packages pane. You can only rename a folder.

■ **Delete.** Select this option to delete folders.
■ Find Software Packages. Select this option to find software packages.
To import a job

1. Open the Thin Client view.
2. Right-click the Software Packages pane and select Import.
   
   The Import Job dialog appears.
3. In the Job file to import field, browse and specify the file that you want to import.

**Note:** By default, the Import to Job Folder, Overwrite existing Jobs and Folders with the same names, and Delete existing Jobs in folder options are disabled.

To preserve the source operating system file paths of Scripted Install, select the Preserve Scripted Install OS source paths option.

Click OK.

To delete the Software Packages option from the Ghost Solution Suite Console

1. Open the Ghost Solution Suite Console.
2. In the Jobs pane, select System Jobs > Thin Client Jobs > Software Packages.
3. Right-click Software Packages and select Delete.

   A confirmation dialog opens.
4. Click Yes to confirm the deletion.

The Software Packages option is deleted from the Ghost Solution Suite Console view.

**Note:** The Software Packages option is automatically added in the Jobs pane in System Jobs > Thin Client Jobs when you switch from the Ghost Solution Suite Console view to the Thin Client view.

Inventory pane

This pane displays a table that lists all the thin clients identified by the console. The following columns appear in the Inventory pane:

- Name
- Computer Status
- Action Status
- Product Name
You can select which columns to view. The following columns are available, but do not appear:

- Automation Partition
- CPU
- Domain Name
- IP address
- MAC address

To view Inventory columns

1. Right-click the Inventory pane. The Manage Inventory Columns dialog appears.
2. You can add columns to either the Selected columns list or the Available columns list by clicking the required arrows.
3. Click OK.

**Toolbars and utilities**

The toolbars and menus on the Ghost Solution Suite Console provide major features and utility tools to deploy and manage computers from the console. From the Main toolbar, you can create new jobs and computer accounts and run basic deployment tasks. On the Tools toolbar, you can launch Ghost Solution Suite administration tools and package editing tools. It also includes icons to quickly run commonly used remote operations.

See “Remote operations using Ghost Solution Suite” on page 128.

**Ghost Solution Suite utility tools**

The Ghost Solution Suite Console lets you open utility programs from the Tools menu or from the Tools toolbar. You can launch Ghost Solution Suite administration tools (Boot Disk Creator, PXE Configuration, Wise SetupCapture and Remote Agent Installer) and package editing tools (Wise MSI Editor, PC Transplant Editor, and Image Explorer) from the toolbar.
### Table 3-1: Ghost Solution Suite utility tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Disk Creator</td>
<td>Use this tool to create boot disk configurations, and automation and network boot media to image client computers. The Boot Disk Creator can maintain several different boot disk configurations for different types of network adapter cards. See <a href="#">Symantec Boot Disk Creator help</a>.</td>
</tr>
<tr>
<td>PXE Configuration</td>
<td>After installing the PXE Server, you can create and modify configurations, which make up the boot menu options that appear on client computers. This is another option to boot computers to automation. See the <a href="#">Symantec PXE Configuration help</a>.</td>
</tr>
<tr>
<td>Remote Agent Installer</td>
<td>Remotely install the Deployment Agent on client computers from the console. This utility lets you push the agent installation to client computers from the Ghost Solution Suite Console. DAgent is the default agent for all Windows platforms.</td>
</tr>
<tr>
<td>PC Transplant Editor</td>
<td>Use this tool to edit a Personality Package to add or remove data. See the <a href="#">Symantec PC Transplant Help</a> located in the Ghost Solution Suite Share.</td>
</tr>
<tr>
<td>Image Explorer</td>
<td>After a disk image is saved to the Ghost Solution Suite Share, this tool lets you view and manage data in the image file. You can edit and split an image, create an index, and more. See the <a href="#">Symantec Image Explorer help</a> file located in the Ghost Solution Suite Share.</td>
</tr>
<tr>
<td>Wise MSI Editor</td>
<td>Edit .MSI packages generated from the Wise Setup Capture tool or other .MSI files used to distribute software and other files.</td>
</tr>
</tbody>
</table>

### Extending the tools menu

You can add commands to the Tools menu on the Ghost Solution Suite Console to quickly access additional management applications. This lets you easily access applications commonly used with Ghost Solution Suite.

Commands are added by modifying or adding new .INI files. You can insert commands to the root ATools.ini file for the main menu or add new .INI files to create submenus. Place both types of .INI files in the directory where the Ghost Solution Suite Console executable (eXpress.exe) is located. The default location is `Program Files\Altiris\eXpress\Deployment Server`. 
You can add up to eight menu items to the main menu, and eight menu items for each submenu.

These .INI fields are included for each application added to the "Tools > Symantec Tools" menu:

[Application name or submenu declaration]
MenuText= <the application name displayed in the menu>
Description= <the name displayed when you mouse over the menu item>
WorkDir= <directory set as default when executable is run>
Executable= <path to the executable files>

The ATools.ini file extends the main Tools menu on the console. This sample file contains one submenu, Web Tools, and two additional menu items, Notepad and Netmeeting. The .INI files are located in the Ghost Solution Suite Share.

[Submenus]
Web Tools= wtools.ini

[Notepad]
MenuText= Notepad Editor
Description= Simple Editor
WorkDir= .
Executable= C:\WINNT\notepad.exe

[NetMeeting]
MenuText= NetMeeting
Description= NetMeeting
WorkDir= .
Executable= C:\Program Files\NetMeeting\conf.exe

Another Tools .INI file is wtools.ini. It is a submenu file referenced by the main ATools.ini file. On the main menu, this is titled "Web Tools" (see Tools.ini) and contains two applications, Internet Explorer and Adobe Acrobat.

[Explorer]
MenuText= Explorer
Description= Windows Explorer
WorkDir= .
Executable= C:\Program Files\Internet Explorer\explorer.exe
GhostCast Server

GhostCasting lets multiple computers running Symantec Ghost Solution Suite receive the same information over a computer network simultaneously. For example, you can send image files to multiple computers.

The GhostCast Server works with Ghost Solution Suite to create an image file of a model computer or restore an image file onto a number of client computers.

The GhostCast Server supports the following forms of data transfer for transferring files:

- **Unicasting**
  One Unicast stream of data is sent for each client computer

- **Direct Broadcasting**
  The data is sent to all computers on a specified subnet. If more than one subnet is targeted, one stream is sent to each subnet.

- **Multicasting**
  The data is sent to all of the computers on the network that have requested the data. Only one stream of data is sent.

The following table lists the fields and description of the GhostCast Server dialog.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Name</td>
<td>Enter a name of the session</td>
</tr>
<tr>
<td>Image File</td>
<td>Browse and select the image file that you want to send to the client computers</td>
</tr>
<tr>
<td>Disk</td>
<td>Select the disk of the client computer that you want to restore.</td>
</tr>
<tr>
<td>Partition</td>
<td>Select if the partition of the client computer that you want to restore.</td>
</tr>
<tr>
<td>Restore Image</td>
<td>Select if you want to restore an image.</td>
</tr>
</tbody>
</table>
Table 3-2  GhostCast Server (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Image</td>
<td>Select if you want to create image of the client computer.</td>
</tr>
<tr>
<td>More Options&gt;&gt;</td>
<td>Displays the following options:</td>
</tr>
<tr>
<td></td>
<td>Client command line options</td>
</tr>
<tr>
<td></td>
<td>■ Disk No.</td>
</tr>
<tr>
<td></td>
<td>Select the disk number from the drop down list</td>
</tr>
<tr>
<td></td>
<td>■ Partition No.</td>
</tr>
<tr>
<td></td>
<td>Select the partition number from the drop down list</td>
</tr>
<tr>
<td></td>
<td>■ Command line</td>
</tr>
<tr>
<td></td>
<td>Enter the command to be executed</td>
</tr>
<tr>
<td>Auto Start</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Time</td>
</tr>
<tr>
<td></td>
<td>Enter the time after which the session should start automatically</td>
</tr>
<tr>
<td></td>
<td>■ Client count</td>
</tr>
<tr>
<td></td>
<td>Enter the number of clients on which the task should start automatically</td>
</tr>
<tr>
<td></td>
<td>■ Timeout</td>
</tr>
<tr>
<td></td>
<td>Enter the time for which the GhostCast Server waits after a client</td>
</tr>
<tr>
<td></td>
<td>computer receives the task.</td>
</tr>
<tr>
<td>Accept clients</td>
<td>Select this option so that the GhostCast Server waits till the clients</td>
</tr>
<tr>
<td></td>
<td>connect.</td>
</tr>
<tr>
<td>Send</td>
<td>Click to start the session.</td>
</tr>
<tr>
<td>Stop</td>
<td>Click to stop the session.</td>
</tr>
</tbody>
</table>

To set the range of IP addresses and log settings, navigate to **File > Options**.
Following are the field and description of the Options dialog:
### Table 3-3 Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Force Mode**             | Check the checkbox to enable Force Mode. You can select from either of the following:  
  ■ Unicast  
  ■ Multicast  
  ■ Direct Broadcast |
| **Limit data throughput for** | You can set the maximum limit of the data transferred:  
  ■ Restoring  
    Set the limit for restoring in MB per minute  
  ■ Creating  
    Set the limit for creating image in MB per minute |
| **Action on completion**   | Select the action to be performed after the GhostCast Server session is complete:  
  ■ Restart Operation  
    Relaunches GhostCast Server  
  ■ Close GhostCast Server  
    Exits the GhostCast Server |
| **Use Specified Multicast Address Range** | Enter the range of IP addresses on which the task should be performed. |
| **Multicast scope TTL**    | Set the multicast scope Time-To-Live (TTL) value.  
  It specifies the number of routers (hops) that multicast traffic is permitted to pass through before expiring on the network. |
| **Log Clients**            | Browse to select the client logs. |
Table 3-3 Options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting</td>
<td>You can set the type of logs to be captured and select the path to store the log file.</td>
</tr>
<tr>
<td></td>
<td>Log Level</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Error</td>
</tr>
<tr>
<td></td>
<td>Statistical</td>
</tr>
<tr>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>Information</td>
</tr>
<tr>
<td></td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Browse and select the log file in which the logs are captured.</td>
</tr>
</tbody>
</table>

To create a job

You can create a job in one of the following ways:

- Select any of the first six options from the Computers pane. All these jobs are scheduled at the current time.

  Note: The Schedule Computers for Job dialog does not have the Job Schedule tab. Also, all the automation jobs have the default option selected for boot image.

- Drag resources to the Computers pane or computers to the Resources pane to schedule jobs at the current time.

  Note: Ensure that you have the required permissions to drag and drop resources.

All thin client job details are saved in the Thin Client Jobs system folder. You cannot delete or rename this new system folder from the console.

All the above options, except Properties, are disabled when the client is not active.

Note: All the jobs on the thin clients are automatically created and scheduled by the console, and this happens only when the clients are active. When creating the jobs, the console refers to the operating system type (platform) of the client.
Computer filters and job conditions

Use this dialog while creating a computer group filter to filter only the specified computers in a computer group, or while setting conditions for task sets when running a job only on the specified computers in a group.

See “Creating a computer group filter” on page 78.
See “Setting conditions for task sets” on page 168.

Creating conditions to assign jobs

You can set conditions on a scheduled job to run only on the computer devices that match a defined criteria. As a result, you can create a single job with tasks defined for computers with varying properties, including the type of the operating system, network adapters, processors, free disk space, and other computer properties. For each job, you can now create task sets that are applicable only to the computers matching those conditions.

Click a job in the Jobs pane. The Condition feature appears in the Details pane. Click Setup to add new conditions or edit existing conditions. When you are setting conditions to schedule a job, select from a list of predefined database fields or create custom tokens that key on other fields in the database.

Creating a computer group filter

The Computer Filters dialog displays a list of all computers in a group according to the specified criteria. Example: You can create a filter to view all the computers in a particular group that have Windows 2000, 256 MB of RAM, and 20 GB hard disks only. By applying the filter, you can view all the computers that meet the specified criteria in the Details pane of the Ghost Solution Suite Console.

Click a computer group in the Computers pane. The Filter feature appears in the Details pane for the selected computer group. Click Setup to add new filters, or to modify and delete existing computer filters.

To create or modify a computer filter

1  Click the All Computers group or any other computer group.
2  On the Filter bar in the Details pane, click Setup > New to create a new filter.
   Or
   Click Setup > Modify.
3  Type a name for the filter and click Add. The Filter Definition page appears.
4 Define the conditions you want to filter.

Click the **Field** box to see a list of computer values stored in the Ghost Solution Suite Database. Select a computer value and set the appropriate operation from the Operations list. In the Value box, enter an appropriate value for the selected database field. Example: You can choose Computer Name as the Field, Contains as the Operation, and Sales as the Value.

5 Repeat to include other conditions. Click **OK**.

**General options**

Use the Program Options feature to set the general options for Ghost Solution Suite. Click **Tools > Options** to view the **Program Options** dialog.

- **Console options**
  
  See “**Console options**” on page 79.

- **Global options**
  
  See “**Global options**” on page 80.

- **Task password options**

- **Domain accounts options**

- **RapiDeploy options**

- **Agent settings options**

- **Custom data sources options**

**Console options**

Set basic console features for miscellaneous refresh actions and warning messages.

Scan resource files for changes every ____ seconds. Specify how frequently (in seconds) the Ghost Solution Suite Console updates its view of package files in the Resources view.

See **Shortcuts and resources view**.

Warn user when no tasks are assigned to the ‘default’ condition. When a job is assigned to computers and the default condition has no tasks assigned, a message appears. The job has no secondary default tasks assigned if a computer in the group does not meet the primary conditions.

See **Setting conditions for task sets**.

Refresh displayed data every ____ seconds. Refresh the display of data accessed from the Ghost Solution Suite Database. This lets you refresh console data at defined intervals instead of updating every time the Ghost Solution Suite Console
receives a command from the server, which can be excessive traffic in large enterprises.

Global options

Set global options for the Ghost Solution Suite server system.

Delete history entries older than _____ days. Specify the number of days entries are kept in the history before they are deleted. Enter any number between 1 and 10,000. If you don’t select this option, log entries remain in the history.

Remove inactive computers after ____ days. Specify the number of days you want to keep inactive computers in the Ghost Solution Suite Database before they are deleted. The default value is 30 days, but any number between 1 and 10,000 is valid.

Synchronize display names with computer names. Automatically update the displayed name of the managed computer names in the console when the client computer name changes. If this option is not selected, changes to the computer names are not reflected in the console. Synchronization is off by default. The names do not have to be synchronized for the Ghost Solution Suite server to manage the computer.

Reschedule failed image deployment jobs to immediately retry. Immediately retry a failed image deployment job. The program continues to retry until the job succeeds or until the job is cancelled.

Client/server file transfer port: _____. Specifies a static TCP port for file transfers to the clients. The default value is 0 and causes the server to use a dynamic port. This setting is useful if you have a firewall and need to use a specific port rather than a dynamically assigned port.

Automatically replace expired trial licenses with available regular licenses. Lets Ghost Solution Suite automatically assign a permanent license to the computer after the trial license expires.

---

**Note:** Be careful when using this option. Ensure that you do not give a permanent license to computers you do not want to manage after their trial license expires.

---

Display Imaging status on console. Displays the status of the imaging job on the Ghost Solution Suite Console.

Remote control ports. Specifies ports for using the Remote Control feature. You have the option to enter a primary port address and a secondary port address (Optional).
Remove task passwords when exporting or copying jobs. Specifies that you must remove the task password when exporting or copying jobs.

Display only computers and jobs the user has rights to manage. Displays only the computers and jobs that the user has rights to manage. If this option is not selected, all of the computers and jobs are displayed. If this option is selected when security is enabled and the logged-on user has administrator rights, all computers and jobs are displayed. However, if this option is selected when security is enabled and the logged-on user does not have administrator rights, that user's view is restricted to see the jobs and computers that the user only has rights to. A computer is displayed if the logged-on user has any permission on the computer's group or if the computer's group inherits any permissions from a parent folder.

Do not update configuration data on a failed configuration task. If checked, does not overwrite the data in the Ghost Solution Suite database if a configuration task fails. The database is not updated until a successful configuration task finishes running.

Primary lookup key(s). Specifies the lookup key type(s) used to associate a new computer with a managed computer. The options are Serial Number, Asset Tag, UUID, or MAC Address.

Sysprep Settings. This lets you enter global values for Sysprep.

See “Sysprep settings” on page 81.

**Sysprep settings**

View and configure the Sysprep settings for the Ghost Solution Suite server.

**OS product key dialog**

In the OS Product Key dialog, select the suitable operating system from the Operating System drop-down list. After you select the operating system, a list of all product keys for the selected operating system appears. Select an operating system from the Operating System drop-down list, and click Add to type the Product Key. You can type up to 29 characters for the Product Key. The new product key is added to the list of available keys of the selected operating system.

To modify a product key, select the product key to be modified, and click Edit. To remove a product key, select the product key to be deleted, and click Remove.

**Note:** If the product key is being used by another task, you cannot delete the product key. You are prompted with a message stating that the product key is being used by another task.
Task password options

According to the network and security properties, the passwords for administrators and users change after a certain number of days. In such a scenario, the password becomes invalid and all jobs and tasks using the user name whose password changes must be modified to use the new password. The Task Password option provides administrators with a simple option to manage all password changes from a centralized location.

This feature lets you set or change user passwords from a central location, so you can modify the password for the Copy File to, Distribute Software, Run Script, Distribute Personality, and Capture Personality tasks when creating or modifying jobs. However, this tab is enabled only to administrators and select users who have been granted the appropriate privileges.

The Status field displays the results of password updates. Example: User A's user name and password is used in ten tasks. If you want to update the password for these ten tasks, you can do so through the Task Password option. After the password is updated, the Status field displays the message: Password for 10 tasks updated.

Domain accounts options

This sign-on feature retrieves the name of the administrator (or the user with administration rights) and the password for each domain. This feature lets you avoid needing to log on for each managed computer when you run imaging and configuration jobs.

You can provide the user credentials for the parent domain or a trusted domain in this window. Ghost Solution Suite supports the UPN and SAM formats, and it accepts either the parent domain user's credentials or the domain user's credentials for any configuration jobs.

Click Add to enter the Domain name. The Add Domain Account page appears. Enter the name of the selected domain and provide the administrator credentials. Click OK. The administrator name and domain are listed in the Domain Accounts list box.

**Note:** To enter the administrator user name for a Windows XP domain, you must add both the domain name and the user name. Example: Instead of entering only the user name jdoe, you must enter domainName\jdoe.
RapiDeploy options

This feature optimizes the multicasting ability of the RapiDeploy application in the Ghost Solution Suite server, letting you deploy images to a group of computers simultaneously, download an image from a file server, or access a local hard drive, and manage the imaging of several client computers concurrently.

Because RapiDeploy is more efficient when writing directly to the IP address of the network adapter driver, you can enter a range of IP addresses when using the multicasting feature for faster computer deployment and management. The Ghost Solution Suite server accesses the range of computers using the defined IP pairs and avoids retrieving the computers through the port and operating system layers.

However, because some network adapter cards do not handle multiple multicast addresses, you can also identify a range of ports to identify these computers. On the first pass, the Ghost Solution Suite server accesses the selected computers using the list of IP numbers. On the second pass, the Ghost Solution Suite server accesses the selected computers using the port numbers or higher level operating system IDs.

Note: Multicasting images are not supported when using the UNDI driver on PXE, and are disabled on the client.

Click Reset to set the default values.

Agent settings options

These are the default agent settings for new computers. Click Change Default Settings to change Windows Agents Settings for Windows and DOS. The Change Default Settings option is enabled only if you select the Force new agents to take these default settings or the Force new Automation agents to take these default settings option. Set Deployment Agent settings for new computer accounts or set Deployment Agent settings for DOS for new computers.

These default settings are applied only for new client computers that have never connected to the Ghost Solution Suite server, and have no information stored in the Ghost Solution Suite Database. These settings are not for the existing managed computers, nor are these settings applied when setting properties using the Remote Agent Installer.

When the Deployment Agent connects, the Ghost Solution Suite server verifies if the computer is a new or an existing computer. If the client computer is new and if the Force new agents to take these default settings option is selected, the Deployment Agent on the client computer receives the default settings established in the Options > Agent Settings dialog. If the computer is recognized as an existing
managed computer, it uses the existing agent settings. The same process occurs for automation agents if the Force new Automation agents to take these default settings option is selected.

Force new agents to take these default settings. Select this option to force the default settings when adding a new computer.

Force new Automation agents to take these default settings. Select this option to force the default settings when adding a new automation agent connects.

Custom data sources options

This option lets you set up credentials to authenticate to external Ghost Solution Suite Databases and other Microsoft SQL Server databases to extract data using custom tokens. Click Add to enter an administrator alias and other login information for the Microsoft SQL Server (or MSDE) hosting the desired Ghost Solution Suite Database.

The information required to create a custom data source entry is listed below:

- **Alias.** The alias name you want to use when referencing the external SQL database.
- **Server.** The name of the external SQL database server or IP address.
- **Database.** The name of the external database from which you want to extract data.
- **Use Integrated Authentication.** This option authenticates to the external database using the domain account you are currently logged on as.
- **Username and Password.** When the integrated authentication is not being used, you must provide a user name and password to authenticate to the external database.
- **Allowed Stored Procedures.** Click this tab to modify the existing list. See "Allowed stored procedure list" on page 84.

**Allowed stored procedure list**

Click Allowed Stored Procedures to identify the stored procedures from the selected custom data source. You can now select from the list of available stored procedures in the data source. This lets you call stored procedures outside of the Ghost Solution Suite Database (eXpress database) using custom tokens within scripts or answer files.
Virtual centers options

You can keep a list of all VMware Virtual Center Web services. The hosts and virtual computers from each Virtual Center that have corresponding computers in the Ghost Solution Suite Database appear in the computer tree. These virtual computers appear under the Virtual computers node in the Computers pane.

Click Add. On the Virtual Center page, enter the Display name, Server hostname, and Username. By default, the port number is displayed. You can also set up a password for the selected user.

Security in Ghost Solution Suite

Ghost Solution Suite provides a security system based on associating job and computer objects with user and group permissions, letting IT personnel be assigned to different security groups to manage operations on specific computer groups or job folders. Each security group can perform only a defined scope of deployment operations on each computer group or job folder. Additionally, each user can be assigned rights to access general console features. You can also choose whether to specify that scripts run only on the Ghost Solution Suite server.

Note: Security rights and permissions set in one console are enforced in all Ghost Solution Suite Consoles.

To set general security rights, click Tools > Security and add a user name and password. You can create users and groups and set scope-based rights.

To set feature-based permissions for specific computers or jobs, select the object in the console, right-click and select Permissions.

See “Best practices for Ghost Solution Suite security” on page 85.

See “Enabling security” on page 86.

See “Setting permissions” on page 91.

See “Groups” on page 88.

See “Rights” on page 89.

Best practices for Ghost Solution Suite security

Ghost Solution Suite is based on defining groups of users and groups of computers and jobs, and associating one with another. We recommend that you first create user groups based on administration duties or access to levels of deployment operations. For example, You probably set up a group with full Administrator rights. This group has access to run all operations on all computers using all types of jobs.
No permissions need to be set on each computer group or job folders for the Administrator group because this has full rights to all features and resources.

However, you can also set up a Technician group that has only basic access and permissions limiting deployment operations. This prohibits members of the group from re-imaging the Server computer group or scheduling Distribute Disk Image jobs. You can explicitly Allow or Deny the group from running these operations for each computer group in the Computers pane or each job folder in the Jobs pane.

After creating the Technician group, you can limit their rights to set General Options and set permissions on each computer groups and job folder for the group. You can select the computer group, right-click it and select Permissions. Select the group name in the left pane, and click Allow or Deny for a list of deployment operations. Example: You can select the Deny check boxes for Restore, Schedule Create Disk Image, and Schedule Distribute Disk Image.

Additional groups can be created with different rights and permissions depending on the needs and responsibilities in the IT team. If users are assigned to multiple groups, the Evaluate Permissions and Evaluate Rights features are sorted and display effective permissions and rights.

**Enabling security**

You can enable security by first creating a group with Administrator rights, adding a user to the Administrator group, and selecting Enable Security.

---

**Note:** When the Administrator Right is selected, you do not need to select any other rights because the Administrator Right implies that all other rights are selected.

**To enable security**

2. Click the **Manage User Groups** tab and click **Add**. The **Add User Group** dialog appears.
3. Select the authentication type. You can add a DS group or a group from the Active Directory. To add groups from Active Directory, refer to the following section:
   
   See “Adding groups from the Active Directory” on page 88.
4. Click **DS Group**.

---

**Note:** The Browse option is disabled for Local Group.
5 Type a name and description in the Add User Group dialog. Click OK.

The group name appears in the window.

6 Select the new group name and click Rights.

7 Select Administrator in the Rights dialog. This assigns complete rights and permissions to the group. Click OK, and click Close.

8 On the main Security dialog, click the Manage Users tab, and click Add.

The Add User Account dialog appears.

9 Select the authentication type. You can add a GSS user or a user from the Active Directory. To add users from the Active Directory, refer to the following sections:

See “Adding groups from the Active Directory” on page 88.

10 Select the GSS User option in the Add User Account dialog.

---

**Note:** The Browse option is disabled for GSS User.

11 Type the user name, full name, and password. Retype the password, and enter a description for the user. Click OK.

12 Select the user name in the main Security dialog. Click Rights.

13 Click the name of the new Administrator group in the Groups window. This assigns the new user to the new group with Administrator rights. Click OK.

---

**Note:** You can assign the user Administrator rights directly, but we recommend you to assign users to groups.

See “Best practices for Ghost Solution Suite security” on page 85.

14 Now that you have a user with administrator rights, select the Enable Security box.

Security is now enabled. You can now create users and groups and assign permissions to computer groups and job folders.

You can add users from the Active Directory.

Adding users from the Active Directory

1 In the main Security dialog, click the Manage Users tab, and click Add.

2 Select the AD User option in the Add User Account dialog.
3 If you know the user name, type it in the Username field, or click Browse to select the user from the Active Directory.

The password field is deactivated because the user is being added from the Active Directory.

**Note:** You can add only one user at a time. To import users, see Importing users from the Active Directory.

4 Enter a description for the user in the Description box.

5 Click **OK**.

**Importing users from the Active Directory**

You can also import users from the Active Directory. To open a standard Windows Active Directory dialog, from the main Security dialog, click the Manage Users tab, and click **AD Import**. Add users from Active Directory, not groups. The users are added to the Ghost Solution Suite Database. However, you still need to assign the users to security groups with appropriate rights and permissions.

**Note:** When logging on with the imported AD account, Ghost Solution Suite accessed the Windows Active Directory server to validate the user password.

**Groups**

Assign the user to previously created groups. If you are enabling security, you can assign the user to a group with Administration rights.

To add groups, from the Security dialog, click the Manage User Groups tab, and click **Add**. Select the authentication type, and type the required details. You can view the members of any group by clicking the group in the Manage User Groups dialog and clicking **View Members**.

See “Best practices for Ghost Solution Suite security” on page 85.

See “Enabling security” on page 86.

**Adding groups from the Active Directory**

You can add users from the Active Directory.

**To add groups from the Active Directory**

1 In the main Security dialog, click Manage User Groups tab, and click **Add**.

2 Select AD Group in the Add User Group dialog.
3 If you know the group name, enter it in the Name field, or click Browse to select the group from the Active Directory. A list of groups, along with their descriptions, appears in a new dialog. Select a group from the list and click OK.

4 The Name, Domain, and Description are displayed. However, you can modify the description. Click OK.

The newly added group appears in the main Security dialog.

Importing groups from the Active Directory

You can also import users from the Active Directory. In the main Security dialog, click the Manage User Groups tab, and click AD Import to open a standard Windows Active Directory dialog. Add groups from Active Directory. You can choose a domain from the Domain List, and select a group from the displayed list. The group is added to the Ghost Solution Suite Database. However, you still need to assign the users to security groups with appropriate rights and permissions.

DS authentication

If the user is already in the Ghost Solution Suite Database and tries to access the Ghost Solution Suite Console, the Ghost Solution Suite server checks the authentication with the logged on user, and upon matching does not prompt for user credentials. Similarly, if a group is already added in the Ghost Solution Suite Database and if a logged-on user, who is a part of the AD group, tries to access the Ghost Solution Suite Console, the Ghost Solution Suite server does not prompt for credentials.

Rights

This dialog lets you set general rights for a user or group.

To verify, add, or change the rights assigned to each console user

1 On the Security page, select a user and click Rights.
2 Click the Rights tab.
3 Select the check box for each right you want to grant.
4 After selecting all applicable rights, click OK to save your changes.

A brief explanation of each Ghost Solution Suite server right that can be assigned is given below:

- Administrator. Lets the user access all features available on the Ghost Solution Suite Console. You must have Administrator rights to enable security. See Enabling security.
- Options Console. Lets you set the view and the Console options. See Console options.
- Options Global. Lets you set the view and the Global options. See Global options.
- Options Domain Accounts. Lets you set the view and the Domains Accounts options. See Domain accounts options.
- Options RapiDeploy. Lets you set the view and the RapiDeploy options. See RapiDeploy options.
- Options Agent Settings. Lets you set the view and the Agent Settings options. See Agent settings options.
- Options Custom Data Sources. Lets you create Custom Data Sources options. See Custom data sources options. You can view, create, and set database aliases.
- Manage Rejected Computers. Lets you view rejected computers in Ghost Solution Suite and change their status. See Rejected computers in Ghost Solution Suite.
- Refresh Clients. Lets you refresh Ghost Solution Suite clients. See Refresh Ghost Solution Suite. You can use the View > Refresh clients <CTRL +F5> feature to disconnect and reconnect client computers.
- Allow Scheduling on All Computers Group. Lets you schedule jobs on All Computers. If you have administrator rights, by default, you have the rights to schedule job on all computers, irrespective of the check box state. You can grant this right to a specific user or a group.
- Import/Export. Lets you import and export jobs and import computers as well. See Importing and exporting jobs and Importing new computers from a text file.
- Options Task Password. Lets you centrally update passwords for users and groups so they can access the Copy File to, Distribute Software, Run Script, Distribute Personality, and Capture Personality tasks. You must have administrative rights to access this option. See Task password options.
- Use PXE Configuration Utility. Lets you use the PXE Configuration Utility.
- Options Virtual Centers. Lets you view and add options for Virtual Centers. See Virtual centers options.
- Run Script on DS. Lets you choose to run scripts either on the server or on the client.
- Access to Master Return Code. If unchecked, restricts access to the master return code list. If checked, lets you modify the master return code list.

- Allow DeployAnywhere. Lets you run DeployAnywhere to create hardware independent images. This functionality is provided by Symantec Ghost Imaging Foundation (GIF). To add and manage drivers, on the Tools menu, click the new DeployAnywhere option. To enable this functionality, select the DeployAnywhere option from the deploy image task. For more information about DeployAnywhere or Ghost, see the Symantec Ghost Imaging Foundation documentation.

Restricting the number of computers

This dialog lets you restrict the maximum number of computers that can be selected.

Restricting the number of computers

1 On the Security page, select a user and click Rights.
2 Click the Restrictions tab.
3 Type the maximum number of computers that each job can be scheduled on.
4 Check the box if you want this user to be able to schedule jobs to run immediately.
5 Click OK to save your changes.

Setting permissions

Set permissions for jobs, job folders, computers, and computer groups.

See “Best practices for Ghost Solution Suite security” on page 85. for additional design tips.

Setting permissions

1 Right-click on a computer group or job folder (or individual computers and jobs) and select Permissions. The Object Security dialog appears.
2 Click the Groups tab and select a group name. Or click the User tab and select a user name.
3 From the list in the right pane, select if you want to Accept or Deny permission to run the operations on the selected computer or job objects. These permissions include access to remote operations using Ghost Solution Suite and features for scheduling Deployment tasks.

See “Remote operations using Ghost Solution Suite” on page 128.

See “Deployment tasks” on page 170.
4 Select the Allow or Deny check box to explicitly set security permissions for these Ghost Solution Suite features for the selected objects.

**Note:** Administrators have access to all objects with unrestricted rights and permissions. You cannot explicitly deny permissions to computer or job objects for users with administrator rights.

5 To assign permissions to multiple groups, click Set permissions on all child objects to assign the values without closing the dialog.

**Note:** You can set permissions for all jobs and computers by clicking in the Jobs pane or Computers pane without selecting a job or computer object.

### Connecting to another Ghost Solution Suite server

From the Ghost Solution Suite Console, you can connect to other Ghost Solution Suite servers on your LAN and manage computers outside of the network segment you are currently logged on to. To open a connection, you must connect to the Ghost Solution Suite Database of the preferred Ghost Solution Suite server connection using the ODBC Data Source Administrator.

Click **File > Connect** to or press **CTRL+O** to open the **Connect to Ghost Solution Suite Server** dialog. Enter the required information to connect to the external Ghost Solution Suite server connections using an ODBC driver.

**Note:** Although you are accessing another connection (another Ghost Solution Suite Database), Windows remembers the last place you browsed to, which would be the Ghost Solution Suite Share of the previous Ghost Solution Suite server connection. You need to browse to the new connection's Ghost Solution Suite Share to access its shared folder that contains its RIPs, images, executables, and other resources.

### Connecting to a new Ghost Solution Suite Database

1 Click **New**. The **Define Connection Information** dialog appears.

2 Enter a name for the connection to be opened.

3 Establish an ODBC data source.
   - Click **ODBC Administrator**.
   - Click the **System DSN** tab, and click **Add**.
Select the SQL Server driver source and click *Finish*.

In the Create a New Data Source to SQL Server dialog, enter a name and description for the data source.

If an entry for your server already exists, select it from the menu. Otherwise, enter the name of the server hosting your remote SQL server in this field. Click *Next*.

Click *Next* in the Create a New Data Source to SQL Server dialog to accept the default settings for authentication.

Select the Change the default database to option and select eXpress from the drop-down list. Click *Next*.

Click *Finish*. The specifications for the new ODBC data source appear.

Click *Test Data Source* to verify that the source is reachable.

Click *OK*. You return to the main ODBC Data Source Administrator dialog with your new data source listed in the System DSN tab. Click *OK*.

4 From the ODBC Data source name drop-down list in the Define Connection Information dialog, select the new Data Source name you just created.

5 In the *Installation Directory path* field, enter or browse the full UNC path (or path using any locally mapped drive) to the directory of the required Ghost Solution Suite server, such as:

\server\express or H:

6 Click *OK*.

Rejected computers in Ghost Solution Suite

When an unwanted managed client computers attaches to your Ghost Solution Suite system, you can right-click the computer in the Computers pane and select *Advanced > Reject Connection*. You can view these rejected computers by clicking *View > Rejected Computers*.

The rejected computers are prohibited from being active in the Ghost Solution Suite Database. They are identified and rejected by their MAC address.

You can remove computers from the Rejected Computers list by selecting it and clicking *Accept Computer(s)*. This lets the computer to attach again and be managed by the Ghost Solution Suite system.
Refresh Ghost Solution Suite

You can refresh the Ghost Solution Suite Console by clicking View > Refresh Console (or pressing <F5>) to update data from the Ghost Solution Suite Database. You can also click View > Reset Client Connections (or press Ctrl+<F5>) to disconnect and reconnect all managed computers in a Ghost Solution Suite server system.

When you refresh the managed client computers, you are asked if you want to disconnect all computers. Click Yes. This tells the Ghost Solution Suite Agent to shut down and restart. It also creates additional network traffic when all computers connect and disconnect. By refreshing the managed client computers, you ensure that you are viewing the current status and state of all computers resources in your system.
Managing Computers

This chapter includes the following topics:

- Managing computers
- Viewing computer details
- Adding new computers
- Computer configuration properties
- Ghost Solution Suite Agents
- Computer properties
- Remote operations using Ghost Solution Suite
- Deploying and managing servers
- New Dynamic Machine Groups

Managing computers

From the Computers pane of a Ghost Solution Suite console, you can identify, deploy, and manage all computer resources across your organization, including desktop computers, notebook computers, network and Web servers, and network switches. You can quickly modify any computer's configuration settings or view its complete management history. Or you can take on big projects, such as completely re-image the hard drive, restore software, and migrate personality settings for a whole department. You now have management of all your computer resources available from a Windows console from any location.

All computer resources can be accessed and managed as single computers or organized into computer groups with similar hardware configurations or deployment requirements, letting you run deployment jobs or execute operations on multiple
computers simultaneously. You can use search features to locate a specific computer in the Ghost Solution Suite Database, or set filters to sort computers by type, configuration, operating system, or other criteria.

**Manage with computer icons.** Major computer types are identified by a computer icon in the console, with a list of scheduled jobs and operations associated with each computer. In the Ghost Solution Suite Console, you can assign and schedule deployment jobs to computers or groups by dragging the computer icon to a job in the Jobs pane, or vice versa.

See “Viewing computer details” on page 97.

Computer icons appear in the **Computers** pane of the Ghost Solution Suite Console, where they can be organized into groups. To assign and schedule a job on a computer in the Ghost Solution Suite Server Console, drag a computer icon or group icon to a job icon.

**Add new computers.** Ghost Solution Suite lets you add new computer accounts and set configuration properties for new computers before they are recognized by the Ghost Solution Suite Server system. Preset computer accounts automatically associate with new computers when they start up, or can be associated with pre-configured computers.

See “Adding new computers” on page 99.

Click **New Computer** on the console to create a new computer account. You can also click **File > New > Computer** or right-click in the **Computers** pane and select **New Computer**.

When the new computer starts up, you can assign it a preset account.

Click **New Group** on the console to add a new group in the **Computers** pane of the Ghost Solution Suite Console. You can also click **File > New > Computer Group** or right-click in the **Computers** pane and select **New Group**.

**Deploy to groups of computers.** Organize computers by department, network container, hardware configuration, software requirements, or any other structure to meet your needs. You can deploy and provision computers on a mass scale.

To filter computers in a computer group and to schedule jobs only to the appropriate computer types.

See “Computer filters and job conditions” on page 78.
Configure Computer Agents

See “Ghost Solution Suite Agents” on page 115.

View and configure computer properties. You can modify computer settings for each computer from the console. Or you can view the Computer Properties page for detailed access to a computer's hardware, software, and network property settings.

See “Computer configuration properties” on page 103.
See “Computer properties” on page 125.

Run remote operations from the console. Perform operations quickly in real time from a Ghost Solution Suite Console. Restore a computer to a previous state, configure property settings, send a file, remote control, chat, set security, run deployment jobs, or select from additional management commands.

See “Remote operations using Ghost Solution Suite” on page 128.

Build and schedule jobs. Build deployment jobs with one or more management tasks to run on selected computers. Create jobs, add tasks, and assign the job to computer groups. Jobs can be organized and assigned for daily tasks or to handle major IT upgrades.

See “Building and scheduling jobs” on page 159.

Manage Servers. Ghost Solution Suite also manages network or Web servers to administrate high-density server farms or server network resources across your organization.

Viewing computer details

In Ghost Solution Suite, a computer resource is identified in the console with a distinctive icon to display the computer type - Windows desktop or notebook, server, or Linux operating system - and its current status. These computer icons change to convey the state of the computer, such as the log on status, server waiting status, or user with a timed license status. You can also view the status of the jobs assigned to the selected computer in the Details pane of a Ghost Solution Suite Console.

See “Viewing job details” on page 160.

The following is a sample list of computer icons displayed in each Ghost Solution Suite Console, identifying the computer type and state.

A computer connected to the Ghost Solution Suite Server with a user logged on.
A computer connected to the Ghost Solution Suite Server, but the user is not logged on.

A computer with a time-limited user license and a user logged on.

A computer not currently connected to the Ghost Solution Suite Server, but known to the Ghost Solution Suite Database.

A pre-configured computer with values defined in advance using the New Computer feature. As soon as the computer connects, the Ghost Solution Suite Server recognizes the new computer and this icon appears.

See “Adding new computers” on page 99.

A managed computer waiting for user interaction before running deployment tasks. This icon appears if the Workstations check box is selected in Initial Deployment.

See “Sample jobs” on page 227.

A computer identified as a master computer used to broadcast images to other client computers.

A managed server connected to the Ghost Solution Suite Server with a user logged on. Additional icons identify different states of server deployment.

A managed Linux computer connected to the Ghost Solution Suite Server with a user logged on. Additional icons identify different states of Linux computer deployment.

Physical view of Rack/Enclosure/Bay components for high-density server systems. These icons appear as physical representations to allow management of different levels of the server structure. In addition, server icons identify logical server partitions. See “Bay” on page 127. for properties and rules to deploy Rack/Enclosure/Bay servers.
Select the **New Computers** or **All Computers** group to run jobs or operations for these default groups identified by an icon in the **Computers** pane.

Additional computer groups can be added to the **Computers** pane to organize similar computer types or to list computers of similar departments or locations. Click the New Group icon on the toolbar or select **File > New > Computer Group** to create a new group.

## Adding new computers

Computers can be added to the Ghost Solution Suite Database using the following methods:

- **Install the Ghost Solution Suite Agent.** If you install the Ghost Solution Suite Agent to a computer with the operating system already installed, the computer is added automatically to the Ghost Solution Suite Database at startup. New computers with the Ghost Solution Suite Agent installed are added to the **All Computers** groups (unless otherwise specified in the Ghost Solution Suite Agent configuration). You can move the computer to another group if required.

- **Use Initial Deployment to configure and deploy new computers booting to automation.** Starting up a new computer with the Automation Agent lets you image the hard drive, assign IP and network settings, distribute personal settings and software, and install the Ghost Solution Suite Agent for new computers. Using Initial Deployment, you can associate new computers with pre-configured computer accounts. These newly configured computers appear in the **New Computers** group.
  
  See “Sample jobs ” on page 227.

- **Create or import computer accounts from the Ghost Solution Suite Console.** You can add new computers using the New Computer feature or import computers using a delimited text file. You can pre-configure computer accounts by adding names and network settings from the console.
  
  See “Creating a new computer account” on page 101.

## About new computers

When a new computer starts up, if Ghost Solution Suite Server recognizes the MAC address provided in a New Computer account or import file, it automatically associates the user account at startup with the New Computer icon. If this value is not provided, the computer appears as a pre-configured computer account, letting you associate it with a new computer.
The New Computer icon appears for a new computer if the MAC Address is provided when creating a new computer account using any import or new computer account feature.

A pre-configured computer account icon appears if specific hardware data (MAC Address) is not known. As soon as the computer starts up and is associated with a pre-configured computer account, Ghost Solution Suite Server recognizes the new computer and this icon appears.

Pre-configured computer account

A pre-configured computer account can be associated with a new computer using the Initial Deployment feature. You can create multiple pre-configured computer accounts and associate the account with a new computer when it boots to automation. At startup, the configuration settings and jobs assigned to the pre-configured computer account can be associated with the new computer.

Ghost Solution Suite provides features to create a pre-configured computer account to pre-define a computer's configuration settings and assign customized jobs to that computer even if you do not know that computer's MAC address. This type of computer is known as a pre-configured computer account.

Pre-configured computer accounts offer a lot of power and flexibility, especially when you need to deploy several computers to individual users with specific needs. Pre-configuring a computer account saves your time because you can configure the computer before it arrives on site. You can set up as much configuration information (such as computer name, workgroup name, and IP address) as you have about the computer and apply it to the new computer when it comes online. You can also prepare jobs prior to the arrival of the new computer to deploy the computer using customized images, .MSIs, and .RIPs, based on a user's specific needs.

Example: A user might request Windows 2000 with Office 2000 and virus scanning software installed on the new computer. The user also might request that the computer personality (customized user settings, address books, bookmarks, familiar desktop settings) be migrated from the old system. You can build any job, including any of the available tasks, and assign it to a pre-configured computer account.

When the new computer finally arrives, you are ready to deploy it because you have done all the work in advance. Boot the client computer to automation, and the new computer can connect to the server and become a managed computer. Now you can perform an Initial Deployment or run a deployment imaging job on the new computer.
Creating a new computer account

You can create computer accounts for individual computers or for computer groups. When creating new accounts for computer groups, you can automatically assign new names and associate them with existing computer groups or the New Computer group.

Click the New Computer icon on the console to create a new computer account. You can also click File > New > Computer or right-click in the Computers pane and select New Computer.

To create a new computer account

2. Enter names and configuration settings for each new computer account using the Computer Configuration screens.
   for a description of the configuration settings.

   Note: If you do not enter a MAC address, the computer you create or import becomes a virtual computer.

3. (Optional) Click Import to add new computers from a delimited text file.
   See “Importing new computers from a text file” on page 102.
4. Click OK.
   A pre-configured computer account icon appears in the Computers pane.

When a new computer starts up, you can assign it to this preset account.
You can create computer accounts and automatically assign predefined names.
These computer accounts can be associated with computers in a selected computer group.

To create and associate multiple computer accounts

1. Select a computer group, including the New Computers group (empty groups cannot access features). Right-click and select the Configure command. The Computer Configuration Properties dialog appears.
2. Enter names and configuration settings for each new computer account using the Computer Configuration screens.
   See “Computer configuration properties” on page 103.
3 (Optional) Click the Microsoft Networking category and click Define Range.

- In the Fixed text field, enter a base computer name. Example: Sales.
- In the Range start field, enter a numeral or letter to add to the Fixed Text name. This creates a unique name for a group of computers starting with the specified character. The range of numerals and letters is assigned to the computer name. Example: Enter 3.
- Select Append to add the range of numerals after the computer name. Clear the check box to add names before the computer name. In the above example, the Result field displays computer names beginning with Sales3 and ending with Sales12.

4 Click Associate. You can now associate computers in a group (including the New Computers group) with the multiple computer accounts.

5 Click OK.

Importing new computers from a text file

You can import computer configuration data using delimited text files (.TXT, .CSV, or .IMP files) to establish multiple computer accounts in the Ghost Solution Suite Server database. This file contains all configuration data for a new computer, including all settings in the Computer Properties of a selected computer.

See “Computer properties ” on page 125.

1 Click File > Import/Export > Import Computers.

A dialog appears, letting you select import files. These files can have .XML, .TXT, .CSV, or .IMP extensions.

2 Select the import file. Click Open. If a correctly formatted computer import file is selected, a message appears, informing you that the computer import is complete and identifying the number of computers added. Click OK.

New computers appear as pre-configured computer accounts in the Computers pane of the console (as single computers or in groups), and any jobs imported from the import file are listed in the Jobs pane.

Note: Jobs can be added to the import file. They can be created and associated with the new computers.

If the computer import file is incorrectly formatted, a warning appears, stating that the computer import file is incorrect.

3 Edit computer settings by selecting a computer from the list and clicking Properties.
4 The **Computer Properties** page opens. You can edit or add values not set in the import file, such as computer name, TCP/IP settings, user name, and other configuration settings.

5 Click **OK**.

   The imported computers appear in the **Computers** pane of the Ghost Solution Suite Console.

You can also import a computer to be placed in a sub-folder in the **Computers** pane and create a job to be associated with the imported computer. See the sample import file for additional information.

**Referencing the sample import file**

When creating an import file, use either the **ImportComputers55.txt** file or the **ImportComputers55.xls** file in the **Samples** folder of the Ghost Solution Suite Share. The **ImportComputers55.txt** file provides a sample import template you can access to test the Import feature. The **ImportComputers55.xls** file is a Microsoft Excel spreadsheet that lets you add values to each identified column and save the file as a delimited TXT file to import to the Ghost Solution Suite Database. The sample import file places a computer (DB Computer 1) in a computer group (Test Group) and adds a job (Test Job) associated with the imported computer.

**Deploying new computers on a mass scale**

If you need to deploy large numbers of computers (100 to 5,000), consider using a barcode scanning system to collect user information (names, operating system, and application needs) and computer information (MAC address, serial numbers, asset tags). You can save this information to a file, which can be imported into the **New Computers List View**. Depending on the number of incoming computers, the amount of information you have about those computers, and the needs of individual users, you can use either the pre-configured computer account method (best for smaller numbers of new computers) or the Initial Deployment job (best when deploying generic setups by departments or groups).

If you are using an import file, ensure you know the primary lookup key. This information is required by Ghost Solution Suite Server to set up a unique computer. The primary lookup key can be the Serial Number, Asset Tag, UUID, or MAC address.

---

**Computer configuration properties**

These computer property settings can be viewed, set, and modified when performing the following computer management operations:

- See “Adding new computers” on page 99.
See “Modifying configuration” on page 208.
Create or edit property settings in a deployment job.

See “Sample jobs” on page 227.

Click the configuration group icons to set additional computer property values. After you edit these computer property settings, the computer restarts so that the changes can take effect.

**General configuration settings**

Set the most important value from this property sheet. It includes the name of the computer in Ghost Solution Suite, the NetBIOS name of the computer, the MAC address and other settings.

**Microsoft networking configuration settings**

Set the Windows name of the computer and the Workgroup or Domain settings.

**TCP/IP configuration settings**

Set the TCP/IP addresses for one or more network adapters.

**NetWare client configuration settings**

Set Novell Directory Services client logon options.

**Operating system licensing configuration settings**

Set the registered user name and view the hashed installation license key for the installed operating system.

**User account configuration settings**

Set the local Windows user account values.

### General configuration settings

The **General** category provides access to important property settings that are also listed in other configuration categories. Click other category icons to view and set additional configuration properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Provides a name that appears in the Ghost Solution Suite Console (not the BIOS name of the computer).</td>
</tr>
<tr>
<td><strong>Note:</strong> The <strong>Name</strong> field is disabled for multiple computer configuration.</td>
<td></td>
</tr>
<tr>
<td><strong>MAC address</strong></td>
<td>The serial number of the computer's motherboard.</td>
</tr>
</tbody>
</table>
### Table 4-1  General configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Number</td>
<td>The serial number of the computer's motherboard.</td>
</tr>
<tr>
<td>Asset Tag</td>
<td>The asset tag of the computer, if available.</td>
</tr>
<tr>
<td>UUID</td>
<td>The UUID of the computer.</td>
</tr>
<tr>
<td>Computer Name</td>
<td>The Windows name of the computer.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Current IP address of the computer. Multiple IP addresses are listed in this box.</td>
</tr>
<tr>
<td>Registered User</td>
<td>The name of the user who registered the operating system software.</td>
</tr>
<tr>
<td>License key</td>
<td>The hash value rendered from the OEM key or 25-digit license key required when installing the operating system.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name for the local Windows user account.</td>
</tr>
<tr>
<td>Full name</td>
<td>The full name for the local Windows user account.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the local Windows user account.</td>
</tr>
<tr>
<td></td>
<td>See “Computer configuration properties” on page 103.</td>
</tr>
</tbody>
</table>

### Microsoft networking configuration settings

Enter the computer name and workgroup or domain property settings for the managed computer. If you are using Active Directory, you can add computers to a domain and a specified organizational unit (OU).

Use Sysprep to generate unique SIDs. This can be done by manually running the utility or selecting this feature while installing the Ghost Solution Suite Agent.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer name</td>
<td>This is the NetBIOS name for the computer. The name must be unique in the network and limited to 15 characters. &lt;br&gt;<strong>Note:</strong> This field is disabled for multiple computer configuration.</td>
</tr>
</tbody>
</table>
### Table 4-2  Microsoft networking configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Define Range</strong></td>
<td>Click to create a sequential range of computer names. The Computer Name Range dialog appears. For new computers, set a range of names for multiple new computers.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fixed text</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Range start</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Append</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Result</strong></td>
</tr>
</tbody>
</table>

**Note:** When setting name ranges, do not set names using multiple Modify Configuration tasks and assigning the names by setting conditions for task sets. If you set up two separate name ranges to be assigned by separate conditions, the computer names increment irrespective to the base name.

See “Modifying configuration” on page 208.

See “Setting conditions for task sets” on page 168.

See “Computer configuration properties” on page 103.
Table 4-2  Microsoft networking configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>Select this option and enter the name of the workgroup to place the managed computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can select either the <strong>Workgroup</strong> or the <strong>Domain</strong> option.</td>
</tr>
<tr>
<td>Domain</td>
<td>Enter either the fully qualified domain name, the DNS domain name, or the WINS domain name. You can enter the fully qualified domain name (Example: mjones.yourcompany.com), and specify the organizational unit (OU) using this format: OU/newOU/users. The complete entry to place the computer in the users OU is the following: mjones.yourcompany.com/OU/newOU/users internal.myServer.org/New Corporate Computer OU/Mail Room/Express Mail Servers</td>
</tr>
</tbody>
</table>

TCP/IP configuration settings

Enter TCP/IP settings for one or more network adapters. Click **Advanced** to setup IP Interfaces, Gateways, DNS, WINS, and Static Routes. For computer groups, click **Associate** to assign a range of pre-defined IP addresses.

Table 4-3  TCP/IP configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>The DNS name of a device on a network. The name is used to locate a computer on the network.</td>
</tr>
</tbody>
</table>
Table 4-3  TCP/IP configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network adapter</td>
<td>A list of all network adapters installed in the selected computer. The network adapter with the lowest bus, device, and function number is the first listed (NIC0 - zero based). If the bus, device, and function information cannot be determined for a network adapter, it is enumerated in the order it is detected. When configuring multiple network adapters, ensure that one network adapter is not using an Intel Universal NIC driver (commonly called UNDI driver) to connect to Ghost Solution Suite Server. If one network adapter uses the native driver and one uses an UNDI driver, your computer appears twice in the console. <strong>Add.</strong> Enter new settings for additional network adapters installed on the client computer. You can add &quot;virtual&quot; network adapter settings to send a job to a computer group containing computers with varying numbers of network adapters. If a computer in the group has only one network adapter, it is configured only with the IP settings listed first. If IP settings are provided for additional network adapters not present in the computer, they are disregarded. If you add a new network adapter, the <strong>Remove</strong> button appears. You can remove the new network adapter by clicking <strong>Remove.</strong></td>
</tr>
</tbody>
</table>


Table 4-3  TCP/IP configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Description    | - **MAC Address**<br>The MAC address is a unique number assigned to the network adapter by the manufacturer. You cannot change this number. The MAC address appears in this box when you view computer configuration settings. This box is disabled when creating a Modify Configuration task.  
- **DNS connection suffix.**<br>Enter this to add domain suffixes to the root address.  
- **Obtain an IP Address automatically.**  
- **Use the following IP address.**  
- **Obtain DNS server address automatically.**  
- **Obtain the following DNS server addresses.**  
- **Reboot After Configuration.**<br>Restarts the computer after configuration. |
| Adapter state  | The state of the Network Interface Card (NIC). AClient does not report limited information for disabled NICs. Ghost Solution Suite tracks any disabled NICs when it rebuilds or reconfigures a computer. Users have the option of enabling, disabling, or keeping the card in its current state. |

TCP/IP advanced options - IP interfaces

IP Interfaces (Linux and Windows type only). Click Add to set named interfaces for this network adapter. You can add TCP/IP addresses to an existing network adapter card on Linux or Windows operating systems.

Table 4-4  TCP/IP advanced options - IP interfaces

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Add or modify an IP address common to all interfaces.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>Enter the appropriate subnet mask.</td>
</tr>
</tbody>
</table>
Table 4-4  TCP/IP advanced options - IP interfaces (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Name</td>
<td>Establish Linux-specific IP interface settings. Ensure you use the &quot;eth&quot; syntax when naming new interfaces. Example: eth0:1 or eth0:new interface.</td>
</tr>
<tr>
<td>Broadcast Address</td>
<td>Enter the Broadcast address for the specified IP interface.</td>
</tr>
<tr>
<td>Interface State</td>
<td>The default value of the interface state is Up, which denotes that the named interface is operating. You can shut down the named interface by selecting Down. See &quot;Computer configuration properties&quot; on page 103.</td>
</tr>
</tbody>
</table>

TCP/IP advanced options - gateway

View Gateway addresses. Click Modify to edit an existing IP address. Use the up and down arrows to move an address to the top of the list, which acts as the primary address. Review all selection by clicking the TCP/IP option on the Configuration page.

Table 4-5  TCP/IP advanced options - gateway

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>Add additional gateways for this network adapter.</td>
</tr>
</tbody>
</table>

TCP/IP advanced options - DNS

Click Add to set a new DNS address.

**DNS server addresses, in order of use:** Add additional Domain Naming Servers (DNS) for this network adapter.

**Append these DNS Suffixes (in order):** Add the name of the Domain Suffix and use the up and down arrows to set the DNS suffix search order

TCP/IP advanced options - WINS

Click Add to set a new WINS address.
Add additional WINS settings for this network adapter. Select one of the Enable NetBIOS over TCP/IP, Disable NetBIOS over TCP/IP, or Use NetBIOS settings from DHCP server options for this network adapter.

See “Computer configuration properties” on page 103.

Note: You cannot edit this information in the Windows 98 operating systems. The Ghost Solution Suite Console disables the edit feature on these types of clients.

TCP/IP advanced options - static routes

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>IP address of the destination Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Netmask</td>
<td>Subnet mask.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Additional gateways required to reach the destination server.</td>
</tr>
<tr>
<td>Interface</td>
<td>IP address for the interface over which the destination can be reached.</td>
</tr>
<tr>
<td>Metric</td>
<td>Cost associated with the route</td>
</tr>
<tr>
<td>Flags (Linux)</td>
<td>Enter the flag associated with a Linux-specific operating system. Possible flags include:</td>
</tr>
<tr>
<td></td>
<td>■ U (route is up)</td>
</tr>
<tr>
<td></td>
<td>■ H (target is a host)</td>
</tr>
<tr>
<td></td>
<td>■ G (use gateway)</td>
</tr>
<tr>
<td></td>
<td>■ R (reinstate route for dynamic routing)</td>
</tr>
<tr>
<td></td>
<td>■ D (dynamically installed by daemon or redirect)</td>
</tr>
<tr>
<td></td>
<td>■ M (modified from routing daemon or redirect)</td>
</tr>
<tr>
<td></td>
<td>■ A (installed by addrconf)</td>
</tr>
<tr>
<td></td>
<td>■ C (cache entry)</td>
</tr>
<tr>
<td></td>
<td>■ ! (reject route)</td>
</tr>
</tbody>
</table>
NetWare client configuration settings

Set Novell NetWare client values for a new or existing computer. Select whether you want to log in directly to a NetWare server or to a NetWare tree in the Novell Directory Service (NDS). You can specify the preferred tree, server name, and NDS context.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore NetWare settings</td>
<td>Select to disregard all Novell NetWare client settings for this computer. Clear to specify the required information.</td>
</tr>
<tr>
<td>Preferred server</td>
<td>Select this option and enter the name of the NetWare server. Example: \OneServer. This is the primary login server for the NetWare client.</td>
</tr>
<tr>
<td>Preferred tree</td>
<td>Select this option and enter the name of the NDS tree.</td>
</tr>
<tr>
<td>NDS User name</td>
<td>Enter the name of the user object for the NetWare client.</td>
</tr>
<tr>
<td>NDS Context</td>
<td>Enter the organizational unit context for the user.</td>
</tr>
<tr>
<td>Run login scripts</td>
<td>Select this option to run the NetWare client login scripts. See “Computer configuration properties” on page 103.</td>
</tr>
</tbody>
</table>

Operating system licensing configuration settings

Enter or view the license information for your Windows operating system software (Windows 2008, 2012, Vista, Windows 7 and Windows 8).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registered user</td>
<td>Enter the name of the registered user.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter the name of the organization.</td>
</tr>
</tbody>
</table>
Table 4-8  Operating system licensing configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License key</td>
<td>Enter the alpha-numeric license key. This is the hash value rendered from the OEM key or 25-digit license key required when installing the operating system. See “Computer configuration properties” on page 103.</td>
</tr>
</tbody>
</table>

User account configuration settings

Set up local user accounts for the newly imaged computer or when running a configuration task. Enter a user name, full name, and password; and set standard Windows login options.

Table 4-9  User account configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>The user name for this local Windows user account.</td>
</tr>
<tr>
<td>Full name</td>
<td>The full name for this local Windows user account.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for this local Windows user account.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Confirm the password for the local Windows user account.</td>
</tr>
<tr>
<td>Groups</td>
<td>Specify the Windows groups that this user belongs to as a comma-delimited list. Example: Administrators, Marketing, Management.</td>
</tr>
<tr>
<td>User must change password at next logon</td>
<td>Select to force the user to change the password after setting the configuration properties.</td>
</tr>
<tr>
<td>User cannot change password</td>
<td>Prohibit the user from changing the password at any time.</td>
</tr>
</tbody>
</table>
Table 4-9  User account configuration settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password never expires</td>
<td>Select to maintain the user password. See “Computer configuration properties” on page 103.</td>
</tr>
</tbody>
</table>

**Ghost Solution Suite Agents**

To remotely manage computers from a Ghost Solution Suite Console, a Ghost Solution Suite Agent is installed on each computer in the Ghost Solution Suite Server system. Ghost Solution Suite Agents are provided for various computer types, including Windows, and Linux computers.

To set or modify Ghost Solution Suite Agent settings from the Ghost Solution Suite Server Console, right-click a computer or group, select Change Agent Settings and click Production or Automation. To set or modify agent settings for new computers, click **Tools > Options**, click Agent Settings.

The following Ghost Solution Suite Agents reside on the client computer and communicate with the Ghost Solution Suite Server:

- **Ghost Solution Suite Agent on Windows**: The Ghost Solution Suite Agent runs on Windows computers, including desktops, notebooks, and servers.

- **Ghost Solution Suite Agent on Linux**: This Ghost Solution Suite Agent runs on Linux workstations and servers.

- **Automation Agent**: The Automation Agent is used when you create configurations to boot client computer to automation. This is done through Boot Disk Creator.

- **Ghost Solution Suite Agent on ThinClient CE 6.0**: This agent runs on ThinClient Windows CE 6.0 operating systems and lets the Ghost Solution Suite Console manage WinCE 6.0 based Thin Clients.

- **Ghost Solution Suite Agent on CE .NET**: This agent runs on the CE .NET 4.2 operating system.
The NS client is an agent that runs on computers supported by the Notification Server. This agent runs on the Ghost Solution Suite Server computer when running Ghost Solution Suite on the Notification Server.

This agent runs on the Ghost Solution Suite Server computer when running Ghost Solution Suite on the Notification Server.

**Install Ghost Solution Suite Agent to add a managed computer**

When a Ghost Solution Suite Agent is installed on a computer, it searches the network for a Ghost Solution Suite Server to attach to. When the Ghost Solution Suite Agent locates a Ghost Solution Suite Server, the client computer is added as a record to the Ghost Solution Suite Database.

When the Ghost Solution Suite Agent for Windows is running on a computer, the user sees a small icon in the system tray. When the icon is blue, the client computer running the Ghost Solution Suite Agent is connected to the Ghost Solution Suite system.

When the Ghost Solution Suite Agent for Windows icon is clear, it shows that the client computer is not connected to the Ghost Solution Suite system. The agent may be configured incorrectly, the Ghost Solution Suite Server is down, or other network problems exist.

**Automatically update to newer version of Ghost Solution Suite Agent**

At times, Symantec may update versions of the Ghost Solution Suite Agent to enhance features. For best performance, we recommend that all managed computers run the latest version of the Ghost Solution Suite Agent. When a new version of the Ghost Solution Suite Agent is saved to the Ghost Solution Suite Share file server, the managed computers automatically update the Ghost Solution Suite Agent.

- From the computer where Ghost Solution Suite Server is installed, click **Start > All Programs > Altiris > Deployment Solution > Configuration**. The Symantec Ghost Solution Suite Server Configuration Utility page appears.
- Click **Options**.
- Click **Transport**.
- Select the **Automatically update clients** option and click **OK**.
Ghost Solution Suite Agent settings

You can set the default agent settings when new client computers are added to the system that the Ghost Solution Suite Server manages. You can also modify the properties settings for the Production or Automation Agent through the Automation Agent.

To set or modify agent settings in the Ghost Solution Suite Server Console for Windows or Linux clients, right-click the computer and select Change Agent Settings > Production Agent Settings.

- To set or modify agent settings for the Ghost Solution Suite Agent, click Tools > Options.
- Click the Agent Settings tab.
- Select the Force new agents to take these default settings check box to set the Ghost Solution Suite Agent settings for all new computers.
- Click the Change Default Settings tab. Click each agent setting tab to set the properties.
  - See “Server connection” on page 119.
  - See “Access” on page 120.
  - See “Security” on page 121.
  - See “Log file” on page 123.
  - See “Startup and shutdown” on page 124.
- Click OK.

To view or modify settings from the Windows client, right-click the Ghost Solution Suite Agent icon in the system tray (or double-click the client icon in the system tray and click Properties).

When the client agent is first started, the agent establishes a connection to the Ghost Solution Suite Server using the following general steps:

To connect to the Ghost Solution Suite Server

1. The agent service is started and initialized.
2. A TCP socket is created.
3. A connection is made to the Ghost Solution Suite Server.
4. The agent is updated, if required.
5. A basic inventory of the client is sent to the Ghost Solution Suite Server.

After the initial connection process is complete, no additional data needs to be sent to or from the Ghost Solution Suite Server for the client agent to remain connected.
Note: If no Ghost Solution Suite traffic is sent to the Ghost Solution Suite System agent, the TCP/IP protocols send an occasional watchdog packet (approximately every 24 hours) to ensure that the connection is still valid.

**Ghost Solution Suite Agent properties**

Right-clicking the Ghost Solution Suite Agent icon gives you access to the following options:

**View status.** Brings up the Symantec Client Service box to observe the current status of the Ghost Solution Suite Agent. You can also see the computer name, Ghost Solution Suite Server connected to, IP address, multicast address, and MAC address. You can also watch Ghost Solution Suite Agent communicate with the Ghost Solution Suite Server. Clicking Properties lets you edit the Ghost Solution Suite Agent properties. Passwords protect this option.

**About.** Displays the version and licensing statement for the Ghost Solution Suite Agent. Passwords do not affect this option.

**View log file.** View the Ghost Solution Suite Agent log file, if you have chosen the option to create a log file. Passwords have no effect on this option.

**Clear log file.** Clear the log file that has been created.

**Shutdown for imaging.** Make an image of a computer without using a job. This makes the required preparatory changes to the computer before an image is made. Failure to do this breaks the reconfiguration phase when deploying the image using a job. Passwords protect this option.

**Change Name in Console.** Change how this computer is listed in the Ghost Solution Suite Server console. This option does not change the NetBios name of the computer or the name of the computer in the database, but only changes the name of the computer displayed in the Computers window. Passwords protect this option.

**Remove.** Uninstall Ghost Solution Suite Agent from the computer. Passwords protect this option.

**Exit.** Stops all Ghost Solution Suite Agent services from running but does not uninstall Ghost Solution Suite Agent. Ghost Solution Suite Agent loads normally the next time you boot the computer. Passwords protect this option.

**User Properties.** Quickly go to the User Properties page to view or make changes. Passwords protect this option.

**Admin Properties.** Quickly go to the Admin Properties page to view or make changes. Passwords protect this option.

**Show Network Interfaces.** View what network cards are in your computer. Passwords protect this option. The following configuration properties (organized using tabs in the dialog) are included in the **Production Agent Settings** dialog.
Server connection

Table 4-10

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect directly to this Deployment Server</td>
<td>Select this option so that the client receiving the Ghost Solution Suite Agent connects to the Ghost Solution Suite Server you selected to configure.</td>
</tr>
<tr>
<td>Address/Hostname</td>
<td>Enter the IP address or NetBIOS name of the Ghost Solution Suite Server computer.</td>
</tr>
<tr>
<td>Port.</td>
<td>Enter the port number communicating with the Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Enable key-based authentication to Ghost Solution Suite Server.</td>
<td>Select this option to specify mandatory authentication for client computers to connect to the Ghost Solution Suite Server. This helps keep rogue computers from connecting to unauthorized Ghost Solution Suite Servers.</td>
</tr>
<tr>
<td>Discover Ghost Solution Suite Server using TCP/IP multicast</td>
<td>Managed computers can use the multicast address if they are on the same segment as the Ghost Solution Suite Server or if multicast is enabled on the network routers. Ensure that the multicast address and port match those set up on the Ghost Solution Suite Server. Try using defaults on both the client and Ghost Solution Suite Server if you have problems while connecting. Managed computers should use the Ghost Solution Suite Server IP address if multicasting is disabled on the network routers or if they are not on the same network segment as the Ghost Solution Suite Server. The port number must match the number set on the Ghost Solution Suite Server. Otherwise, the client computers cannot connect.</td>
</tr>
<tr>
<td>Server Name</td>
<td>Enter the NetBIOS name of the computer running the Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number distributing the multicast address.</td>
</tr>
<tr>
<td>Multicast Address</td>
<td>Enter the group multicast address.</td>
</tr>
</tbody>
</table>
### Access

Set these commands to control the way the client handles requests from the server.

Table 4-11  

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow this computer to be remote controlled.</strong></td>
<td>Select to let the administrator remotely control the selected computer. The default setting is to NOT let the computer be remotely controlled.</td>
</tr>
</tbody>
</table>
Table 4-11  Access (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt the user before performing actions</td>
<td>You can select the following options to prompt the user before the corresponding action is performed:</td>
</tr>
<tr>
<td>■ Shut down and Restart.</td>
<td>Prompts the user before shutting down and restarting the computer. This feature overrides the Power Control option from the Ghost Solution Suite Server to force applications to shut down without a message.</td>
</tr>
<tr>
<td>■ Copy file and Run command</td>
<td>Prompts the user before running a program or executing file copy commands.</td>
</tr>
<tr>
<td>■ Remote Control</td>
<td>Prompts the user before running the Remote Control commands.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time to wait for user response</th>
<th>If one of the <strong>Prompt the user before perform actions</strong> is selected and the user is not at the computer to respond, you need to decide whether to continue or abort the operation. Specify the time to wait for the user's response, and select one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Continue the operation</td>
<td>Select to continue if there is no response from the user.</td>
</tr>
<tr>
<td>■ Abort the operation</td>
<td>Click to not continue if there is no response from the user.</td>
</tr>
</tbody>
</table>

| Select when the Ghost Solution Suite Server is denied access to the Ghost Solution Suite Agent. | Select the days and set the start and end times when access to the Ghost Solution Suite Agent is denied. |

**Security**

This page lets you secure data between the Ghost Solution Suite Server and the Ghost Solution Suite Agent, or to set a password so that the user on the client computer can only view and modify the User Properties of the Ghost Solution Suite Client Settings on the managed computer.
Table 4-12  Security

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt session communication with</td>
<td>Select to allow encryption from this managed client computer to the Ghost Solution Suite Server. This lets encrypted data transmissions between the Ghost Solution Suite Server and the Ghost Solution Suite Agent on the client computer. If selected, the client computer can connect (but is not required to connect) using encryption.</td>
</tr>
<tr>
<td>Ghost Solution Suite Server</td>
<td></td>
</tr>
<tr>
<td>Require encrypted session with any server</td>
<td>Select to require encryption between the managed client computer and the Ghost Solution Suite Server. If this option is selected and the option to allow encryption in the Deployment Configuration tool is not selected, the Ghost Solution Suite Server does not communicate with the Symantec Client on the managed client computer.</td>
</tr>
<tr>
<td>Password protect Admin properties from</td>
<td>Select to let users on the managed computer access the Admin properties only if they enter the set password. If the check box is selected and the user does not know the password, they will have rights only to view the User Properties, which includes only the User Prompts and Remote Control tabs on the Symantec Client Settings dialog.</td>
</tr>
<tr>
<td>user</td>
<td>Enter the password in the Password field and re-enter the password for confirmation in the Confirm password field.</td>
</tr>
</tbody>
</table>
Table 4-12  Security (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide client tray icon</td>
<td>Select to hide the Symantec Client icon in the system tray of the managed computer. If you hide the icon, you must run AClient.exe with the -admin switch to view and modify the complete administrative properties from the managed client computer.</td>
</tr>
</tbody>
</table>

Log file

The Log File page controls how data is logged and saved in a Ghost Solution Suite Server system, letting you save different types and levels of information to the log files. You can save a text file with log errors, informational errors, and debug data using this dialog. If the log exceeds the specified size, the older data is dropped from the files. You can maximize the size of the log file to save all selected data.

Table 4-13  Log file

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save log information to a text file</td>
<td>Select this option to save information to a log file. By default, this option is cleared. Selecting this option enables the File name and Maximum size fields.</td>
</tr>
<tr>
<td>File name.</td>
<td>Enter the name and path of the log file. The default path is \Program Files\Altiris\AClient\AClient.log file.</td>
</tr>
<tr>
<td>Maximum size</td>
<td>Enter the maximum number of bytes for each log file.</td>
</tr>
<tr>
<td>Log errors</td>
<td>Select this option to save only the errors returned when running a job or operation between the Ghost Solution Suite Server and the Ghost Solution Suite Agent.</td>
</tr>
<tr>
<td>Log informational messages</td>
<td>Select this option to save a list of procedural steps run on the client computer.</td>
</tr>
<tr>
<td>Log debugging information</td>
<td>Select this option to list comprehensive debugging information in the text file.</td>
</tr>
</tbody>
</table>
Note: If the log exceeds the specified size, the older data is dropped from the files, so it is recommended to provide maximum file size.

Proxy

Typically, remote networks on the other side of a router or switch cannot receive multicast or Wake-On-LAN packets from the Ghost Solution Suite Server. Setting the managed computer as a proxy client computer forwards or re-creates the multicast packets. A managed client computer setup as a multicast proxy simply acts as a Ghost Solution Suite Server and advertises the server's name and IP address through multicasting. You can also set the managed computer as a proxy to send Wake-On-LAN packets.

Set these options to control how the managed computer acts as a proxy agent, identifying the type of traffic this managed computer forwards from the server.

Table 4-14  Proxy

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward Wake-On-LAN packets</td>
<td>Select if you want the managed computer to forward Wake-on-LAN packets.</td>
</tr>
<tr>
<td>Forward Ghost Solution Suite Server discovery multicast packets</td>
<td>Select if you want to advertise the Ghost Solution Suite Server to client computers on another LAN segment or if the client computer is on the other side of the router.</td>
</tr>
<tr>
<td>Send multicast advertisement every</td>
<td>Set the time in seconds, minutes, or hours for managed computers to send a multicast advertisement.</td>
</tr>
</tbody>
</table>

Startup and shutdown

Following are the field and the description of the Startup and shutdown dialog box:

Table 4-15  Startup and shutdown

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay starting jobs after system startup</td>
<td>Set the time in seconds, minutes, or hours for managed computers to delay jobs until after system startup.</td>
</tr>
<tr>
<td>Specify the Windows boot drive</td>
<td>Specify the drive that the client computer boots from. The default is the C drive.</td>
</tr>
</tbody>
</table>
Table 4-15  Startup and shutdown (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force all programs to close when shutting down</td>
<td>Select this option to shut down applications when using Power Control features. The user is still prompted to Abort or Continue the shutdown.</td>
</tr>
<tr>
<td>Synchronize date/time with Ghost Solution Suite Server</td>
<td>Select this option to synchronize the system clock of managed computers with the time of the Ghost Solution Suite Server.</td>
</tr>
<tr>
<td>Prompt for a boot disk when performing automation jobs</td>
<td>Select this option to prompt for a boot disk while running any automation jobs.</td>
</tr>
</tbody>
</table>

**Computer properties**

View and edit the computer properties for each managed computer.

View and edit computer properties by double-clicking a computer icon in the Computers pane, or right-clicking and selecting Properties, or clicking the icon in the toolbar.

See “General” on page 125., See “Hardware” on page 125.

**General**

View or change the name of the computer as it appears in the console. You can view the following: logged-on user names, operating system installed, name of the Ghost Solution Suite Server, whether an automation partition is installed, version of the Symantec Windows Client, and other client information.

See “Computer configuration properties” on page 103.

**Hardware**

View processor make and type, processor count, RAM installed on the computer, display configuration, manufacturer, model, product name, MAC address of each network adapter installed, serial number, asset tag, UUID, and whether Wake On LAN and PXE are installed and configured.

See “Computer configuration properties” on page 103.
Drives

View information about each drive on the computer. If you have multiple drives, you can select a drive from the list to view its settings, such as the capacity, serial number, file system, volume label, and number of drives installed.

See “Computer configuration properties” on page 103.

TCP/IP

View TCP/IP information, including a list of all installed network adapter cards (up to eight) for the selected computer. Click Change to open the Configuration page to modify settings.

See “Configuring computers” on page 133.

See “Computer configuration properties” on page 103.

Applications

View the applications that are installed on the computer, including their description, publisher, version number, product ID, and system components.

See “Computer configuration properties” on page 103.

Services

View the services installed on the computer along with the description, start type, and path for each service.

See “Computer configuration properties” on page 103.

Devices

View the devices installed on the computer, including display adapters, disk drives, ports, storage volumes, keyboards, and other system devices.

See “Computer configuration properties” on page 103.

Location

View and edit user-specific properties such as contact name, phone number, e-mail address, department, mail stop, and site name. As the administrator, you can enter this information manually or you can let the user populate this screen using the Prompt User for Properties option.

See “Prompt user for properties ” on page 141.
See “Computer configuration properties” on page 103.

Bay

View location information and other properties for Rack / Enclosure / Bay components for high-density and blade servers. Set rules for automatic re-deployment of blade servers based on physical location changes. This property is available only to systems using blade servers.

Server deployment rules

From the Bay property page, you can select rules to govern actions taken when a new blade server is detected in a selected bay. These rules are described below:

Table 4-16 Server deployment rules

<table>
<thead>
<tr>
<th>Rule</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Re-Deploy Computer</strong></td>
<td>Restore a blade server using deployment tasks and configuration settings saved from the previous server blade in the bay. This lets you replace new blades in the bay and automatically run deployment tasks from its deployment history.</td>
</tr>
<tr>
<td></td>
<td>See “Restoring a computer from its deployment history” on page 131.</td>
</tr>
<tr>
<td></td>
<td>All deployment tasks in the bay’s history are run starting from the last Distributing a Disk Image task or Scripted OS Install task, or from any script (in a Run Script task) with this command: rem deployment start.</td>
</tr>
<tr>
<td></td>
<td>See “Distributing a disk image” on page 182.</td>
</tr>
<tr>
<td></td>
<td>See “Scripted OS install” on page 189.</td>
</tr>
<tr>
<td></td>
<td>See “Running a script” on page 210.</td>
</tr>
<tr>
<td><strong>Run Predefined Job</strong></td>
<td>The server processes any specified job. Select a job to run automatically when a new server is detected in the bay.</td>
</tr>
</tbody>
</table>
Table 4-16  Server deployment rules (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore the Change</td>
<td>This option lets you move blades to different bays without automatically running jobs. The server blade placed in the bay is not identified as a new server and no jobs are initiated. If the server existed in a previous bay, the history and parameters for the server are moved or associated with the new bay. If the server blade is a new server (never before identified), the established process for managing new computers is executed.</td>
</tr>
<tr>
<td>Wait for User Interaction</td>
<td>(Default) No job or tasks are performed (the Ghost Solution Suite Agent on the server blade is instructed to wait). The icon on the console changes to reflect that the server is waiting.</td>
</tr>
</tbody>
</table>

See “Computer configuration properties” on page 103.

Lights-Out

View information about the remote management hardware installed on the selected computer (most often a server) used to power up, power down and restart the computer remotely, or to check server status. You can also enter the password for the remote management hardware by clicking Password.

**Note:** This feature is currently only available for selected HP Integrated Lights Out (ILO) and Remote Insight Lights-Out Edition (RILOE) features.

See “Computer configuration properties” on page 103.

Remote operations using Ghost Solution Suite

The Operations menu in the Ghost Solution Suite Console provides a variety of commands to remotely manage all computers in your site or network segment. Some operation commands, such as Restore, automatically create and schedule deployment jobs and place them in the System Jobs folder in the Jobs pane. Other commands, like Chat or Remote Control, open utility programs to access and remotely manage computers.
Open the computer operations menu by right-clicking a computer icon in the **Computers** pane, clicking **Operations** on the menu bar, or clicking the icons in the toolbar.

**Table 4-17** Remote operations

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Restore</strong></td>
<td>Reconfigure your computer to a former state. Select from a list of previous deployment tasks and select to restore only the ones you want.</td>
</tr>
<tr>
<td></td>
<td>See “Restoring a computer from its deployment history” on page 131.</td>
</tr>
<tr>
<td><strong>History</strong></td>
<td>View, print, delete, and save to file a history of deployment tasks.</td>
</tr>
<tr>
<td></td>
<td>See “Viewing computer details” on page 97.</td>
</tr>
<tr>
<td><strong>Configure</strong></td>
<td>Set network and local configuration properties for each computer, including computer name, IP address, domains, Active Directory context.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring computers” on page 133.</td>
</tr>
<tr>
<td><strong>Quick Disk Image</strong></td>
<td>Select a computer and image its hard disk. This creates and stores the image to distribute now or later.</td>
</tr>
<tr>
<td></td>
<td>See “Quick disk image” on page 133.</td>
</tr>
<tr>
<td><strong>Power Control</strong></td>
<td>Wake up, restart, shut down, and log off remotely.</td>
</tr>
<tr>
<td></td>
<td>See “Power control” on page 218.</td>
</tr>
<tr>
<td><strong>Execute</strong></td>
<td>Type and run commands remotely.</td>
</tr>
<tr>
<td></td>
<td>See “Execute” on page 140.</td>
</tr>
<tr>
<td><strong>Copy File to</strong></td>
<td>Copy selected files, directories, or entire directory structures and send them to the selected computer(s).</td>
</tr>
<tr>
<td></td>
<td>See “Copying a file” on page 216.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat</td>
<td>Start an individual chat session with one or more selected client computers. Communicate actions or query for symptoms during administration. See “Chat” on page 141.</td>
</tr>
<tr>
<td><strong>ADVANCED &gt;</strong></td>
<td></td>
</tr>
<tr>
<td>Clear Computer Status</td>
<td>Clear computer status as shown in the title bar of the List View.</td>
</tr>
<tr>
<td>Prompt User for Properties</td>
<td>Query the user for personal information. This feature sends a form to the user to fill out. See “Prompt user for properties” on page 141.</td>
</tr>
<tr>
<td>Reset Connection</td>
<td>Disconnect and reset the connection between Ghost Solution Suite Server and the Ghost Solution Suite Agent on the selected computer.</td>
</tr>
<tr>
<td>Install Automation Partition</td>
<td>Embed automation partitions onto the selected computer's hard disk to enable a managed computer to run automation tasks.</td>
</tr>
<tr>
<td>Get Inventory</td>
<td>Update property settings for a selected computer. These inventory settings can be viewed in Computer properties. Select it to ensure that you have the latest inventory of the computer. Set the timeout value in the General tab of the Ghost Solution Suite Server Configuration utility (in the Control Panel).</td>
</tr>
<tr>
<td>Reject Connection</td>
<td>Refuse communication with the selected computer.</td>
</tr>
<tr>
<td>Install BIS Certificate</td>
<td>Install a BIS certificate for the selected computer.</td>
</tr>
<tr>
<td>Remove BIS Certificate</td>
<td>Remove a BIS certificate from the selected computer.</td>
</tr>
<tr>
<td>Uninstall agent</td>
<td>Uninstall the agent from the selected computer.</td>
</tr>
</tbody>
</table>
### Table 4-17  Remote operations (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply Regular License</strong></td>
<td>Apply a permanent license if a client computer is using a time-limited license or requires an updated license.</td>
</tr>
<tr>
<td><strong>New Job Wizard</strong></td>
<td>Open this to build, assign, and schedule deployment jobs for the selected computer. See “New job wizard” on page 162.</td>
</tr>
<tr>
<td><strong>New Group</strong></td>
<td>Click to create a new computer group in the Computers pane.</td>
</tr>
<tr>
<td><strong>New Computer</strong></td>
<td>Create a new computer account. See “Adding new computers” on page 99.</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>Assign the computer or group a new name in the console. Right-click a computer or group to edit in the Computer pane.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Delete a computer, a computer group, or any combination of computers and groups from the database.</td>
</tr>
<tr>
<td><strong>Change Agent Settings</strong></td>
<td>Update property settings for the Ghost Solution Suite Agent running on selected computer(s).</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>View security settings for the selected computer(s).</td>
</tr>
<tr>
<td><strong>Job Scheduling Wizard</strong></td>
<td>Open this to assign deployment jobs to the selected computer.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>View computer configuration and network properties. See “Computer properties” on page 125.</td>
</tr>
</tbody>
</table>

### Restoring a computer from its deployment history

Occasionally, it is necessary to restore a computer to its original settings based on operations or deployment jobs previously executed on the computer. A computer’s past deployment history appears in the **Restore Computer** dialog, where you can restore a computer by selecting the tasks from its history file. You can rerun the deployment tasks to restore the computer.
Restore a computer by right-clicking a computer icon in the **Computers** pane and selecting **Restore**, clicking **Operations > Restore Computer** on the menu bar, or clicking this icon in the toolbar. You can restore a computer using Remote Operations Using Ghost Solution Suite or by creating and scheduling a job using the New Job Wizard.

See “**Remote operations using Ghost Solution Suite**” on page 128.

See “**New job wizard**” on page 162.

To restoring a computer from its deployment history

1. Right-click a computer and click **Restore**.

   The **Restore Computer** dialog appears with a list of previous tasks with check boxes.

2. (Optional) Select the type of tasks to be displayed from the **Show only** drop-down list. Select the date from the **Since** list box to filter tasks.

3. Click **Next** to view a summary of tasks selected to reschedule.

4. Click **Next** to schedule the job.

   See “**Building and scheduling jobs**” on page 159.

5. Click **Finish**.

When you finish this computer operation, a new job appears in the Jobs pane of the Ghost Solution Suite Console under the **System Jobs > Restoration Jobs** folder. The job name has a generic format of Restore: <computer name>.

You can view the history of deployment tasks for a specific computer. Users who do not have administrative privileges or the permissions to delete a computer's history cannot access this option.

To view a computer’s history

1. Right-click a computer and click **History**.

   The History of <Computer Name> dialog appears with a list of previous tasks, including when the task was scheduled, its deployment status and other deployment information.

2. (Optional) Click **Save As** to save the file as a .TXT or .LOG file.

3. (Optional) Click **Print** to print the History file.

4. Click **Delete** to delete the History file. Click **Yes** to the confirmation message.

5. Click **Close**.

See “**Remote operations using Ghost Solution Suite**” on page 128.
Configuring computers

From the Operations menu, you can enter and modify configuration settings for computers. See “Computer configuration properties” on page 103. for complete information about configuration settings.

To configure computers

1. Right-click a computer and click **Configure**.
   
   The **Computer Configuration Properties** dialog appears.

2. Set basic configuration values in the **General** configuration group (default view).

3. Click other configuration group icons in the left pane to set additional values.

4. Click **OK**.

See “Remote operations using Ghost Solution Suite” on page 128.

Quick disk image

This computer operation creates a disk image of the selected computer. This option is a quick and easy way to create a disk image of a selected managed computer from the Ghost Solution Suite Console.

To run a disk image job you must have an automation partition installed on the client computer, or it is PXE-enabled and can boot to automation by connecting to a PXE Server.

To create a quick disk image

1. Right-click a computer and click **Quick Disk Image**.
   
   The **Schedule Computers for Job** dialog appears.

   See “Building and scheduling jobs” on page 159.

2. Schedule the job to run immediately or at a later time. You can also click the option to not schedule the job (this option places the job in the working area and does not run until you manually drag it to a selected computer and reschedule it).

3. Click **OK**.

A new job appears in the Jobs pane of the Ghost Solution Suite Console under the **System Jobs > Image Jobs** folder. The job name has a generic format of **Create Image: <computer name>**.

See “Remote operations using Ghost Solution Suite” on page 128.
Power control

This computer operation lets you wake up a computer, restart a computer, shut down, or log off as the current user for a selected managed computer. You can also power a computer on if Wake-On-Lan is supported.

Restore a computer by right-clicking a computer icon in the Computers pane and selecting Power Control, clicking Operations > Power Control on the menu bar, or clicking the icon on the toolbar.
To control power

1 Right-click a computer and select **Power Control**.

A secondary menu appears with the following options:

- **Wake-up**: The Wake-Up feature is hardware-dependent and is available only for inactive computers. Select this command to start a computer that has been turned off.

  Your operating system and network adapter must be capable of recognizing and processing the Wake-on-LAN packets. Non-embedded network adapters must be properly configured. Example: 3Com NICs have an extra header cable that enables Wake-on-LAN. Check the documentation that comes with your network adapter for more information about Wake-on-LAN.

  For NICs and operating systems that support Wake-on-LAN Power Management features, go to the **Properties** dialog of the network adapter driver and select the **Power Management** tab. Click the **Allow this device to bring the computer out of standby** option for this device to bring the computer out of standby status.

  You must enable this feature for some computers in their BIOS.

- **Restart**: Click to reboot the selected managed computer. Select **Force Applications to close without a message box** to restart immediately without prompting the user.

- **Shut down**: Click to shut down the selected managed computer. Select **Force Applications to close without a message box** to shut down immediately without prompting the user.

- **Log off**: Click to log off the selected managed computer. Select **Force Applications to close without a message box** to log off immediately.
2 Select a Power Control option. A **Confirm Operation** dialog appears. Select the **Force application to close without a message** option to shut down users without a warning. If you do not select this option, the user is prompted to save work before the power operation continues.

3 Click **Yes**.

See “Remote operations using Ghost Solution Suite” on page 128.

**Remote control**

Multiple methods are provided to remote control managed computers. The integrated GSS remote control utility can be used on Windows XP, 2003 Server, and 2000 computers.

Additionally, you can access the built-in Remote Desktop feature built into many Windows operating systems directly from the Ghost Solution Suite Console. You can also manually add access to other remote control utilities by modifying a configuration file.

- GSS remote control
- Remote desktop connection
- Additional remote control programs

**GSS remote control**

Remote Control is a computer management feature built into the Ghost Solution Suite Server Console. It lets you control all types of computers to view problems or make immediate changes as if you were sitting at the managed computer's screen and using its keyboard and mouse.

When a managed computer is being remotely controlled, the Ghost Solution Suite Agent icon in the managed computer's system tray flashes these two icons alternately.

Remote Control also provides Chat, Refresh, , Send File, and **Ctrl+Alt+Delete** features to assist in managing computers from the console. See Chat and Copying a file.

**Note:** You cannot disable the flashing eye icon while the computer is being remotely controlled.

Before you can remotely control a managed computer:

- The managed computer must have the Symantec Agent for Windows installed and properly set up.
The client must have the appropriate **Proxy** option selected in Symantec Client Properties.

- The client and Ghost Solution Suite Server Console must be able to communicate to each other through TCP/IP.

**To remotely control a managed computer**

1. Right-click a computer and click **Remote Control > GSS Remote Control**.
   This opens the Remote Control window displaying the managed computer's screen.

---

**Note:** If you cannot perform a remote-control operation from the selected managed computer, you can change this client setting by using the Remote Control options in the **Change Agent Settings** command. The default setting is to not allow remote control of the managed computer.
From the Remote Control window, you can execute the following commands:

**Toolbar**

**Chat**
Click to open a chat session with the selected managed computer. This starts a chat session between the console computer and the managed computer. The chat session opens a chat window that lets you send messages back and forth between the Ghost Solution Suite Console and the managed computer. If you start a chat session while controlling multiple computers in a single window, the chat session is only between the Ghost Solution Suite Console and the master client.

**Refresh**
Click to update the screen view of the managed computer.

**Ctrl+Alt+Delete**
Click to select **Restart** or **Logon** options for the managed computer.

*Note:* The managed computer must be running Windows 2000, XP, 2003, 2008, and Vista and have the keyboard and mouse driver installed for this feature to be available.

**Send File**
See Send files during remote control.

**Toggle Control**
Click to toggle between the view of control access of the managed computer (default) and of access only of the managed computer.

**Control menu**

**Disable Input from the Client**
Click to prohibit the user of the managed computer from using the keyboard or mouse during the remote-control session.

**Close Window**
Click to close the remote control window of the managed computer.

**View menu**

**Refresh**
Click to refresh the view of the screen.
Fit to Window
If this option is selected, the client display image becomes the same size as the Remote Control window. If this option is not selected, the image retains the size of the client display.

Color Depth
See “Remote operations using Ghost Solution Suite” on page 128.

Properties
See “Remote operations using Ghost Solution Suite” on page 128.

3 To end a Remote Control session, click Control > Close Window in the Remote Control window.

Remote desktop connection
Remote Desktop connection is available for many Windows operating systems including Windows Vista and 2008 Server.

To remotely connect to a computer
1 Open the Ghost Solution Suite Console and right-click the Vista computer you want to remotely connect.
2 Click Remote Desktop. The remote desktop window for the computer appears. The remote desktop connection is established to the Vista computer.

To remotely connect to multiple computers using the Remote Desktop option
1 Open the Ghost Solution Suite Console and right-click the computer you want to remotely connect.
2 Click Remote Desktop. The remote desktop window for the computer appears. The remote desktop connection is established to the computer.

To remotely connect to multiple computers
1 Open the Ghost Solution Suite Console and right-click the computers you want to remotely connect.
2 Click Remote Control. The Remote Control Options dialog appears.
3 Select Control each client separately in its own window to remote control each computer separately.

or

Select Control all clients together, in the same window, using the following master to remote control the selected computers together and select the master computer.

4 Click OK.

The remote control connection is established for the computers.

Additional remote control programs

You can manually add access to additional remote control programs to the Remote Control menu in the Ghost Solution Suite Console.

To add a program, open the RemoteControlTools.ini located at the root of your Ghost Solution Suite Share and follow the instructions provided in the file.

Execute

Send a command from the Ghost Solution Suite Console as if you were entering a command from the command-line prompt on the client computer.

Execute a command to a client computer by right-clicking a computer icon in the Computers pane and selecting Execute, clicking Operations > Execute from the menu, or clicking this icon in the toolbar.

To execute

1 Type a command you would like executed on the selected remote computer(s), or select from a list of previously-run commands. Example: Type regedit to open the registry on the computer.

2 To run the command as another user on the managed computer, click User and enter the user name and password.

User account

Use this dialog to run a script using another local user account. You can log in with another user name and password with rights to run an execute command.

Table 4-18

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run with default security credentials.</td>
<td>This option runs with the current user credentials. This is the default option.</td>
</tr>
</tbody>
</table>
Table 4-18  (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run with the following credentials</td>
<td>Click this option to log on with another user name and password.</td>
</tr>
</tbody>
</table>

See “Remote operations using Ghost Solution Suite” on page 128.

Chat

You can communicate with managed computers using the Chat text messaging system. From the Ghost Solution Suite Server Console, select an individual computer or a group of computers to open an individual chat session with each logged-in user.

Open text messaging with a user by right-clicking the computer icon in the Computers pane and selecting Chat, or clicking this icon in the Remote Control dialog.

See “Remote control” on page 136.

To chat

1. Open a chat session. The Chat with <computer name> window appears, identifying the computer you are sending messages to.
2. Type a message in the lower field.
3. Click Send or press Enter.
   The exchange of text messages appears in the upper field.

See “Remote operations using Ghost Solution Suite” on page 128.

Prompt user for properties

This feature lets an administrator prompt a user for computer location and user information. The information supplied in this form appears in the Location properties in the Computer Properties dialog.

See “Computer properties” on page 125.
To prompt a user for location properties

1 In the Computers pane of the Ghost Solution Suite Server Console, right-click a computer and click Advanced > Prompt User for Properties. You can also select a computer and click on the Prompt User for Properties icon in the toolbar or click on Operations > Prompt User for Properties.

A dialog appears in the Ghost Solution Suite Server Console with a list of properties.

2 Select the properties to prompt the user. The properties selected in this dialog are active on the property form sent to the user, letting the user enter information for the selected properties.

Note: All properties are selected by default; you must deselect the properties you don't want to include when the client is prompted.

3 Click OK.

The properties form appears for the logged-on user of the computer, asking for location properties.

When the user enters information and selects OK, the Location properties in the Computer Properties field are updated for the selected computer. If the user changes the computer name, the name in the Computers pane of the Ghost Solution Suite Console also changes. These settings are stored directly to the Ghost Solution Suite Database.

See “Remote operations using Ghost Solution Suite” on page 128.

Install automation partition

When the Ghost Solution Suite Server sends a deployment job to client computers, tasks within the job can be assigned the default automation pre-boot environment, Linux, or WinPE. With an embedded (recommended) or hidden automation partition installed on the client computer's hard disk, deployment jobs can run automatically.

You can have multiple tasks within a deployment job, and each task can be assigned to run in a different automation environment, depending on the task and end result you want. The following are the automation tasks you can add to the deployment jobs:

- Run script
- Create disk image
- Distribute disk image
Scripted OS install

During the Ghost Solution Suite Server installation, the Pre-boot Operating System page appears for you to select a default pre-boot operating system, which is used by Boot Disk Creator to create the configurations that boot client computers to automation. You can install additional pre-boot operating system files through Boot Disk Creator. See Boot Disk Creator Help.

If you are running PXE Servers, you do not need to install an automation partition on each client computer’s hard disk. When the Ghost Solution Suite Server sends a deployment job, PXE-enabled client computers search for a PXE Server to receive the boot menu options and the boot menu files that are required to boot to automation. See Automation Pre-boot Environment in the Ghost Solution Suite Server Reference Guide.

To install an automation partition

1. Right-click a computer and click Advanced > Install Automation Partition.

2. From the drop-down list, select the pre-boot operating system environment you want to install.

3. Click OK.

The Automation Agent you selected installs as an embedded partition on the client computer’s hard disk. After the installation completes, the client computer reboots automatically. You can now run automation-specific deployment tasks on this computer.

Change agent settings

This feature lets you modify most of the agent settings for a selected computer or computer group. You can set properties for the Production Agent (Ghost Solution Suite Agent), or for an Automation Agent.

To change agent settings

1. From the Computers pane, right-click a computer and select Change Agent Settings.

2. Select either Production Agent or Automation Agent.

3. Edit the properties settings.

4. Click OK.
Deploying and managing servers

Ghost Solution Suite provides additional features to remotely install, deploy and manage network servers. From the Ghost Solution Suite Server Console, you can configure new server hardware, install operating systems and applications, and manage servers throughout their life cycle. And because servers are mission-critical, you can set up a system to quickly deploy new servers or automatically re-deploy servers that have failed. Features like rules-based deployment, support for remote management cards, and quick server restoration from a deployment history give you new tools to manage all servers throughout your organization.

Servers are identified in the Computer pane with distinctive server icons. Like all managed computer icons, the icons change to identify the status and state of the computer, such as user logged on or Server Waiting.

**Note:** Servers are recognized by their operating system (such as Windows 2000 Advanced Server, Windows Server 2003, 2008, or any Linux operating system), multiple processors, and specific vendor server models.

<table>
<thead>
<tr>
<th>Table 4-19</th>
<th>Deploying and managing servers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Manage Servers from the Console.</td>
<td>The Ghost Solution Suite Server Console includes features specifically designed for deploying and managing servers, such as enhanced task logging and history tracking features to let you recall administrative actions and quickly redeploy mission-critical servers.</td>
</tr>
<tr>
<td>Set Server-specific options.</td>
<td>Servers are essential to any organization and require special planning and management strategies. Ghost Solution Suite Server provides server-specific features to automatically deploy new servers and maintain existing servers. See “Server deployment options” on page 146.</td>
</tr>
</tbody>
</table>
Server management features

Ghost Solution Suite Server provides various features for deploying and managing servers. These features are supported for client computers as well, but are essential in deploying servers.

Server icons. The Ghost Solution Suite Console displays icons that identify servers across the network. Like other computer icons in the console, server icons can be selected to view server properties or assign specific jobs and management tasks.

The following states are displayed:

- The server is active and a user is logged on.
- The server is disconnected from the console.
- The server is in a waiting state.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Scripted Installs.</td>
<td>Execute scripted, unattended installs across the network for both Microsoft Windows and Linux servers. Follow steps to create answer files and set up operating system install files using a wizard. See “Scripted OS install” on page 189.</td>
</tr>
<tr>
<td>Support for multiple network adapter cards</td>
<td>Because servers may require more than one network interface card, Ghost Solution Suite Server provides property pages to access and configure multiple network adapters remotely from the console. See “TCP/IP configuration settings” on page 108.</td>
</tr>
<tr>
<td>Synchronized server date and time.</td>
<td>Ghost Solution Suite Server automatically sets the server’s date and time after installing or imaging (as part of the configuration process). Ghost Solution Suite Agents include an option to disable this feature (it is off by default).</td>
</tr>
<tr>
<td>Enhanced scripting capabilities.</td>
<td>Ghost Solution Suite Server also lets you view and debug each step in the deployment script, and track each job to provide a history of tasks for redeploying a server.</td>
</tr>
</tbody>
</table>
Server deployment options

Ghost Solution Suite Server includes features to automatically reconfigure and redeploy new servers. If you are using Initial Deployment to automatically re-image new servers or run installation scripts, you can (1) safeguard against mistaken disk overwrites, or (2) run automatically for every server not identified as a managed computer in the database. These contrasting settings are based on polices you define for managing servers in your organization.

Example: If you rely on PXE to boot the new server and you want to deploy new servers automatically without halting the process, you must change the default settings in the PXE Configuration Utility. In contrast, if you want to ensure that the server waits before being deployed (or waits a set time before proceeding) to avoid erroneous re-deployment, you must set the options in the Advanced section of Initial Deployment.

When a server boots from a PXE server or from Automation (if the option is set), Ghost Solution Suite Server recognizes it as a new computer and attempts to configure the computer with sample jobs. See Sample jobs. Initial Deployment includes a feature to prohibit servers from being deployed automatically.

To halt the initial deployment of servers

1  Click Initial Deployment and select Properties.
2  Click the Advanced tab.
3  Select the Servers check box and click OK.

Initial Deployment does not run for any computer identified in the console as a server.

If installing a server using a PXE Server, the server attempts to install, but does not run automatically using default settings. It waits until a boot option is selected from the client computer. You can change the default setting in the PXE Configuration Utility to allow Initial Deployment to run automatically and not wait for user intervention.

To change PXE options for initial deployment

1  Click on Start > All Programs > Altiris > PXE Services > PXE Configuration Utility.
2  Click the GSS tab.
3  Select a pre-boot operating system from the Initial Deploy boot option drop-down list.
4  Click Execute Immediately.

Initial Deployment runs automatically for every identified server.
When you run a deployment job on a computer where the Ghost Solution Suite Agent is remotely installed, a message appears stating that no BootWorks partition or PXE stamp is found. The message remains open until the user clicks OK on the message dialog, which delays executing the scheduled job as part of an automated redeployment process. To fix this delay:

**To clear BootWorks prompt for remote listall**

1. Select **Tools > Options**. The Program Options dialog appears.
2. Select the **Agent Settings** tab.
3. In the Automation Agent Settings section, select the Force new Automation agents to take these settings check box and click Change Default Settings.
4. Click OK.

Following these steps, ensures that the BootWorks message does not appear and a job runs smoothly when scheduled.

**Managing server blades**

Ghost Solution Suite lets you manage high-density server blades with Rack/Enclosure/Bay (R/E/B) hardware and properties. From the Ghost Solution Suite Console, you can deploy and manage these space-efficient server blades using the **physical view** to assign jobs to the Rack, Enclosure, or Bay level of the server cluster, or you can manage each server blade directly from the **logical view**.

See Bay for properties and rules to deploy Rack/Enclosure/Bay servers.

Using Ghost Solution Suite, you can employ rip and replace technology that lets you insert a new server blade and automatically configure and deploy it exactly like the previously installed server blade, letting you replace any server that is down and get it back on line quickly. By default, the replay option is checked when you create a new job. This option replays the job during any rip and replace actions.

Symantec provides fail-safe features to ensure that no server is mistakenly overwritten and that all disk images, software, data, and patches are applied to the new server from the history of jobs assigned to the previous server blade.

**Managing new server blades**

Ghost Solution Suite lets you automatically deploy, configure and provision new server blades using a variety of features, including Sample Jobs and Server Deployment Rules.

See “Sample jobs ” on page 227.
See “Server deployment rules” on page 127.

New server blades in newly identified bays

When new blades are identified in a Bay that has not been used previously (if it has been used previously, the Bay object is identified in the physical view), both the Initial Deployment and Virtual Bays features can be set up to automatically run configuration tasks and deployment jobs.

To Create Virtual Bays: Set up Virtual Rack/Enclosure/Bays for Hewlett-Packard Rapid Deployment Pack installations of Ghost Solution Suite.

Initial Deployment setup: Clear the Servers check box in the Advanced dialog.

If both new computer features are set up and a new server blade is installed in a Bay not previously identified by the Ghost Solution Suite Server, the Create Virtual Bay feature executes and Initial Deployment does not execute.

New server blades in identified bays

If a new HP server blade is installed in an identified Bay (one that already has a server blade installed and is visible from the Ghost Solution Suite Console), both Sample Jobs in Ghost Solution Suite and Server Deployment Rules can be set up. However, when both are set up, the Server Deployment Rules execute and Initial Deployment does not execute.

Virtual bays

Hewlett-Packard blade servers now have a Virtual Bay feature that lets you pre-assign deployment jobs to the Rack, the Enclosure, or to a specific blade server in the Bay. Any HP blade server can have predefined deployment jobs and configuration tasks associated with it to execute automatically upon installation. (This feature requires that the Hewlett-Packard Rapid Deployment Pack is installed.)

The Virtual Rack/Enclosure/Bay icons change from virtual icons to managed server icons in the Ghost Solution Suite Console as live blade servers are inserted and identified by Ghost Solution Suite.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack name</td>
<td>Enter or edit the name of the Rack.</td>
</tr>
<tr>
<td>Enclosure name</td>
<td>Enter or edit the name of the Enclosure.</td>
</tr>
<tr>
<td>Enclosure type</td>
<td>Select the type of HP server blade from the list.</td>
</tr>
</tbody>
</table>
Table 4-21  (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Job</td>
<td>Select an existing job to run when the pre-configured computer account is</td>
</tr>
<tr>
<td></td>
<td>associated with a new server blade.</td>
</tr>
<tr>
<td>Server Change rule</td>
<td>Select the Server Deployment Rules to run on the Bay when a new server blade</td>
</tr>
<tr>
<td></td>
<td>is installed.</td>
</tr>
</tbody>
</table>

See “Server deployment rules” on page 127.

**Note:** If you create Virtual Bays for an enclosure (such as the BLe-class with 20 bays) and if another model of server blade with an enclosure containing fewer bays is connected (such as the BLp-class with 8 bays), the excess virtual bays are truncated automatically. Conversely, if you create Virtual Bays with fewer bays (8) and install an enclosure with additional bays (20), you must re-create the virtual bays in the enclosure (right-click the enclosure name in the physical view and click **New Virtual Bays**).

**Hewlett-Packard server blades**

Hewlett-Packard high-density blade servers can be deployed and managed from the Ghost Solution Suite Console. The following HP server blades are supported:

- **HP Proliant™ BL e-Class**
  - Proliant™ BL 10e
  - Proliant™ BL 10e G2

- **HP Proliant™ BL p-class**
  - Proliant™ BL 20p
  - Proliant™ BL 20p G2
  - Proliant™ BL 40p

HP blade servers let you employ all features provided in the Ghost Solution Suite Console when you install the HP Proliant Essentials Rapid Deployment Pack (see www.hp.com/servers/rdp), including the Virtual Blade Server feature. The name of each Rack for an HP Server appears along with the assigned name for the Enclosure and Bay. These names are collected from the SMBIOS of the server blade and appear in both the physical and server views within the Computers pane of the Ghost Solution Suite Console.

For HP blade servers in the physical view, the Rack name can be a custom name in the console, with all subordinate Enclosures and Bays also identified. Example:
Dell server blades

Dell high-density blade servers can be deployed and managed from the Ghost Solution Suite Console. All Dell Rack Servers are supported by Ghost Solution Suite, but the server blades can also be managed from the physical view in the Rack/Enclosure/Bay view. The following servers are supported:

<table>
<thead>
<tr>
<th>Dell Rack Servers</th>
<th>Dell Server Blades</th>
</tr>
</thead>
<tbody>
<tr>
<td>All PowerEdge™ rack servers</td>
<td>PowerEdge™ 1655MC</td>
</tr>
</tbody>
</table>

For Dell blade servers in the physical view, the Rack name is always Dell. All subordinate Enclosures and Bays are identified with custom names under the Dell rack name. Example:

Dell

<enclosureName>

<bayName>

See “Server management features” on page 145.
See “Server deployment options” on page 146.

Fujitsu-Siemens server blades

Fujitsu-Siemens high-density blade servers can be deployed and managed from the Ghost Solution Suite Console. All Fujitsu-Siemens Rack Servers are supported by Ghost Solution Suite, but the server blades can also be managed from the physical view in the Rack/Enclosure/Bay view. The following servers are supported:

<table>
<thead>
<tr>
<th>Fujitsu-Siemens Rack Servers</th>
<th>Fujitsu-Siemens Server Blades</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Primergy™ rack servers</td>
<td>Primergy™ BX300 blade servers</td>
</tr>
</tbody>
</table>

For Fujitsu-Siemens blade servers in the physical view, the Rack name is always Fujitsu-Siemens. All subordinate Enclosures and Bays are identified with custom names under the Fujitsu-Siemens rack name.
Example:

Fujitsu-Siemens
<enclosureName>
<bayName>
See “Server management features” on page 145.
See “Server deployment options ” on page 146.

Note: If you have Fujitsu-Siemens Server blades managed by the Ghost Solution Suite Server, ensure that the SNMP service is running on the Ghost Solution Suite Server. Also, if the Ghost Solution Suite Server is installed on a Windows 2003 server, ensure that the security is set correctly to receive traps from remote computers. By default, Ghost Solution Suite Servers cannot receive traps from remote computers.

IBM server blades

IBM high-density Blade Centers can be deployed and managed from the Ghost Solution Suite Console. All IBM blade servers are supported by Ghost Solution Suite, but the server blades can also be managed from the physical view in the Rack/Enclosure/Bay view.

For IBM blade servers in the physical view, the Rack name is always IBM. All subordinate Enclosures are identified with custom names under the IBM rack name and Bays are identified by number. Example:

IBM
<enclosureName>
<baynumber>
See “Server management features” on page 145.
See “Server deployment options ” on page 146.

Finding a computer in the database

This search filter lets you type a string and query specified database fields for specific computer properties. You can search for user or computer names, licensing or location information, or primary lookup keys: MAC address, serial number, asset number, or UUID. This search filter queries property values appear in the Computer Properties pages.

See “Computer properties ” on page 125.
Click <CTRL> F or click Find Computer on the console toolbar to search the Ghost Solution Suite Database for computers by property settings. The search begins at the top of the computer list and highlights the computer name in the Computers pane when a match is found. Press F3 to find the next computer that matches the search criteria until there are no more results, or the end of the computer list is reached.

To find a computer in the database

1. In the Search For field, type all or part of the computer’s property values you would like to search for. This alpha-numeric string is compared with specified database fields.

2. From the In Field drop-down list, select the field you want to search in the Ghost Solution Suite Database.

Example: To find a computer by searching for its IP address, type the address in the Search For field and select the IP Address from the In Field drop-down list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>BIOS name of the computer.</td>
</tr>
<tr>
<td>Computer Name</td>
<td>Ghost Solution Suite name of the computer.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Example: 0080C6E983E8.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Example: 192.168.1.1.</td>
</tr>
<tr>
<td>ID</td>
<td>Example: The computer ID. 5000001.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Serial number installed in BIOS. A primary lookup key.</td>
</tr>
<tr>
<td>Asset Tag</td>
<td>Asset number in BIOS. A primary lookup key.</td>
</tr>
<tr>
<td>UUID</td>
<td>A primary lookup key.</td>
</tr>
<tr>
<td>Registered User</td>
<td>Name entered when the operating system was installed.</td>
</tr>
<tr>
<td>Product Key</td>
<td>Product Key for the operating system.</td>
</tr>
<tr>
<td>Logged On User</td>
<td>Name of the user currently at the computer.</td>
</tr>
<tr>
<td>Physical Bay Name</td>
<td>The actual bay number. Example: 7x.</td>
</tr>
</tbody>
</table>

The computer you are looking for appears highlighted in the Computers window in the console.
Using lab builder

Use the Lab Builder to set up jobs under the Lab folder in the Jobs pane to set up a classroom or lab environment.

Click Lab Builder on the console toolbar or click File > New > Lab Builder to set up jobs specifically created for managing multiple computers in a lab environment.

You can set up jobs to:

- Create Disk Image
- Deploy Lab
- Restore Lab
- Update Configuration
- Upload Registries

Each of these jobs contains a default list of tasks. Lab Builder places these five new jobs under a folder (which you name) located under the Lab folder. All tasks in the jobs have been assigned default paths and file names that let them use the same images and configuration information, registry data, and so on. We recommend that you do not change the file names and paths. If you change the default settings (example: changing the image name), you must change them in all jobs where the image is used.

To use Lab Builder

1. Click the Lab Builder icon on the toolbar, or choose File > New > Lab Builder.
2. Enter the name of the Lab Setup.
3. (Optional) Enter a lab description to help you differentiate the lab from others and click OK.
4 Identify an image in the **Create Disk Image** job.

See “Creating a disk image” on page 174.

5 Set computer names and addresses in the **Update Configuration** job.

The following information describes the default jobs. To run one of these jobs, simply drag it to the computer or computer group you want it applied to.

**Create Disk Image**

This job uploads an image of a computer to the server and an image name is created automatically based on the lab name. However, there is no actual image in the job until you drag the image source computer to this job.

**Deploy Lab**

This job has three default tasks: Deploy image, Apply configuration settings, and Back up registry files. The image that is uploaded using the Create Disk Image job is deployed when you use this job. The configuration settings you specify in the Update Configuration job are applied to the computers, and the computer registry files are uploaded to the Ghost Solution Suite Server.

**Restore Lab**

This job restores the image and registry files to a computer where a lab was previously deployed. You can quickly get a computer running again by restoring the lab on that computer.

**Update Configuration**

This job lets you set unique configuration information (such as computer names and network addresses) for client computers. When a lab is deployed, each computer has an identical image, but not the same configuration settings. This means you don’t have to visit each computer to reset the IP addresses and other settings when you deploy an image.

**Upload Registries.**

This job backs up computer registry files to the Ghost Solution Suite Server.
New Dynamic Machine Groups

The New Dynamic machine group lets you create groups of computers based on a filter. Following are the fields and the description of the New Dynamic machine group dialog:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Machine Group Name</td>
<td>Enter a name for the group</td>
</tr>
<tr>
<td>Group</td>
<td>Select an existing group or select all computers, New computers or New Group</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a filter based on which the computer or groups of computers are filtered.</td>
</tr>
</tbody>
</table>

If you want to edit or modify filters use Setup>>.

See “Filter Setup” on page 156.

Creating and modifying filters

Ghost Solution Suite lets you create filters for computers. A filter lets you specify a set of conditions based on which the computers that are present on the network are filtered.

For example: If you want to find out all the computers whose RAM is equal to 4MB, then you can set the filter where Field is RAM(total), operation is set as at most and value as 4.

**Note:** To delete a condition of a filter, select the filter condition from the Filter Setup dialog and click Delete.

To create filters

1. In the Ghost Solution Suite console, navigate to the Computers section and right-click to view the options.
2. From the options, select New Group.
3. In the Filter Setup dialog, enter the name of the filter that you want to create.
4. Click Add....
5. In the Filter definition dialog, select the field from the drop-down list.
6. Select the operation parameter.
7 Enter the Value of the parameter.
8 Click OK.
9 In the Filter Set up dialog, click OK.

To modify a filter
1 In the Ghost Solution Suite console, navigate to the Computers section.
2 From the Computers section, select the filter that you want to modify.
3 Click Setup>>.
4 In the Filter Set up dialog, select the condition that you want to modify.
5 Click Modify...
6 In the Filter definition dialog, modify the filter condition.
7 Click OK.
8 In the Filter Set up dialog, click OK.

Filter Setup

The Filter Set up dialog lets you create, modify, and delete the filters that are applied to the computers in the network. A filter is a set of multiple conditions based on which the computers that are present on the network are filtered. After you add the conditions to the filter, the table displays all the conditions that are set for the filter.

Following are the field and description of the Filter Set up dialog:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Add the name for the filter.</td>
</tr>
<tr>
<td>Add...</td>
<td>Click on this option to add conditions to a filter.</td>
</tr>
<tr>
<td>Modify...</td>
<td>To enable the Modify option, select the condition from a filter that you want to modify.</td>
</tr>
<tr>
<td>Delete</td>
<td>To enable the Delete option, select the condition from the filter that you want to delete.</td>
</tr>
</tbody>
</table>

Following are the field and description of the Filter Definition dialog:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Select the name of the condition to be added from the drop-down list</td>
</tr>
<tr>
<td>Operation</td>
<td>Select from the following operators:</td>
</tr>
<tr>
<td></td>
<td>■ contain</td>
</tr>
<tr>
<td></td>
<td>■ does not contain</td>
</tr>
<tr>
<td></td>
<td>■ ends with</td>
</tr>
<tr>
<td></td>
<td>■ is exactly</td>
</tr>
<tr>
<td></td>
<td>■ starts with</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the value for the condition that you want to use.</td>
</tr>
</tbody>
</table>

See “Creating and modifying filters” on page 155.
Building and scheduling jobs

This chapter includes the following topics:

- Building and scheduling jobs
- Viewing job details
- New job wizard
- Building new jobs
- Job scheduling wizard
- Setting conditions for task sets
- Deployment tasks
- Creating a disk image
- Distributing a disk image
- Scripted OS install
- Scripted install for Windows XP, Windows Server 2003 and earlier
- Scripted install for Windows Vista, Windows Server 2008, and later
- Scripted install for Linux
- Distributing software
- Capturing personality settings
- Distributing personality settings
Building and scheduling jobs

A job represents a collection of predefined or custom deployment tasks that are scheduled and executed remotely on selected client computers. You can build jobs with tasks to automatically create and deploy hard disk images, back up and distribute software or personality settings, add printers, configure computer settings, and perform all aspects of IT administration. Jobs can be run immediately for a specific computer, or stored and scheduled for daily or long-term administrative duties on multiple computer groups.

Job icons appear in the Jobs pane of the Ghost Solution Suite Console. To assign and schedule a job in the Ghost Solution Suite Console, drag the job icon to selected
Computer icons. Job status icons also appear in the Details pane of the Ghost Solution Suite Console to indicate various deployment states.

See “Viewing job details” on page 160.

The New Job Wizard guides you through common deployment and management jobs. It is an easy way to set up new users or migrate users to new computers, create and distribute images of computers on the network, distribute software packages, restore computers, and more.

See “New job wizard” on page 162.

Jobs include one or more Deployment tasks. You build jobs by adding tasks to a job and customizing the task for your specific needs. You can add tasks to capture and distribute images, software packages, and personality settings. You can also write and run a script task, or run scripted installs, configure settings, copy files and back up registry settings. You can also modify existing jobs by adding, modifying, copy and pasting, or deleting tasks to suit your requirements.

See “Building new jobs” on page 167.

Set conditions on jobs to run only on computers with properties that match the criteria you specify. You can build one job to run on different computer types for different needs, and avoid mistakes by ensuring that the correct job runs on the correct managed computer. Add links.

See “Setting conditions for task sets” on page 168.

Initial Deployment lets you run predefined jobs and configuration tasks on new computers when they start up. You can automatically deploy new computers by imaging and configuring TCP/IP, SIDs, and other network settings and installing basic software packages. See Sample jobs .

Sample jobs are installed with Ghost Solution Suite and appear in the Samples folder of the Jobs pane. You can run many sample jobs as they are, or you can set environmental variables. See Sample jobs.

### Viewing job details

As jobs are assigned, scheduled and executed, it is helpful to know specific details about their status and assignments. The Ghost Solution Suite Console provides job icons to show the state and status of the job in the Details pane:

- Job status icons that update the state of the job in running deployment tasks. These icons are graphical symbols in the Ghost Solution Suite Console used to identify the status of an assigned job.
A job is scheduled to run on a computer or computer group.

A job is in progress.

A job has executed successfully.

A job is associated with a computer or group of computers but is not scheduled.

Indicates error conditions when individual tasks run.

- A description of the job, if available. You can also use Add or Modify in the main window to edit the description.

- If a job defines error conditions when individual tasks run, the Status field displays any errors incurred and the tasks that completed successfully.

- Job Schedule details. This is the job's run time, beginning when the job started and ending when it completed successfully.

- The currently applied conditions appear in a list box with a Setup option to add conditions to different task sets for different computer properties within a job. Conditions specify characteristics that a computer must have before the job runs. See Setting conditions for task sets.

- A list of tasks assigned to the job and task descriptions also appears. Change the order of the task execution with the up and down arrows. Tasks are executed in the order they are listed. See Deployment tasks.

- Features to add, modify, and delete tasks for each job.

- A list of assigned computers and its deployment history.

To sort jobs or computer details, just point and click on the category in the Details pane. Example: Click the Status column heading to organize and display the progress status of the job.

See “Viewing computer details” on page 97.
New job wizard

The New Job Wizard provides integrated features to build, assign, and schedule common deployment jobs. It helps you build the most common jobs, and guides you through additional steps to assign and schedule the jobs to selected computers. It lets you quickly build image files and deploy new computers, distribute software packages, migrate users, and more.

Note: When a software package or deployment job is scheduled to run on client computers, the Symantec Client Service Message dialog appears, warning them that a job is about to execute. If a user clicks Abort when the message appears, an event is logged to the client’s history so that Ghost Solution Suite administrators know when users abort a scheduled event.

Create a new job by clicking New Job Wizard on the Ghost Solution Suite Console, clicking File > New > Job Wizard, or right-clicking in the Jobs pane of the Ghost Solution Suite Console and selecting New Job Wizard. The New Job Wizard appears to guide you through basic deployment jobs.
To create a New job

1. Select a job option:
   - Create an image. This wizard guides you through the steps required to create an image of a computer's hard disk and schedule the job.
     See “Creating a disk image” on page 174.
   - Deploy and configure computers. This wizard guides you through the steps required to deploy a previously created new disk image on a selected computer and install software and personality settings.
     See “Distributing a disk image” on page 182.
   - Deploy software packages. This wizard guides you through steps required to install software packages. You can set conditions, select packages, assign to computers, and schedule the job.
     See “Distributing software” on page 200.
   - Restore a computer. This wizard guides you through the steps required to restore a computer to a known working state by re-imaging the hard drive and reinstalling software packages, personality settings, and defining configuration values. This option reschedules jobs saved in each managed computer's history record, which contains all deployment tasks previously processed. See Restoring a computer from its deployment history.
   - Migrate computers. This wizard guides you through the steps required to migrate the hard disk image, applications, and personality settings from a source computer to a destination computer. You can perform one or more migration operations using the provided options.

2. Give the job a unique name. You can type a name up to 64 characters.

3. Follow the steps in each wizard to create a job (some New Job wizards build multiple jobs).

4. (Optional) Unselect the Replay during rip and replace option. This option is selected by default. This option replays the job during any rip and replace actions.

After creating a job, the job appears in the Jobs pane of the Ghost Solution Suite Console with the deployment tasks listed in the Tasks list.

**Note:** You cannot define return codes when using the New Job Wizard. See “Building new jobs” on page 167.

See “Modifying tasks in a deployment job” on page 219.
Migrating computers

From the **New Job Wizard**, you can select **Migrate computers** to quickly distribute hard disk images, software, and settings from a user's current computer to a new computer. You can image a new computer's hard disk with a new operating system and install software and personality settings. Or perform different levels of migration to distribute only software or to simply capture and distribute personality settings to the new computer.

**Migrate one computer to another separate computer**

Click this option to migrate a user from a source computer (old computer) to another destination computer (new computer). Capture personality settings, distribute a new hard disk image, distribute software and redistribute the saved personality settings from the source computer to the new destination computer.

Click the option to migrate only personality settings to one or more computers. Also select **Prepare destination computer with a disk image** to distribute a disk image to the new computer and select **Install software packages prior to applying the personality on the destination computer** to install software packages on the new computer.

**Note**: This option creates two jobs that appear in the **Jobs** pane: **Job (Capture)** and **Job (Distribute)**.

**Job (Capture)** includes a Capture Personality Settings task (See “Capturing personality settings” on page 203.) to capture the personality of the source computer and a Modify Configuration task to rename the source computer to avoid naming conflicts (see Modifying configuration). The source computer is named computerName (Old).

**Job (Distribute)** includes a Deploy Image task (see Distributing a disk image) if selected, a Modify Configuration task to update settings to the destination computer, and one or more Install Package tasks to update software (if selected) and migrate personality settings. See Distributing software.

**Migrate the same computer to another operating system**

Click this option to upgrade the operating system on a computer and reinstall personality settings and software packages on the same computer. It creates jobs and tasks to capture the personality settings, distribute a new disk image, distribute software packages, and migrate the personality settings.

Click the option to deploy a disk image and migrate the personality settings to the computer. (Optional) **Select Install software packages** prior to applying the personality on the destination computer to install software packages on the computer.
Note: This option creates two jobs that appear in the Jobs pane: **Job (Capture)** and **Job (Distribute)**.

**Job (Capture)** includes a Capture Personality Settings task (See “Capturing personality settings” on page 203.) to capture the personality of the source computer.

**Job (Distribute)** includes a Deploy Image task (See “Distributing a disk image” on page 182.) and one or more Install Package tasks to update software, if selected. See “Distributing software” on page 200.

**Simply capture the personality of the computers**

Click this option to capture and save, but not distribute, the personality settings of the selected computer(s). You can select a personality template and save Personality Packages to the Ghost Solution Suite Share, letting you distribute these personality settings later to new computers.

Note: This option creates a single job with a Capture Personality Settings task.

See “Capturing personality settings” on page 203.

See “New job wizard” on page 162.

**Selecting computers in the new job wizard**

The New Job Wizard provides steps to select and assign computers to the jobs created in the wizard, rather than requiring you to create a job and assign it to computers when building new jobs. The jobs created in the **New Job Wizard** appear in the Jobs pane, and can be saved and assigned to other computers at a later time. You can also schedule jobs for the specified computers in the wizard.

See “Building and scheduling jobs” on page 159.

**Applying computers to a job**

When deploying software in the **New Job Wizard**, you can select computers to assign the Distribute Software task created in the wizard. (See Distributing software.) You can also select an option to simply store the job and use it at another time without scheduling the job. Regardless of the scheduling option selected, the job appears in the Jobs pane to use at another time.

**New Computers.** Open an Adding New Computers dialog to create new user accounts to assign the job.
Associating destination computers

Use this dialog to associate source computers with destination computers when migrating personality settings. Depending on the computers selected in the previous Select Computers dialog, you can migrate personality settings captured from the source computers to new destination computers.

Right-click a computer in the Source column to replace it with another source computer. Right-click a computer in the Destination column to replace it with another destination computer and assign it to a new source computer. To automatically assign multiple computers, click Automatic to assign source computers with destination computers using an alpha-numeric order. The associated computers share personality settings after running the jobs.

See “Migrating computers” on page 164.

Setting up conditions in the new job wizard

The New Job Wizard also provides steps to set up conditions, a step usually performed independently for each job during its build phase. Setting conditions lets you run selected tasks only on computers matching defined criteria. See Setting conditions for task sets.

Click Setup conditions for this set of tasks to open the Define Conditions dialog from the New Job Wizard.

Installing software packages

The New Job Wizard provides steps to install software packages to the selected computers. You can install any type of software to the managed client computer, including .MSIs, .RIPs, and personality packages. If the selected package is not an .RIP or personality package, a message appears asking if you want to continue. See Distributing software for additional information.

Option summary

After selecting the options in the New Job Wizard, you can view a summary of the job names, assigned computers, conditions, and other selected choices. To change any options, click Back to return to the previous dialog. Click Finish to complete the steps in the wizard.

See “New job wizard” on page 162.
Building new jobs

A job can be a single task to distribute software or change computer property settings, or a series of tasks sequenced to migrate hard disk images, set post-installation TCP/IP and SID values, and install software packages and personality settings.

To create a new job, click this icon on the Ghost Solution Suite Console, or click File > New > Job, or right-click in the Jobs pane of the Ghost Solution Suite Console and select New Job. You can modify jobs by double-clicking the job or right-clicking, and selecting Properties. Add tasks to each job by clicking Add.

To build new jobs

1. Create a new job. Enter a unique name and description for the job. You can type a name up to 64 characters.

   A new job is added to the Jobs pane in the Ghost Solution Suite Console. You can group and organize jobs, and access and apply them to computers or computer groups from an index of prebuilt jobs.

2. (Optional) Set conditions to apply the job to specified computers meeting defined criteria. Order multiple conditions to run jobs on computers that match the first applicable condition. See Setting conditions for task sets.

3. Click Add to open a list of deployment tasks to add to each job.

4. Set task options using the provided wizards.

5. (Optional) Unselect the Replay during rip and replace option.

   This option is selected by default. This option replays the job during any rip and replace actions.

   After you complete the steps to create a task, it is added to the Task list. Click Add to add another task. Use the up and down arrows to change the order of execution of the tasks in the Task list.

   Tasks are executed in the order that they appear in the task list. Therefore, ensure you do not run a task that overrides the previous tasks. Example: List Distribute Disk Image above Distribute Software or Distribute Personality, letting the hard disk be imaged before installing applications and settings.

6. (Optional) Set Return Codes. The last action in each task wizard lets you set return codes for each deployment task. See See “Setting up return codes ” on page 223.

7. After adding tasks, click OK.

8. To schedule the job, drag it to a computer or computer group. The Schedule Jobs dialog appears.
See “Importing and exporting jobs” on page 223.

Job scheduling wizard

The Job Scheduling Wizard provides features to assign jobs to selected computers and computer groups, and to schedule the jobs to run without using a mouse. This new feature meets Section 508 requirements to improve disability access and enables integration of voice activation software and other user interface features.

Select a job

Select the jobs or groups of jobs to assign to computers or computer groups. Use the SHIFT and CTRL keys to select multiple jobs or job folders. Click Next.

Select a computer or computer groups

Select the computers or groups of computers to assign the jobs selected in the previous dialog. Use the SHIFT and CTRL keys to select multiple computers or groups. Click Next.

New Computers. Click when adding new computers.
See “Adding new computers” on page 99.

Setting conditions for task sets

Setting conditions on a job lets you run selected tasks only on computers that match defined criteria. As a result, you can create a single job with tasks defined for computers with varying properties, including operating system types, network adapters, processors, free drive space, and other computer properties. You can create task sets for each job that apply only to the computers matching those conditions.

Note: The default condition (named default) has no parameters or values associated with it. If this is the only condition that a job contains, the tasks associated with the default condition will always work on all computers to which the job is assigned. A default condition is like having no conditions.

In addition, if a task is associated with the default condition, the task always runs when a computer does not meet any other conditions associated with this job.
To set conditions for task sets


2. Click Setup next to the Condition field. A menu appears with options to create a new condition, or to modify, delete, or reorder a condition.

3. To reorder conditions, click Order and reorder them using up or down.

4. To create a new condition, click New in the menu. The Condition Settings dialog appears. Enter a name up to 64 characters.

5. Click Add to open the Condition dialog. Specify the following conditions and click OK:

   - From the Field drop-down list, select a data field heading. You can define conditions based on common client features such as operating system, software and hardware version, hard drive space, operating system language, RAM, and other characteristics.
     To set up custom conditions based on custom tokens, select User Defined Tokens from the Field drop-down list.

   - From the Operation drop-down list, select a compare statement.

   - In the Value box, type a string to search for in the selected database field. You can set conditions based on computer properties stored in fields in the Ghost Solution Suite Database. Example: You can set a condition to match a particular asset tag, Ghost Solution Suite agent version, or IP address. You can use wildcard characters and AND/OR operators.

   - To set up custom conditions based on custom tokens, select User Defined Tokens from the Field list.

The task set you create appears in the Task list for each condition. When you select a new condition, the tasks for that condition appear.

---

**Note:** When using User Defined Tokens to set conditions for some client property values, you may be required to use the decimal value instead of the hex value. Example: When setting conditions based on the NICS table on the nic_device_id and nic_vendor_id columns, you must use decimal values.

---

See “Deployment tasks” on page 170.
Deployment tasks

A task is an action of a job. Jobs are built with tasks. Each task runs according to its order in the task list contained in a job. You can resize the task pane by dragging the bottom pane (horizontal bar) that separates the task list and the scheduled computer list of the Ghost Solution Suite Console. This lets you view a greater number of tasks in a deployment job without using the scroll bar to navigate up and down.

Task names in a mixed-language environment

Ghost Solution Suite Server does not handle the code pages in a mixed-language environment well. If a Windows 32-bit Ghost Solution Suite Server Console is installed on a native single-byte OS (for example, English, Italian, and French) and viewed on a double-byte language, the task names show as a series of question marks.

When you view the task names on a native double-byte OS, they display correctly.

Common Tasks

The Add menu of the Ghost Solution Suite Console includes the following tasks:

<table>
<thead>
<tr>
<th>Table 5-1</th>
<th>Common tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Create Disk Image</strong></td>
<td>Create a disk image from a reference computer and save the image file (.IMG or .GHO files) for later distribution. See “Creating a disk image” on page 174.</td>
</tr>
<tr>
<td><strong>Distribute Disk Image</strong></td>
<td>Distribute previously created disk images (.IMG or .EXE files) or create a disk image from a reference computer on the network and simultaneously distribute it (.IMG or .GHO) to other managed computers on the network. See “Distributing a disk image” on page 182.</td>
</tr>
<tr>
<td><strong>Scripted OS Install</strong></td>
<td>Run scripted (unattended) installs using answer files to install computers remotely over the network. See “Scripted OS install” on page 189.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Distribute Software</td>
<td>Distribute .RIPs, .MSI files, scripts, personality settings, and other package files to computers or groups.</td>
</tr>
<tr>
<td></td>
<td>See “Distributing software” on page 200.</td>
</tr>
<tr>
<td>Capture Personality</td>
<td>Capture the personality settings of a selected computer on the network using the PC Transplant software. PC Transplant ships as a part of Ghost Solution Suite Server.</td>
</tr>
<tr>
<td></td>
<td>See “Capturing personality settings” on page 203.</td>
</tr>
<tr>
<td>Distribute Personality</td>
<td>Send a Personality Package to computer or groups. This task identifies valid Ghost Solution Suite packages and assign passwords and command-line options to Personality Packages.</td>
</tr>
<tr>
<td></td>
<td>See “Distributing personality settings” on page 205.</td>
</tr>
<tr>
<td>Modify Configuration</td>
<td>Modify the IP address, computer and user name, domains and Active Directory organizational units, and other network information and computer properties.</td>
</tr>
<tr>
<td></td>
<td>See “Modifying configuration” on page 208.</td>
</tr>
<tr>
<td>Back up Registry</td>
<td>Copy the registry files of selected computers and save the registry file settings to a selected directory.</td>
</tr>
<tr>
<td></td>
<td>See “Backing up and restoring registry files” on page 208.</td>
</tr>
<tr>
<td>Restore Registry</td>
<td>Copy the registry file settings to a managed computer.</td>
</tr>
<tr>
<td>Get Inventory</td>
<td>This lets you gather inventory information from client computers to ensure that the Ghost Solution Suite Database is updated with the latest computer properties.</td>
</tr>
</tbody>
</table>
Table 5-1 Common tasks (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Script</td>
<td>Create custom commands using scripts to perform jobs outside the bounds of the preconfigured tasks. Use the Run Script dialog to select or define a script file to run on specified computers or groups.</td>
</tr>
<tr>
<td>Copy File to</td>
<td>Copy a file from the Ghost Solution Suite Share or another source computer to a destination computer.</td>
</tr>
<tr>
<td>Power Control</td>
<td>Perform power control options to restart, shutdown, power off, and log off.</td>
</tr>
<tr>
<td>Wait</td>
<td>Use the Wait dialog to retain a computer in automation mode after a task is performed.</td>
</tr>
</tbody>
</table>

Supported Live Task Types

The following is the list of the live tasks supported for the x64, IA64, and SPARC platforms.

<table>
<thead>
<tr>
<th>Task</th>
<th>x64</th>
<th>IA64</th>
<th>SPARC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Computer</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>History</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Configure</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Quick Disk Image</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Wake Up</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Restart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Shutdown</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Control: Log off</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Feature</td>
<td>Yes</td>
<td>No</td>
<td>Unknown</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----</td>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>Remote Control</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Execute</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Copy File</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Chat</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Advanced: Clear Computer Status</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Prompt User for Properties</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Advanced: Reset Connection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Install Automation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Get Inventory</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Reject Connection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Uninstall Windows Agent</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Advanced: Install BIS Certificate</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Remove BIS Certificate</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced: Apply Regular License</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>New Job Wizard</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>New Group</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>New Computer</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Rename</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Creating a disk image

This task creates an image of a computer's hard disk. You can save the disk image as an .IMG, .EXE, .WIM, .DMG, or .GHO file.

Create an image file by using the **New Job Wizard** or adding the task when building new jobs. You can distribute the disk image file using the **Distribute a Disk Image** task. This task will run Symantec RDeploy.exe from the console to capture and migrate hard disk images.

See “New job wizard” on page 162., See “Building new jobs ” on page 167., and Distributing a disk image.

To create an image of a computer, you must boot to Linux, or WinPE. This requires that you set up a PXE Server or install an automation partition.

**To create a disk image**

1. In the **Jobs** pane in the Ghost Solution Suite Console, select a job.
2. In the **Details** pane, click **Add** and select **Create Disk Image**.
3 In the Create Disk Image dialog, select an imaging tool from the drop-down list. You can select RapiDeploy (Text mode), RapiDeploy (Graphics mode), RapiDeploy (Linux mode), ImageX, Mac Image or Ghost.

RDeployT is the default imaging executable. This facilitates the imaging of thin client computers. The following are the RapiDeploy options for imaging:

**Graphical Mode (RDeploy)** — Select this option to run the RDeploy in a GUI mode.

**Text Mode (RDeployT)** — Select this option to run the RDeploy in a text mode.

**Linux (RDeploy)** — Select this option to run the RDeploy in Linux mode.

You can select the ImageX or Mac Image option for imaging. If you select ImageX, the image is created as a .WIM file. If you select Mac Image, the image is created as a .DMG file. For information on creating a Mac Image, See “Creating a Mac image” on page 177. You can also select the Ghost option for imaging. If you select Ghost, the image is created as a .GHO file. For information on creating a Ghost Image, See “Creating a Ghost image” on page 178.

---

**Note:** Linux (RDeploy) and Ghost options are available only when the ImageTools.ini file is stored in the eXpress folder.

4 Enter additional parameters in the **Additional Parameters** field.

You can add command-line options specifically for the RapiDeploy program to run imaging tasks. See Command-line Switches in the Deployment and Migration Guide.

5 Enter a path and file name to store the disk image file. You can store image files to access later when a managed computer is assigned a job that includes the image file.

The default file name extension is .IMG. Saving image files with an .EXE extension converts them into self-extracting executable files (the run-time version of RapiDeploy is added in the file). You can also save ImageX files with a .WIM extension, a Mac image with a .DMG extension, and a Ghost image with a .GHO extension.
6 Select **Disable image path validation** if you want to store the image file outside of the Ghost Solution Suite Share file structure. If you do not select this option and do not specify a Ghost Solution Suite Share path, a warning message appears, reminding you to configure your automation process to use the path indicated in the Name field. You can still save your image to a location outside of the Ghost Solution Suite Share file structure even when you do not select this option. This option only eliminates the warning message. You can use this option to store images locally on the managed computer’s hard drive or to an additional server used to store images.

If you typed a UNC path in the Name field and the server does not have access to the path, check to disable image path validation. Otherwise, the process fails.

When storing images locally on the managed computer's hard drive, ensure that you enter the path relative to the managed computer (Example: C:\myimage.img). When you store an image locally on a managed computer instead of a file server, you save server disk space and reduce network traffic.

**Prerequisite:** To store images locally on the managed computer's hard drive, you must have a hidden automation partition installed on the managed computer’s hard disk with the required disk space to hold the images you want to store.

---

**Note:** When imaging computers where images are stored on the managed computer’s hidden automation partition, use the option to remove the automation partition only when you want to clear all images from the computer.

7 Select **Prepare using Sysprep** to use Sysprep to prepare the system for imaging.

8 From the **Operating System** drop-down list, select the operating system or Add new to open the OS Product Key dialog and select the OS Information.

9 Click **Advanced Settings**. This opens the **Sysprep advanced settings** dialog. See Advanced Sysprep settings for creating a disk image.

10 *(Optional)* Select the **Do not boot to Production** option to create an image of the hard disk while booted to Automation without first booting to Windows to save network settings (TCP/IP settings, SID, computer name, and so on). If you select this option, these network settings are not reapplied to the computer after the imaging task, resulting in network conflicts when the computer starts.
11 From the Automation pre-boot environment (WinPE/Linux) drop-down list, select the required pre-boot environment to perform the Create Disk Image task in the selected pre-boot environment. By default, the Default Automation (Auto-select) type is selected.

**Note:** ImageX requires a WinPE x86 pre-boot environment.

12 (Optional) To select Media Spanning and additional options, click Advanced. See “Create disk image advanced” on page 180.

13 Click OK (if you are using the New Job Wizard) or click Next.

14 (Optional) Set Return Codes. See “Setting up return codes” on page 223.

15 Click Finish. The task appears in the Task list for the job. The disk image is created when you run this task.

**Note:** If an imaging job fails on a managed computer, the Ghost Solution Suite Configuration page appears on the client computer. This page displays a prompt to confirm whether the user wants to configure the client computer or restore the original settings. On the client computer's screen, select Cancel > Restore Original Settings.

See “Deployment tasks” on page 170.

### Creating a Mac image

You can create a Mac Image using the Create Disk Image task.

**To create a Mac image**

1 In the Create Disk Image dialog, select Mac Image (*.dmg) from the Imaging Tool drop-down list.

2 (Optional) Provide the disk number in the Additional Parameters field using the following format:

   `-d[disk#]`

   By default, all partitions of disk 1 are imaged. To image a different disk, provide the disk number in the Additional Parameters field using the same format.

3 Choose from one of the following options to add the path and file name for the disk image:

   - Specify the share using the following format:
     ```
     afp://server/sharepoint/path/filename.dmg
     ```
Provide credentials using the following format:
afp://username:password@server/sharepoint/path/filename.dmg

If no credentials for this server are provided in the automation configuration, the guest account is used by default.

**Note:** These credentials are passed unencrypted and can be read by a network sniffer. The captured disk image must be stored on an AppleTalk Filing Protocol (AFP) share.

4 Select **Disable image path validation**.

The image file is stored outside of the Ghost Solution Suite Share file structure. If you do not select this option, a warning message appears, reminding you to configure your automation process to use the path indicated in the Name field. You can still save your image to a location outside of the Ghost Solution Suite Share file structure even when you do not select this option. This option eliminates the warning message.

5 (Optional) Select the **Do not boot to Production** option if you do not want the computer to boot to Production before creating the image.

6 From the Automation pre-boot environment (WinPE/Linux) drop-down list, select the required pre-boot environment to perform the **Create Disk Image** task in the selected pre-boot environment. By default, the Default Automation (Auto-select) type is selected.

7 Click **Next**. The **Return Codes** dialog appears.

8 (Optional) Set Return Codes.

See “Setting up return codes” on page 223.

9 Click **Finish**. The task appears in the Task list for the job. The Mac image is created when you run this task.

**Note:** The **Sysprep settings** option is disabled if you select **Mac Image** as the Imaging Tool. The **Automation pre-boot Environment** for Mac Image is the **Default Automation** when capturing Mac images.

Creating a Ghost image

Symantec Ghost Solution Suite provides operating system migration, software distribution, computer personality migration, hardware and software inventory, and secure system retirement.
You can create a Ghost Image using the **Create Disk Image** task.

**Note:** To use the Ghost Solution Suite for creating a disk image, you have to store the ghost.exe and ImageTools.ini files in the Program Files\Altiris\eXpress\Ghost Solution Suite Server directory.

To create a Ghost image

1. In the Create Disk Image dialog, select **Ghost Image (.gho)** from the Imaging Tool drop-down list.
2. Add additional parameters in the **Additional Parameters** field.
3. Enter the path and file name to store the disk image.
4. (Optional) To disable the validation of the image path, select the **Disable image path validation** check box. This is useful if the image is stored locally, or if you are retrieving the image from a remote server.
5. To use Microsoft Sysprep, select the **Prepare using Sysprep** check box and specify the operating system and product key.
6. From the **Automation pre-boot environment (WinPE/Linux)** drop-down list, select the required pre-boot environment to create the disk in the selected pre-boot environment.

   By default, the **Default Automation (Auto-select)** type is selected.
7. Click **Next**.

   The **Return Codes** dialog appears.
8. (Optional) Set Return Codes. See **Setting up return codes**.
9. Click **Finish**.

   The task appears in the Task list for the job. The Ghost image is created when you run this task.

**Advanced Sysprep settings for creating a disk image**

You can use the Sysprep Advanced Settings dialog to specify Sysprep mass storage device support. By default, the Enable mass storage device support using built-in drivers (For Windows XP and 2003 only) option is selected.

**Disable mass storage device support.** When this option is selected, the Sysprep.inf file contains the section [Sysprep] with the key value pair as BuildMassStorageSection = No
Enable mass storage device support using built-in drivers. When this option is selected, the Sysprep.inf file contains the section [Sysprep] with the key value pair as BuildMassStorageSection = Yes

Enable mass storage device support using following: When this option is selected, the Sysprep.inf file contains the section [SysprepMassStorage] and is appended by contents of the file mentioned in the Mass storage section file field. You can also copy the drivers directory mentioned in the Mass storage drivers field.

Command-line switches. You can add command-line options.

Advanced Sysprep settings for creating a disk image for Windows Vista and later versions

You can use the Sysprep advanced settings dialog to specify the settings for any Windows Vista or later Windows operating system version.

If you select the Operating System as Windows Vista or later, in the Sysprep settings on the Create Disk Image dialog. The Advanced Settings... option is enabled.

Click the Advanced Settings... option. The Sysprep advanced settings dialog appears. This dialog lets you select Plug-n-Play (PnP) drivers options, as well as Sysprep options, such as command-line options.

Create disk image advanced

Media Spanning

Table 5-2

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum file size</td>
<td>The maximum file size supported is 2 GB. To save an image larger than 2 GB, the Ghost Solution Suite Server automatically breaks it into separate files regardless of your storage capacity. From the Maximum file size drop-down list, select a media type.</td>
</tr>
<tr>
<td>Specify ___ MB</td>
<td>If the preferred type is not on the list, select Other (specify) and enter the required file size in the Specify ___ MB field.</td>
</tr>
</tbody>
</table>
Additional Options

Table 5-3

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression</td>
<td>Compressing an image is a trade-off between size and speed. Uncompressed images are faster to create, but use more disk space.</td>
</tr>
<tr>
<td>Optimize for Size</td>
<td>Select this option <strong>Optimize for Size</strong> to compress the image to the smallest file size. Select Optimize for Speed to create a larger compressed image file with a faster imaging time. The default setting is <strong>Optimize for Speed</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Configuration restoration after imaging a compressed drive is not supported for this release.

(Optional) Enter an image description to help identify the image and click **OK**.

Ghost Solution Suite Hot Imaging

The Ghost Solution Suite Hot Imaging lets you automatically refresh images from a live reference computer before deploying the image. This feature ensures that the deployed image is latest and reduces the risk of stale, out-of-date images.

Hot imaging does not require to boot a computer to boot into the preboot environment before creating an image. Hot imaging uses the Snapshot technology for Windows desktop operating systems and is used to capture an image while Windows is running.

**Note:** Hot imaging is not support Windows Server class operating systems.

Tips for Hot imaging:

- The Volume Shadow Copy service should not be in "disabled" state. If you are using any database software on the computer you want to take a hot image of, that database software must be stopped to prevent damage to the database file. If the database application is VSS Aware, the Volume Shadow Copy service shuts down the database for you. If the database application is not VSS aware, you must stop the database service before capturing an image.

- Firewalls can block necessary communications.
See “System requirements for installing Ghost Solution Suite” on page 33.

To use Hot imaging

1. In the Ghost Solution Suite console, navigate to Jobs > Hot Imaging.
2. Use the appropriate sample jobs for creating an image:
   ■ Create X64 Image
   ■ Create X86 Image

Troubleshooting error 1959

While using Hot imaging, you may receive an error as follows:

■ Volume could not be locked
■ Cloning via Volume Snapshot has failed

Following is the workaround for the same:

If you are using ghost32.exe on the client computer:

1. Go to Start > Run.
2. Type cmd and click OK.
3. Navigate to C:\Program Files (x86)\Altiris\eXpress\Deployment Server.
4. Type ghost32.exe -forcevolumesnapshot and click Enter.
5. Configure Ghost Solution Suite to meet your needs.

If you are executing a Create Image task:

1. Find the failed task in your task list.
2. Right-click on the task and go to Properties.
3. Click Advanced.
4. Type -forcevolumesnapshot in the Additional option for the Ghost command line and click OK.
5. Click Save > Execute.

Distributing a disk image

Distribute a RDeploy, ImageX, Mac, or Ghost image file to managed computers to deploy a previously created hard disk image. Ghost Solution Suite supports hardware independent imaging through DeployAnywhere. DeployAnywhere requires Windows PE on 32-bit automation only.
DeployAnywhere creates a hardware abstraction layer (HAL) and updates network drivers and storage drivers. It performs post-imaging functionality while you are still in automation mode.

You can use the following switches with DeployAnywhere:

- `/logPth` that specifies the fully qualified path where the DA log files are written.
- `/logID` that specifies the ID to prepend to the log file name.

For more information about DeployAnywhere or Ghost, see the Symantec Ghost Imaging Foundation documentation.

Distribute a hard disk image using the New Job Wizard or adding the Distribute Disk Image task when building new jobs. You can create the disk image file using the Create a Disk Image task.

See “New job wizard” on page 162.
See “Building new jobs ” on page 167.
See “Creating a disk image ” on page 174.

---

**Note:** If you deploy a Windows image over a Linux computer or a Linux image over a Windows computer, you must change the path of the Ghost Solution Suite Agent for the Windows log file.

---

**To distribute a disk image**

1. Open the **New Job Wizard** and select Deploy and configure computers and click **Next**. The **Job conditions** page appears. Click **Next**.

   or

   In the Jobs pane in the Ghost Solution Suite Console, select a job. In the Details pane, click **Add** and select **Distribute Disk Image**.

2. In the **Disk Image Source** page, click **Select a disk image file** to select a stored image file. This lets you set down a new image file from a previously imaged computer. Enter the name of an existing image file.

   - If you do not want the Ghost Solution Suite Server to validate the selected path, select **Disable image path validation**. This is useful if the image is stored locally, or if you are retrieving the image from a remote server.

3. Click **Select a computer on the network** to image a source computer on the network. Enter the name and location of the source computer to both create an image and distribute the newly created image file.
This option saves an image of a selected computer's hard disk in its current state each time the job runs. You can schedule the job to image a specified computer every time it runs, which updates the image each time.

- Select the **Save the disk image as a file while distributing** option to save the newly created image file. If you use a reference computer as the image source, you can also choose to save the image as a file for later use. Enter or browse to the location where you want to store the file.

4. Select **Prepared using Sysprep** to use Sysprep to prepare the system for imaging.

5. Click **Add New** to open the OS Product Key dialog and select the OS Information.

6. From the Product Key drop-down list, select the product key.

7. Click **Advanced Settings** to open the **Sysprep Advanced Settings** dialog. See [Advanced Sysprep settings for distributing a disk image](#).

8. In the Data transfer mode, select if the image should be distributed using either of the following:
   - **GhostCast Server**
     - Enter the **Session Name** that should be used.
   - **Multicast using Ghost**

9. Enter the required Additional Parameters.

10. Select Automatically perform configuration task after completing this imaging task to restart the computer and push the configuration settings to the imaged computer.

---

**Note:** If you clear this option, a warning appears, confirming that you want to remove the configuration step after the image is deployed. As a result, the imaged computer may not reconnect to the network.

---

11. (Optional) Select the **DeployAnywhere** option if you want to do hardware independent imaging.

12. (Optional) Select the **Boot to production** to complete configuration task.

13. From the Automation pre-boot environment (WinPE/ Linux) drop-down list, select the required pre-boot environment to perform the Distribute Disk Image task. By default, the Default Automation (Auto-select) type is selected.

14. (Optional) Click Advanced to resize partitions and set additional options. See [Distribute disk image-resizing](#). Click **OK**.
Distributing a Mac image

You can deploy a Mac image using the Distribute Disk Image task.

This task deploys only .DMG files that were created using a Create Disk Image task. The Distribute Disk Image task cannot deploy an image that was created by Apple Disk Utility or the hdiutil tool.

To deploy a Mac image

1. Select the Select a disk image file option.
2. In the Name field, choose from one of the following options to add the path to the Mac (.DMG) image:
   - Specify the share using the following format:
     afp://server/sharepoint/path/filename.dmg
   - Provide credentials using the following format:
     afp://username:password@server/sharepoint/path/filename.dmg

   If no credentials for this server are provided in the automation configuration, the guest account is used by default.

   **Note:** These credentials are passed unencrypted and can be read by a network sniffer. The captured disk image must be stored on an AppleTalk Filing Protocol (AFP) share.

3. Select **Automatically perform configuration task after completing this imaging task** to run the configuration task after the imaging task is complete.
4. Click Next. The Return Codes dialog appears.
5. (Optional) Set Return Codes.
   See “Setting up return codes” on page 223.
6. Click Finish. The task appears in the Task list for the job. The Mac image is deployed when you run this task.
Distributing a Ghost image

You can distribute a Ghost (.GHO) image using the Distribute Disk Image task.

To distribute a Ghost image

1. On the Distribute Disk Image dialog, select the Select a disk image file option.
2. Browse and select a .GHO image.
   If you do not want the Ghost Solution Suite Server to validate a selected path, select Disable image path validation. This is useful if the image is stored locally, or if you are retrieving the image from a remote server.
3. To use Sysprep to distribute the image, select Prepared using Sysprep.
4. From the Operating System drop-down list, select the operating system.

   **Note:** Click Add New. From the Sysprep Settings dialog, select the operating system information.

5. From the Product Key drop-down list, select the product key.
6. Add any additional parameters in the Additional Parameters field.
7. To restart the computer and push the configuration settings to the imaged computer, select Automatically perform configuration tasks after completing this imaging task.
8. From the Automation pre-boot environment drop-down list, select the required pre-boot environment to perform the Distribute Disk Image task.
   By default, the Default Automation (Auto-select) type is selected.
9. Click Next.
10. (Optional) Set Return Codes. See Setting up return codes.
11. Click Finish.

The task appears in the Task list for the job. The Ghost image is deployed when you run this task.
Advanced Sysprep settings for distributing a disk image

You can generate the Sysprep.inf file for the Distribute Disk Image task, depending on the option selected in the Advanced Sysprep Settings dialog.

**Use default answer file.** When this option is selected, the Ghost Solution Suite Server generates the Sysprep.inf file depending on the data present in the database.

**Use the following answer file.** When this option is selected, the Ghost Solution Suite Server picks up the contents of the file mentioned in the Sysprep answer file field and prepares the Sysprep.inf file from it.

Advanced Sysprep settings for distributing a disk image in Windows Vista

You can use the Sysprep advanced settings dialog to specify the settings for any Windows Vista operating system. If you select Windows Vista as the operating system under Sysprep settings on the Distribute Disk Image dialog and click Advanced Settings, the Sysprep advanced settings dialog for Windows Vista appears. This dialog lets you select Sysprep answer file options.

Distribute disk image-resizing

By default, whenever you deploy an image, you have the option to resize the partition to take advantage of the available disk space. Drive Size gives you information about the size of the image, so you can determine if you need to change partition sizes. Minimum indicates the amount of space the image will use on the target computers. Original indicates the image source disk size.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Size</td>
<td>Select this option and enter the desired partition size.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Select this option and enter the percentage of free space you want the partition to occupy.</td>
</tr>
<tr>
<td>Min</td>
<td>View the minimum size of the partition.</td>
</tr>
<tr>
<td>Max</td>
<td>View the maximum size of the partition.</td>
</tr>
</tbody>
</table>

**Note:** FAT16 file systems have a 2 GB limit and cannot be resized larger than that (although they can be resized smaller than the minimum value). HP partitions remain a fixed size.
Distribute disk image-additional options

This option lets you specify operations for existing Automation Agents and OEM disk partitions. The options are as follows: leave the partition as it is, remove, or replace the existing partitions. If the image file does not contain any information for an automation or OEM partition, the default option is to leave the client's existing Automation or OEM partition as it is.

RDeploy options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical Mode[RDeploy]</td>
<td>Click this option to choose RDeploy as the imaging executable.</td>
</tr>
<tr>
<td>Text Mode[RDeployT]</td>
<td>Click this option to choose RDeployT as the imaging executable. Text Mode or RDeployT is the default choice.</td>
</tr>
</tbody>
</table>

Automation partition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave the client's existing Automation partition as it is</td>
<td>If the image file contains no automation partition information, by default, this option is selected. The automation partition remains unchanged when distributing disk images.</td>
</tr>
<tr>
<td>Delete the client's Automation partition [-nobw]</td>
<td>Select this option to delete the existing Automation partition from client computers.</td>
</tr>
<tr>
<td>Replace the client's existing BW partition from image file [-forcebw]</td>
<td>Select this option to replace the existing automation partition on the client computer with the automation partition from the image file</td>
</tr>
</tbody>
</table>

OEM partition:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave the client's existing OEM partition as it is</td>
<td>If the image file contains no OEM partition information, by default, this option is selected. The OEM partition remains unchanged when distributing disk images.</td>
</tr>
</tbody>
</table>
Table 5-7  (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete the client's OEM partition [-nooem]</td>
<td>Select this option to delete the existing OEM partition from client computers.</td>
</tr>
<tr>
<td>Replace the client's existing OEM partition from image file [-forceoem]</td>
<td>Select this option to replace the existing OEM partitions on the client computer with the OEM partition from the image file.</td>
</tr>
<tr>
<td>Additional Command line switches</td>
<td>You can add command-line options specifically for the RapiDeploy program that runs imaging tasks.</td>
</tr>
</tbody>
</table>

Note: The checkdisk command-line option should not be used from a Ghost Solution Suite Console. The post-configuration task fails after an image restore.

**Deployment tasks**

**Scripted OS install**

The **Scripted OS Install** task performs remote, automated, and unattended operating system installations over the network using answer files to input configuration and installation-specific values. Scripted installs let you deploy server and client computers across the network from installation files and perform post-installation configuration tasks. You can run scripted installs for Windows or Linux computers.

Note: Scripted Install requires either an automation boot disk or a PXE Server. Using embedded automation causes the selected image (Linux, WinPE) to load and halt. It does not let the scripted install run.

When running a **Scripted OS Install** task, you can identify the type of operating system to install for supported languages, run the scripted install, and update with service pack installations. This task provides easy-to-use features to create an answer file for each scripted installation.

Scripted installs are flexible in performing post-configuring tasks, but much slower and bandwidth-intensive. Complete network and Web server installation and configuration tasks benefit most from scripted installs.
Use complete unattended install features to copy Windows operating system source files quickly to the Ghost Solution Suite Share and easily create an answer file. Configured operating system install sets can be reused to build and run scripted install jobs as needed.


Run scripted install jobs to remotely install different versions of Linux. You can customize sample scripted install jobs installed with the Ghost Solution Suite Server system and create a kickstart answer file to remotely run a scripted install.

See “Scripted install for Linux” on page 199.

**Scripted install for Windows XP, Windows Server 2003 and earlier**

**To install Windows**

1. After selecting **Add > Scripted OS Install**, select the **Windows** option and click **Next**.

2. Select the type of Windows operating system to install and the preferred language. See Select OS version and language. Select the required pre-boot environment from the **Automation - PXE or BootWorks environments (WinPE/Linux) Automation pre-boot environment (WinPE/Linux)** drop-down list to perform the **Distribute Disk Image** task in the selected pre-boot environment. The option reported by the PXE Manager is the default pre-boot environment option. By default, the Default Automation (Auto-select) type is selected. Click **Next**.
3. From the **Select or add new OS source files** drop-down list, select the operating system source files already copied to your Ghost Solution Suite Share.

See “Installation source files” on page 193.

Click **Add New** from the list to set up the new operating system installation files.

See “Operating system-source files” on page 193.

Click **OK** after entering a unique name and the path to the operating system installation source files. The source files will be copied to the Deploy folder in the Ghost Solution Suite Share directory. The first source files added are given a generic name of WinOS001, with additional operating system source folders named as WinOS002, WinOS003 and so on. Service Pack source files are also stored as WinSP00x.img files.

This process could take a few minutes. Because the installation source files are copied over to the Ghost Solution Suite Share, when running subsequent scripted installs you do not need to add new source files for this version of Windows. They can be selected from the list of installation source files.

See “Installation source files” on page 193.

---

**Note:** When importing Scripted Install jobs, you must edit the job files to point to the installation source files on the new Ghost Solution Suite Server system. This requires you to run the Scripted Install for Windows wizard and modify the path and name of the folder for the Installation Source Files for the exported jobs. This is required for both the main installation and the service pack installation file.

---

Scripted install for Windows XP, Windows Server 2003 and earlier

See “Installation source files” on page 193.

See “Importing and exporting jobs” on page 223.

4. After the source files are copied, select the newly created operating system source name from the **Installation Source Files** list. Click **Next**.

5. In the **Partition and Format Disk** page, click **Advanced** to set partition size, delete hidden partitions or set RapiDeploy command-line parameters. Click **Next**.

See “Operating system-source files” on page 193.

6. Import an answer file to the Ghost Solution Suite Database. Click **Next**.

See “Import an answer file” on page 194.
Select OS version and language

Identify the operating system version to run in a scripted install. The selected version and language must correspond to your Windows installation files.

We support multiple languages for the following Ghost Solution Suite utilities:

- Boot Disk Creator
- Image Explorer
- PXE Configuration Utility
- Remote Client Installer
- Control Panel Applet
- DS Info
- PW Util (Password utility)
- Switch Management

Select the operating system version

Select the Windows operating system you want to install from the list. Click Template if you want to install another version or language of a Windows operating system not provided in the list.
Select the operating system language

Select the language version of the operating system to install. The language must correspond to the operating system source files. If you selected the Template option, only the Multilingual language option can be selected (this is a generic language option).

Automation (Pre-boot Environment)

Select the required pre-boot environment from the Automation (Pre-boot Environment) drop-down list. The option reported by the PXE Manager is the default pre-boot environment option.

Installation source files

If you copied installation files to the Ghost Solution Suite Share for previous scripted installs, the name of this install source configuration appears in the list box for each operating system type and language. To create new source configuration sets for additional operating system installs, select Add new from the drop-down list.

Select or add new operating system source files

Select the assigned name for each operating system source configuration in the list, or select Add new from the list to create a new install task. Previous scripted install jobs will create a WinOS00x.img file in the Deploy directory of the Ghost Solution Suite Share.

Operating System-Source Files

The Operating System-Source Files dialog lets you identify the version of Windows install files and enter the path to the files (on the CD or other medium).

Select or add new service pack source files

Run service pack updates immediately after installing the operating system during the scripted install process. Previous scripted install jobs will create a WinSP00x.img file.

Operating system-source files

Name the operating system source configuration, specify the path, and automatically copy Windows installation files to the Ghost Solution Suite Share.
Enter a unique name for the operating system source files

Enter a name for the operating system source configuration files to assign an alias to associate with the install files for a specific operating system version and language.

Enter path to operating system source files

Enter the path to the I386 folder on the CD where the Windows installation programs and support files are stored. Example: Browse to the CD drive and select I386\WINNT.exe. Click Open.

The Windows operating system identified previously in the Installation Source Files dialog must match the source files selected here. If the name and language of the operating system does not match the installation files, you receive an error.

Click OK and the files will copy from the source CD (or other volume) to the Ghost Solution Suite Server\Deploy directory in the Ghost Solution Suite Share. This process will take a few minutes.

Enter a short description. (Optional) Enter a description of the Windows operating system source configuration. Example: W2K Advanced Server SP3 English.


Import an answer file

Reference a previously created answer file for a Windows scripted install. You can also view a summary of the operating system source configuration.

Import existing unattend.txt

Select to import a previously created answer file to the Ghost Solution Suite Database. The values for the answer file are imported from the delimited text file and appear in the Answer File Setup dialog.

Path of the unattend.txt

Enter a path and select an answer file with any name. The answer file is imported to the database, edited in the console (if required), and distributed as an unattend.txt file to the client computer.

See Scripted install for Windows XP, Windows Server 2003 and earlier
Answer file setup

Use the tabs in this dialog to enter values to create an answer file for a scripted install. These values are stored in the Ghost Solution Suite Database. An answer file is generated from the database (unattend.txt) and distributed to each managed computer when the job runs.

In the **Answer File Setup** dialog, select a value (a row) in the table. A list appears in the **Values** column to change values for each entry. You can add new variables to each section by selecting the bottom row named **Add new Variable**. To add a new section to the answer file, click the right arrow until the **Add new Section** tab appears (the last tab on the right).

The required answer file values are selected automatically in the dialog with a gray check mark (you cannot clear these variables). Optional but selected values have a green check mark. Other optional values are cleared. Select these optional values if you want to add them to the answer file when it is generated.

The various tabs in the **Answer File Setup** dialog correspond to the general answer file sections. See the Microsoft Windows Unattended Setup Guide for specific values for an unattended setup file.


Add a new section

Use this dialog to add new variable sections to the answer file.

**Use this dialog to add new variable sections to the answer file**

If you add a section, this name appears in the new tab in the Answer File setup dialog. Enter a description. Enter comments to describe the new section.

**Enter a description**

Enter comments to describe the new section.

See the Microsoft Windows Unattended Setup Guide for your specific operating system values for an unattended setup file.


Delete a section

To delete a new section that you added, right-click the section and select **Delete selected Section**.
Add a new variable

Use the **New Variable for Section "Unattended"** dialog to add new variables to the answer file. This variable appears as a row in the **Answer File Setup** dialog.

**Table 5-8  Add a new variable**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the variable</td>
<td>Select a variable name</td>
</tr>
<tr>
<td>Type of the new variable</td>
<td>Select a variable data type. The <strong>Default value of the variable</strong> and <strong>Displayed value of the variable</strong> fields are enabled depending on the variable type selected.</td>
</tr>
<tr>
<td>Default value of the variable</td>
<td>Enter values for a list, text, password, IP address, or variable only types.</td>
</tr>
<tr>
<td>Displayed value of the variable</td>
<td>Enter an alias for list item types to appear instead of the real variable value.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter comments to describe the new variable. It appears in the <strong>Description</strong> column of the <strong>Answer File Setup</strong> dialog.</td>
</tr>
</tbody>
</table>


Command-line switches for scripted install

Use the **Scripted OS install commands** dialog to enter Windows commands that are executed from the cmdlines.txt file. You can also add scripted install command-line options.

**Table 5-9  Command-line switches for scripted install**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switches</td>
<td>Add or edit switch commands to this line for the install program for the scripted install.</td>
</tr>
</tbody>
</table>
Table 5-9 Command-line switches for scripted install (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional commands in the cmdlines.txt file</td>
<td>Enter additional Windows scripted install commands in this dialog. The commands execute in the order they are listed. The provided command installs the Ghost Solution Suite for Windows during the Install Component phase of the installation. You can view and edit Ghost Solution Suite settings in the next dialog. Enter additional Windows scripted install commands in this dialog. The commands execute in the order they are listed. The provided command installs the Ghost Solution Suite for Windows during the Install Component phase of the installation. You can view and edit Ghost Solution Suite settings in the next dialog.</td>
</tr>
</tbody>
</table>


Ghost Solution Suite agent settings for scripted install

View or edit Ghost Solution Suite for Windows settings in this dialog. You can change agent settings using this text-edit dialog.

for a list of the Ghost Solution Suite properties.


Scripted install summary

View a summary of the selected options for the scripted install. Click Back to change any of these settings or click Finish to complete the Scripted Install task. Click Next to set up return codes.

See “Setting up return codes” on page 223.


Scripted install for Windows Vista, Windows Server 2008, and later

The Scripted OS install for Windows Vista, Windows Server 2008 Server or later provides a wizard to help set up Vista, Windows Server 2008 and later installation
files and run sample jobs. Follow the steps in the wizard to identify the type of scripted install as Vista, Windows 2008 Server or later. You can gather all the files for Vista or Windows 2008 Server for the job, but the server does not build any answer file. Instead, you are asked for the location of the answer file. Also, a sample answer file is provided.

To perform a scripted install for Windows Vista and 2008 server

1. On the **Scripted Operating System Installation** page of the **Scripted OS Install** dialog, select the following options:
   - The operating system
   - Operating system language
   - Automation pre-boot environment

   **Note:** Ghost Solution Suite supports only WinPE environments.

2. Click **Next**.

3. From the **Select or add new OS source files** drop-down list on the **Installation Source Files** page of the **Scripted OS Install** dialog, select the operating system.

   Browse to the root directory of the ISO files of the OS that you are installing.

4. (Optional) You can select the required option from the **Select or add new service pack source files** drop-down list. Click **Next**.

5. Select the **Select a Diskpart tool** option on the **Partition and Format Disk** page of the **Scripted OS Install** dialog to partition and format the disk. Click **Next**.

   **Note:** You can select the **Continue without selecting Diskpart Tool** option to partition and format the hard disk using your own scripts and setup utilities.
6 On the **Scripted Operating System Installation** page of the **Scripted OS Install** dialog, browse to select the path of the unattended .XML file.

7 On the **Scripted OS Install Commands** page of the **Scripted OS Install** dialog, set the command-line options for the cmdlines.txt files and enter the Additional commands in the cmdlines.txt file. (See Command-line switches for scripted install.) Click **Finish**.

---

**Note:** If you want to use the sample answer files (Vista_unattend.xml and Longhorn_unattend.xml) provided by default in the Deploy folder of the Ghost Solution Suite Share, you must enter the product key (for the version you want to install) before you schedule the job. If you do not select the product key, the job fails.

See “**OS product key dialog**” on page 81.

---

### Scripted install for Linux

The Scripted OS install for Linux provides a wizard to help set up Linux installation files and run Sample jobs. Follow steps in the wizard to identify the type of scripted install and locate the answer files. You can also modify and run Sample deployment jobs to remotely run a scripted install on Linux servers and workstations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory</td>
<td>Browse to or enter the path and name of the Linux answer file (Kickstart file).</td>
</tr>
<tr>
<td>Command-line</td>
<td>Enter the command-line options.</td>
</tr>
<tr>
<td>Automation pre-boot environment (WinPE/Linux)</td>
<td>Select the required pre-boot environment from the drop-down list to perform the Backup and Restore task in the selected pre-boot environment. By default, the Default Automation (Auto-select) type is selected.</td>
</tr>
</tbody>
</table>

### Scripted install summary

View a summary of the selected options for the scripted install. Click **Back** to change any of these settings or click **Finish** to complete the Scripted Install task.
Distributing software

Send .MSI Packages, .CAB, .EXE, and other package files to selected computers or computer groups, including EBS, and .RPM files for Linux computers. This task identifies valid Ghost Solution Suite packages and assigns passwords and command-line options.

Distribute software packages to managed computers using the New Job Wizard or adding the Distribute Software task when building new jobs.

See “New job wizard” on page 162.
See “Building new jobs” on page 167.

To distribute software

1. Enter the name and location of the package to distribute in the Name field.

   Note: Information about the package appears in the Description field for valid packages. If no description appears, the file is not an .RIP or a Personality Package.

2. For .RIPs, if you set the password option when you created the .RIP, you must enter the password for the package to run.

3. Select Run in quiet mode to install the package without requiring user interaction.

4. Specify the users to associate with the .RIP or the Personality Package.
   - Select Apply to all users to run the package for all users with accounts on the computer.
   - If you want to send the package to a managed computer with multiple users and to install it for certain users with a unique password, clear the Apply to all users box.
     Example: To install an .RIP for a specific user account on a computer, add values to the Additional command-line switches field:
     -cu:“JDoe;TMaya;Domain\BLee”

     The command-line switches are specific to any package you are distributing that supports command-line options, such as .MSI and Personality Packages. For a complete list of command-line options, see the Wise MSI Product Guide and the Symantec PC Transplant Pro Product Guide.
5 If distributing an install package or other types of packages with associated support files, you can select **Copy all directory files** to install all peer files in the directory. Select **Copy subdirectories** to distribute peer files in the directory and all files in associated subdirectories.

---

**Note:** Some clients may have software installed on the client computer that, for protection against harmful software, only lets software programs on a list of "well-known" executables to run. Therefore, whenever the system administrator wanted to install a patch on client computers, he or she would have to update the well-known-executables list on all the client computers, which could be a lot of work.

---

To save the work of updating that list, or of manually renaming distribution packages, the RenameDistPkg feature was added. Now, the system administrator may update the well-known-executable list once with a filename of their choice. The well-known filename may be entered into the Windows registry of the Ghost Solution Suite Server computer (the computer running axengine.exe) as the Value data of a string value named RenameDistPkg under the HKEY_LOCAL_MACHINE\SOFTWARE\Altiris\Altiris eXpress\Options key. If the RenameDistPkg registry entry is set, Ghost Solution Suite Server renames the installation files that are copied to the client computers.

This feature only affects files that are temporarily copied to the client computer as part of a Distribute Software task. The file that is to be executed only during the installation, sometimes referred to as the package, is the file that is renamed, not the files that are actually installed to various locations on the target computer.

If the **Copy all directory files** option is enabled, only the main (installable) file is renamed.

6 Click **Advanced** to specify how files are distributed to the managed computer. You can copy through the Ghost Solution Suite Server, or copy directly from the file source and then run, or run directly from the file source. See Distribute software advanced. Click **Next**.

7 Provide additional command-line options for distributing software.
8  (Optional) Set Return Codes.
   See “Setting up return codes” on page 223.

9  Click Finish. The task appears in the Task list for the job. The software is distributed when you run this task.

   Note: When an .RIP or Personality Package is executed through Ghost Solution Suite Server, the quiet mode command-line option is applied. This means the user cannot interact with the user interface on the managed computer.

Note: When an .RIP or Personality Package is executed through Ghost Solution Suite Server, the quiet mode command-line option is applied. This means the user cannot interact with the user interface on the managed computer.

If the Personality Package is configured to run only if a particular user is logged in and only if the user has an account on the managed computer, the package runs the next time that user logs in. If the user does not have an account, the package aborts and sends an error back to the console through the Ghost Solution Suite. If the package is not run through the Ghost Solution Suite Server, a message appears on the managed computer and the user is prompted to abort or continue.

See "Modifying tasks in a deployment job" on page 219.

Distribute software advanced

Following are the fields and the description of the Distribute software > Advanced:

Table 5-11  Distribute software advanced

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy files using Ghost Solution Suite Server then execute</td>
<td>Select this option to distribute packages through the Ghost Solution Suite Server to the managed computer, requiring two file copy transactions if the Ghost Solution Suite Share is on another file server. This option is run for Simple installs and is the default option.</td>
</tr>
<tr>
<td>Copy directly from file source then execute.</td>
<td>Select this option to copy packages directly from the Ghost Solution Suite Share if this data store is located on another server (a Custom install). It copies the file and runs it, avoiding running through the Ghost Solution Suite Server and reducing processor output.</td>
</tr>
<tr>
<td>Run directly from file source</td>
<td>Select this option to run files remotely from the Ghost Solution Suite Share or another selected file server.</td>
</tr>
</tbody>
</table>
Table 5-11  Distribute software advanced *(continued)*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify user</td>
<td>Enter the user name and password for the client computer and the Ghost Solution Suite Share. Both must have the same user name and password (this is not an issue if both are on the same domain).</td>
</tr>
<tr>
<td>Run script in console user session</td>
<td>For Windows 2008, Vista, and Windows 7, you can see the output of jobs on a local desktop and use that output for debugging purposes. The script runs in a logged-in user's UI session. If no users are logged in, the job fails. DAgent can also run scripts in a console user session.</td>
</tr>
</tbody>
</table>

Capturing personality settings

The Capture Personality task lets you save personal display and user interface settings defined in the operating system for each user. You can create a Personality Package that you can save and distribute when migrating users. This task runs Symantec PC Transplant from the console to capture and distribute settings.

Capture personality settings using the New Job Wizard or adding the Capturing Personality task when building new jobs.

See “New job wizard” on page 162.

See “Building new jobs” on page 167.

To capture a personality

1. After creating a job, click **Add > Capture Personality**.

2. Enter the name of a personality template file, or browse and select a template. A default personality template is included in the PCT folder of the Ghost Solution Suite Share (DEFAULT.PBT). Enter the name of the folder where you want to store the package.

   The personality template lets you define the settings, files, and options to be captured during run time. Click **Template Builder** to open a wizard to build a custom template.

3. In **User account and folder login**, enter the login credentials for the managed computer from which the personality settings are captured, and the file server where the Personality Package is stored.
4 In **Package login**, enter a password for the Personality Package. This is a run-time password that is required when the Personality Package runs on the destination computer.

5 Click **Advanced** to specify additional features.

6 Set the **Advanced** options and click **OK**. Click **Next**. See “Capture personality advanced options” on page 204.

7 (Optional) Set Return Codes.
   See “Setting up return codes” on page 223.

8 Click Finish. You have now created a Capture Personality task, which appears in the Task list. You must schedule this task to capture a personality setting and save it as a PCT file in the selected location (most often in the PCT folder on the Ghost Solution Suite Server shared directory on the Ghost Solution Suite Share).
   See “Distributing personality settings” on page 205.

**Note:** To capture a personality on a Windows 98 computer, ensure that all users have Write access to the Ghost Solution Suite Server share (by default at C: Program Files\Altiris\eXpress\Deployment Server in a Simple install). Also, ensure that the User account and folder login fields are blank. A user must also be logged on at the client computer to capture the client profiles. An error is returned if you attempt to capture personality settings on Windows 9x computers that are not authenticated.

**Note:** Set the conditions on the job for either Windows 98 or Windows 2000, XP, 2003, 2008 and Vista computers to ensure that the appropriate Capture Personality task runs on the appropriate computers.

### Capture personality advanced options

**Table 5-12** Capture personality advanced options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain users</td>
<td>Select this option to capture personality settings for all domain users on the computer.</td>
</tr>
<tr>
<td>Local Users</td>
<td>Select this option to capture personality settings for all local users on the computer.</td>
</tr>
</tbody>
</table>
Table 5-12  Capture personality advanced options (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Specify users or groups to capture personality settings. Select the Custom check box and enter the Users or Groups you want to capture personality settings. Also, instead of specifying names, you can also select users who have been either created or accessed in the specified number of days.</td>
</tr>
<tr>
<td>Additional command-line switches</td>
<td>You can add command-line options specifically for the PC Transplant program that migrates personality settings. See the Symantec PC Transplant Reference Guide in the docs folder of the Ghost Solution Suite Share.</td>
</tr>
</tbody>
</table>

Distributing personality settings

The Distribute Personality task lets you save personal display and user interface settings defined in the operating system for each user. You can distribute Personality Packages to migrate personality settings. This task runs Symantec PC Transplant from the console to capture and distribute settings.

Distribute personality settings using the New Job Wizard or adding the **Distribute Personality** task when building new jobs. For more information about capturing personality settings to create a Personality Package, refer to the following section:

See “Capturing personality settings ” on page ?.

See “New job wizard” on page 162.

See “Building new jobs ” on page 167..
To distribute personality settings

1 In the **Name** field, enter the file name and location of the PCT file.

---

**Note:** The information about the Personality Package appears in the **Description** field for valid Personality Packages (PCT files). If no description appears, the file is not a valid package.

If you use a token, such as %COMPNAME%, in this field, and you proceed with the job, when you apply the job to a Windows XP computer, the user must enter input before the job completes. Symantec recommends you enter a valid Personality Package name and use the **Additional command-line switches** fields for token values. See the Symantec PC Transplant Reference Guide for a complete list of valid command-line options.

2 In the **Password** field, type the password set for the PCT file when created.

3 Select **Run in quiet mode** to install the package without displaying the PC Transplant screens.

4 Specify the users to associate with the Personality Package.
   - Select **Apply to all users** to run the package for all users with accounts on the specified computer.
   - If you want to send the package to a managed computer with multiple users and to install it for certain users with a unique password, clear the **Apply to all users box**.
     
     Example: To install a Personality Package for specific user accounts on a computer, add values to the **Additional command-line switches** field.
     
     Example:
     ```
     -user: J Doe; T Maya; B Lee
     ```

---

**Note:** The command-line options are specifically for Personality Packages. For a complete list of command-line options, see the Symantec PC Transplant Reference Guide.

5 (Optional) Click **Advanced** to specify how to copy Personality Packages to the managed computer. You can copy through Ghost Solution Suite Server and then run, or copy directly from the file source and then run, or run directly from the file source. See **Distribute personality advanced**. Click **OK**.

6 Click **Next**.
7  (Optional) Set Return Codes.  

See “Setting up return codes” on page 223.

8  Click Finish. The task appears in the Task list for the job. The personality is distributed when you run this task.

For more information about capturing a computer's personality settings, see the Symantec PC Transplant Help.

See “Modifying tasks in a deployment job” on page 219.

Distribute personality advanced

<table>
<thead>
<tr>
<th>Table 5-13 Distribute personality advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td><strong>Copy files using Ghost Solution Suite Server then execute</strong></td>
</tr>
<tr>
<td><strong>Copy directly from file source then execute</strong></td>
</tr>
<tr>
<td><strong>Execute directly from file source</strong></td>
</tr>
</tbody>
</table>


Table 5-13  Distribute personality advanced (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File source access and credentials</strong></td>
<td>Enter the user name and password for the client computer and the Ghost Solution Suite Share. Both must have the same user name and password (this is not an issue if both exist in the same domain).</td>
</tr>
</tbody>
</table>

### Modifying configuration

You can add a task to configure or modify the configuration of computer property settings using the **Modify Configuration** dialog. The Ghost Solution Suite updates the property settings and restarts the computer for changes to take effect.

**To modify configuration**

1. After creating a job, double-click the job, and click **Add > Modify Configuration**.
2. Select the **Reboot after Configuration** check box to restart client computer after the configuration changes are complete. By default, the check box for **Reboot after Configuration** is selected.
3. Enter or edit the property settings in the **Configuration** dialog. Click the category icons in the left pane to set additional values for each property setting group.
   
   See “Computer configuration properties” on page 103.
4. Click **Next**.
5. (Optional) Set Return Codes.
   
   See “Setting up return codes” on page 223.
6. Click **Finish**. The task appears in the Task list for the job. The configuration is modified when you run this task.
   
   See “Modifying tasks in a deployment job” on page 219.

### Backing up and restoring registry files

**Note:** This feature has been deprecated and removed from the product in a later release.
Copy registry files of selected computers using the Back Up Registry task and save the registry file settings to a selected directory. You can also create a Restore Registry task to copy the registry settings to a managed computer.

Copy registry settings by adding the Back Up Registry task when building new jobs. Restore registry settings by adding the Restore Registry task.

See “Building new jobs” on page 167.

To back up and restore registry files

1. Enter the directory path to back up or restore registry files.

2. The Computers with registry files in this directory field displays the names of the computers whose registry files will be captured in this directory.

3. Select the required pre-boot environment from the Automation pre-boot environment (WinPE/Linux) drop-down list to perform the Backup and Restore task in the selected pre-boot environment. The Default Automation (Auto-select) type is selected.

4. Click Advanced if Windows was installed on client computers in a directory other than the default. Enter the correct path to the root of the Windows directory.

   ■ Select Include registry information for all users to back up registry keys for all user accounts.

   Note: If you clear this check box, only the Administrator and Guest user accounts are backed up or restored.

5. Click Next.

6. (Optional) Set Return Codes.

   See “Setting up return codes” on page 223.

7. Click Finish. The task appears in the Task list for the job.

See “Modifying tasks in a deployment job” on page 219.

Getting inventory

Use this task to gather inventory from an individual computer or a group of client computers. This ensures that the Ghost Solution Suite Database is updated with the latest computer properties information, which includes the following information:

■ Applications
Location is the only area that administrators can manually enter if they want to. The Ghost Solution Suite software gathers the other information from each computer. You can view the history of the Get Inventory task in the Computers History pane. See “Viewing computer details” on page 97.

- Click Add and select Get Inventory from the list. The Get Inventory task appears in the list.

Running a script

Select an existing script or write a new script file to run on selected managed client computers.

Run script files on client computers by adding the New Script task when building new jobs. See Script information to identify how the script appears, script security, and an option for server-side execution of the script.

See “Script information” on page 211.

See “Building new jobs” on page 167.
To run a script

1. If you have a script file defined, select Run Script and browse to select the file. To read or edit the script file, click Modify.

   **Note:** To run scripts that call an executable, use the start command.

   Example: Enter `start C:\windows\notepad.exe` to open the Notepad application on the client computer.

2. To create a new script, click Run Script. Enter the script in the provided field, or click Import and select a script file to import. After you import the script, you can modify it in the provided field.

3. Specify the operating system to run the script. You can choose Windows, Linux, or Mac OS X. Click **Next**.

4. Set Script Information. See Script information. Click **Next**.

   See “Script information” on page 211.

5. (Optional) Set Return Codes.

   See “Setting up return codes” on page 223.

6. Click Finish. The task appears in the Task list for the job. The script runs when you run this task.

   **Note:** The Ghost Solution Suite Server assumes a return code of zero (0) as a successful script execution. Some programs return a code of one (1) to denote a successful script execution. If a program returns a one (1), you see an error message at the Ghost Solution Suite Console even though the script ran correctly. To modify the return codes, you can edit the script file to return a code that the console interprets correctly.

See "Modifying tasks in a deployment job" on page 219.

### Script information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the client computer</td>
<td>This option runs the script on the managed computer to which you assign the job</td>
</tr>
</tbody>
</table>
Table 5-14  Script information (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locally on the Ghost Solution Suite Server</td>
<td>This option runs a server-side script on the Ghost Solution Suite Server of the managed computer. In most cases you can create a server-side script task that runs in context with other tasks. Example: You can add a task to image a computer and add a task to execute a server-side script to post the imaging return codes to a log file stored on the Ghost Solution Suite Server computer. Use the -id option for running scripts on Ghost Solution Suite Server when using the WLogEvent and LogEvent utilities. See “Using LogEvent and WLogEvent in scripts” on page 214. Note: You cannot use this feature to run scripts that require user intervention. The script runs on the Ghost Solution Suite Server of the managed computer, but is not visible. When running the script on the Ghost Solution Suite Server, it runs specifically for the assigned managed computer. Example: If you create a job with a script to run locally on the Ghost Solution Suite Server and assign the job to 500 computers, the script runs on the Ghost Solution Suite Server 500 times.</td>
</tr>
</tbody>
</table>

Client run environment

Select the environment for your client computer. You can run the script either in production mode or in automation mode.
### Table 5-15  Client run environment

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Production - Client-installed OS</td>
<td>(Windows/Linux/Mac OS X) Security Context</td>
</tr>
<tr>
<td></td>
<td>■ Default (local system account). Use the network security account established to administrate all managed computers.</td>
</tr>
<tr>
<td></td>
<td>■ Specific user. If you have selected to run the task on the local Ghost Solution Suite Server, enter an administrator user name and password for that Ghost Solution Suite Server account. In most cases Ghost Solution Suite Server does not have the Ghost Solution Suite installed, which prohibits it from using a network security account.</td>
</tr>
<tr>
<td></td>
<td>■ Run script in console user session For Windows 2008 and Vista, you can see the output of jobs on a local desktop and use that output for debugging purposes. The script runs in a logged-in user's UI session. If no users are logged in, the job fails.</td>
</tr>
<tr>
<td></td>
<td>■ Scripts run in an elevated mode, which skips the usual consent step through a user access control (UAC). Otherwise, someone must physically go to the remote computer and approve the action to allow the script to run.</td>
</tr>
<tr>
<td>Script Window</td>
<td>From the drop-down list, select how you want the script window to appear: minimized, normal, maximized, or hidden.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This option is available only for Windows environment.</td>
</tr>
</tbody>
</table>
Table 5-16  Script Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional command-line switches</td>
<td>Additional command-line switches. Enter commands to execute when the script runs in Windows, Linux, or Mac OS X.</td>
</tr>
<tr>
<td>Automation pre-boot environment (WinPE/Linux/Mac OS X)</td>
<td>Select this option to run the script in an automation environment. Select a pre-boot automation environment from the drop-down list.</td>
</tr>
</tbody>
</table>

If you select Linux as the operating system type, the **Locally on the Ghost Solution Suite Server** option is disabled and only the **Additional command-line switches** under the **Production Client installed OS (Windows/Linux/Mac OS X)** is enabled.

**Example script**

The process to convert NT4 from FAT16 to NTFS normally returns a 1 after a successful completion. The following is an example of the file that is modified to return a code of 0 (which is the success code recognized by the Symantec Management Console and utilities). You can make similar changes to your script files as needed.

```
CONVERT /FS:NTFS
if ERRORLEVEL 1 goto success
goto failure
:succcess set ERRORLEVEL = 0
goto end
:failure
echo Failed
set ERRORLEVEL = 1
goto end
:end
```

**Using LogEvent and WLogEvent in scripts**

The logging features, LogEvent and WLogEvent, accommodate detailed logging to help debug complex scripts. These utilities include the following features:

- Logging is stored in the database instead of a log file.
The console displays and works with the new status messages. LogEvent posts status sends messages to the Ghost Solution Suite Console, letting you view the status of the script. It is a light-weight reporting tool that can log both status strings and status codes to the history file and the console.

**LogEvent** - Use the LogEvent utility for Linux scripts.

**WLogEvent** - Use the WLogEvent utility for Windows scripts.

The LogEvent and WLogEvent utilities are command-line driven only - there is no user interface. Use both utilities with the following switches.

```
LOGEVENT -c:code -id:%ID% -l:level -ss:"message"
```

code is any number for a return code level.

id is used for server-side scripting only. For server-side scripts you must add the -id:%ID% switch.

See the **Locally on the Ghost Solution Suite Server** option in Script Information to select a server-side script. See “Script information” on page 211. level is the severity level. The following levels are used:

- 1 = Information message
- 2 = Warning message
- 3 = Critical failure message. Only this level can be used to set up a return code. See “Setting up return codes” on page 223.. The response does not execute for a return code unless a level 3 is specified when using the LogEvent and WLogEvent command in a script.

message is the status string. If spaces exist in the message, the string must be contained in quotes. Specifying a severity level of 3 causes the script job to fail.

**Example scripts**

```rem
REM Bootwork unload
Set ImageName=F:\Images\XPIntel.img
rdeploy -mu -f%ImageName% -p1
logevent -l:1 -ss:"Created %ImageName%.
"
REM Execute WLogEvent.exe from CMD script
REM This script requires WLogevent.exe to reside on the client
REM in the temp directory.
\WLogevent.exe -c:0 -l:1 -ss:"Running Dir on %NAME%"
dir
```
Copying a file

Copy all types of files to managed computers. You can send selected files or directories to a computer or computer group.

Send files to client computers by adding the Copy File to task when building new jobs. Use the Copy File to operation (see Remote operations using Ghost Solution Suite ) to copy files quickly from Computers pane in the console.

See “Building new jobs ” on page 167.

To copy a file

1. Select either the **Copy File** or **Copy Directory** option. When you select the Copy Directory option, select Copy Subdirectories to copy all subdirectories.

2. Enter the directory path and name of the file or directory. The Source path defaults to the Ghost Solution Suite Share, but you can enter or browse to a file or directory.

   To copy files or directories through the Ghost Solution Suite Server from the Ghost Solution Suite Share, you can enter a relative path in this field. To copy files or directories directly from the Ghost Solution Suite Share to the managed computer, you must enter the full UNC path name.

   See “Copy file to advanced ” on page 217.

---

**Note:** When entering the source path for copying files through the Ghost Solution Suite Server, you can only access the shared directories through an established user account. Specifically, you can only use UNC paths when you have sufficient authentication rights established.

---

3. Select the **Allow to run in automation** check box to run this task in automation mode.

   **Note:** This option is only applicable for Linux and WinPE automation.

---

4. Type the destination path. The **Destination path** field automatically enters a sample path, but you can enter the directory path you require. If the destination path does not exist on the destination computer, it is created.
5. Click **Advanced** to specify additional features to copy files through the Ghost Solution Suite Server or directly from a file server. Click **Next**.

6. (Optional) Set **Return Codes**.
   
   See “Setting up return codes” on page 223.

7. Click **Finish**. The task appears in the Task list for the job. The file is sent to the specified location when you run this task.
   
   See “Modifying tasks in a deployment job” on page 219.

### Using location variables

Location variables are being added to the Ghost Solution Suite Server for the Copy Files feature, letting you enter a token variable instead of requiring a complete location path when copying files to a managed computer (a client computer running the Ghost Solution Suite).

Ghost Solution Suite supports long names in the REM replacetoken command. If your file name includes spaces, enclose the file name in quotes so that it handles correctly.

The current variables include:

**Temp**. Enter Temp in the Destination path to set the Temp directory (identified in the system path) for the managed computer. Example: Instead of entering `C:\windows\temp\setup.exe` in the Destination path, enter `temp:setup.exe`.

### Copy file to advanced

| Table 5-17 Copy file to advanced |
|---|---|
| **Field** | **Description** |
| **Copy files using Ghost Solution Suite Server** | This option distributes software packages through the Ghost Solution Suite Server to the managed computer, requiring two file copy transactions if the Ghost Solution Suite Share is on another file server. Use this option for Simple installs to take advantage of security rights defined by the Ghost Solution Suite Server. You can use a relative path name entered in the **Source Path** field in the **Copy Files** dialog. This is the default option. |
### Table 5-17  Copy file to advanced (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy directly from file source</td>
<td>Click this option to copy packages directly from the Ghost Solution Suite Share, sending only one copy across the network. It copies the file directly to avoid running through the Ghost Solution Suite Server and diminishes processor output. Because the Ghost Solution Suite Agent doesn't recognize shared rights and is not guaranteed to have a mapped drive to the data source, you need to identify a user name and password for the data share computer from the target computer. This option also requires a full UNC path name in the Source Path field in the Copy File dialog.</td>
</tr>
<tr>
<td>File Source logon</td>
<td>Enter the user name and password for the client computer and the Ghost Solution Suite Share. Both must have the same user name and password (this is not an issue if both exist in the same domain).</td>
</tr>
</tbody>
</table>

**Note:** Windows 98 computers have security limitations when copying files directly from the source to the Ghost Solution Suite using the UNC path name. We recommend that you use the Copy files using Ghost Solution Suite Server option for these types of computers or plan a proper security strategy for direct copying.

---

**Power control**

Start the computer using Wake on LAN or run standard power control options to restart the computer, shut down, or log off the current user.

Wake up, shut down, or log off client computers by adding the Power Control task when building new jobs. See “Building new jobs” on page 167.

**To manage power control**

1. Create a job.
2. Click Add > Power Control.
3. Select an option: Restart, Shut down (if available), Log off, or Wake up (send Wake-On-LAN).
4. Select Force application to close without a message, if required. Click Next.
5 (Optional) Set Return Codes.
   See “Setting up return codes” on page 223.
6 Click Finish. The task appears in the Task list for the job.

Waiting

Use the Wait task to boot a computer in the automation mode and wait for user interaction.

To use the Wait task toolbar
1 Create a job.
2 Click Add > Wait.
   The Wait dialog appears.
3 Select the appropriate pre-boot environment from the drop-down list. Click Next.
4 (Optional) Set Return Codes.
   See “Setting up return codes” on page 223.
5 Click Finish. The task appears in the Task list for the job.

Modifying tasks in a deployment job

You can build jobs by adding or modifying deployment tasks. You can modify the tasks in a job that is already scheduled on any computer. The job will run the modified tasks according to the previously set schedule.

If the task (image, batch file, executable, and so on) is saved in the product directory, it appears on your Resources list in the Shortcuts pane. Simply drag it to an existing job to add it.

To add a task to a job immediately
1 In the Jobs pane, double-click the job you want to modify.
2 Click Add and select another task from the menu.
3 Follow the basic instructions on each dialog provided for each task. Select the type of task you want to add and follow the directions.
4 After finishing task configuration, a new task appears in the Jobs list.
5 Change the order of the tasks using the up and down arrows. The tasks run in the order listed.
Use the steps below to copy and paste tasks within the same job, or from one job to another. You can use CTRL+C and CTRL+V to copy and paste tasks.

To copy and paste a task

1. In the Jobs pane, click the job that contains the task you want to copy.
2. In the Details pane, right-click the task, and select Copy. (To copy multiple tasks, press the CTRL key and select the desired tasks. The tasks that are highlighted are copied when you select Copy.)
3. In the Jobs pane, click the destination Job where you want to paste the task.
4. Right-click in the Details pane and select Paste. The tasks appear at the bottom of the task list, and use the condition settings of the current job.
5. Change the order of the task using the up and down arrows. The tasks run in the order listed.

To modify a task in a job

1. In the Jobs pane, double-click the job you want to modify.
2. Select the desired task from the list.
3. Click Modify and follow the directions to make the required changes. Click OK.

To remove a task from a job

1. In the Jobs pane, double-click the job you want to modify.
2. Select the task you want to remove from the task list. Click Delete.
3. Click OK.

Use the steps below to copy and paste tasks within the same job or from one job to another. You can also use CTRL+C and CTRL+V to copy and paste tasks.

To copy and paste tasks

1. In the Jobs pane, click the job that contains the task you want to copy.
2. In the Details pane, right-click the task and select Copy. (To copy multiple tasks, press the CTRL key and select the desired tasks. The tasks that are highlighted are copied when you select Copy.)
3. In the Jobs pane, click the destination Job where you want to paste the task.
4. Right-click in the Details pane and select Paste. The tasks appear at the bottom of the task list and use the current condition settings of the destination job.
5. Change the order of the tasks using the up and down arrows. The tasks execute in the order listed.
To add a new task to an existing task list

1. Select a job from the Jobs pane.
2. Click on one of the tasks within the job and add a new task. The new task is inserted above the task you highlighted, and all other jobs shift down by one position.
3. Use the up and down arrows to change the order of the tasks within the job.

Modifying multiple modify configuration tasks

If you have scheduled multiple Modifying Configuration tasks to a computer group, you can double-click Modify Configuration in the task list of the Details pane to modify each computer's configuration settings independently.

In the Jobs pane, click the job with a Modify Configuration task. Double-click the Modify Configuration task.

A message appears. Click YES to modify configuration settings individually for each scheduled computer. Click NO to modify the Modify Configuration task when the job is scheduled again (the current job sends modified configuration files already created).

If you click YES, a Modify Job Wizard appears with a list of each managed computer scheduled to change configuration settings. Select one or more computers and click Next.

To modify multiple modify configuration task

1. In the Computer Configuration Properties property page, modify the settings. Click Next.

   See “Computer configuration properties” on page 103.

2. Set Return Codes.

   See “Setting up return codes” on page 223.

3. Click Finish.

Creating new script files

You can create script files and directly schedule the script file to run scripts on any computer or computer groups.
To create new script files

1. Go to View > Shortcuts View.
2. Click Resources in the Shortcuts view to move the focus to the Resources view.

---

**Note:** The Script File option is activated only if the focus is on the Resources view.

---

A script file is created by default at the root of the resources. The default file name is Batch.bat.

4. Right-click the Batch.bat file, and select Modify.

---

**Note:** You can rename the batch file by right-clicking the file and selecting Rename.

---

5. Type the script in the open file, and save it.
6. Drag the Batch.bat file to a computer or computer group where you want to schedule the job.
7. Specify the scheduling options, and click OK.

See “Building and scheduling jobs” on page 159.

### Copy and paste jobs and job folders

Jobs or job folders (including their subfolders) can be copied to any other job folder in the left pane of the Jobs pane of the Ghost Solution Suite Console. A Job folder can only be copied to a root level folder, which has a limit of 30 subfolders, and cannot be copied to a child level folder.

If you copy a job or folder with the same name as the destination job or folder, the copied job or folder is automatically named Copy of <job or folder name>. This feature can only be performed by administrators or users who have permissions to create jobs or job folders.

To copy jobs and job folders

1. In the Jobs pane, right-click a job or job folder you want to copy, and click Copy.
2. In the Jobs pane, right-click the destination job folder and click Paste.
Importing and exporting jobs

Jobs can be exported to back up the Ghost Solution Suite Server data or to share jobs between Ghost Solution Suite Server installations.

To import jobs
1. Right-click in the Job pane, and select Import
   or
   Click File > Import/Export > Import Jobs.
2. Browse to or enter the path and name of an existing import file (.BIN file).
3. Select Import to Job Folder to import the jobs to an existing folder in the Jobs pane. If you have a folder already selected, it appears in the edit field.
4. Select Overwrite existing Jobs and Folders with the same name to replace identical jobs and folders.
5. Select Delete existing Jobs in folder to overwrite and replace all jobs in the selected Jobs folder. Click OK to import the job(s).

To export jobs
1. Right-click the job or Jobs folder you want to export and select Export.
   or
   Click File > Import/Export > Export Jobs.
2. Select the destination folder and enter a file name.
3. Click Export subfolders to export all folders subordinate to the selected job folder.
4. Click OK.

Setting up return codes

When you create a task in a job, you can define a response to specific return codes generated from that task after it runs. You can determine the response if the task runs successfully or if the task fails. You can also set up custom return codes generated from scripts or batch files that are unique to your environment or deployment system.

Note: Return code handling cannot be set up for jobs created in the New Job Wizard.
When creating a task, the **Return Codes** page appears so you can set a response if the task was successful or to determine a default response if the task failed. Because Ghost Solution Suite Server returns a 0 (zero) if the task runs successfully, any other return code value denotes some type of failure in running the task. As a result, in the **Success** field you can select an action if the return code is 0 (zero), or select an action in the **Default** field if the return code is not a 0 (zero).

Return codes are first evaluated to be successful (zero) or failed (non-zero). If the task returns as successful, it runs the action specified in the **Success** field. If it is not successful, it determines if the return code has been assigned a custom code value. If the return code is defined as a custom code, the selected action for that custom code runs. If no custom code is assigned to the return code, the action set in the default runs.

---

**Note:** If you are using LogEvent and WlogEvent in Scripts, you can generate return codes only when the level 3 message is specified. Specifying a severity level 3 causes the script job to fail and lets you respond using this return code feature.

### Return code actions

For both successful tasks (in the **Success** field) and failed tasks (in the **Default** field), you can specify the following actions:

- **Stop**
  - This action stops the job after the task runs. Subsequent tasks do not run.

- **Continue**
  - This action lets the subsequent tasks in the job continue after the task runs.

- **Select a job.**
  - This action lets you select existing jobs to run after the task completes.

These actions also apply to custom return codes designed specifically for your system.

### Custom return codes

In the **Other return codes** field, you can view custom return codes set specifically for your system. You can add return codes by clicking **Add below the Other return codes field**, or by clicking **Master Return Code**.

Type a custom code in the **Code** field, select a response action from the **Response** list, select the result from the **Result** list to specify the interpretation of this return code as Success or Failure, and provide a message in the **Status** field.

These custom codes can respond to any return codes set up in scripts or batch files in the **Run Scripts** task, or these custom codes can respond to system return codes.
codes thrown from the Ghost Solution Suite Server or external codes generated when distributing applications, personality settings, or disk images. Any task can have custom codes that respond to different return code values.

**Master Return Code List.** This is a list of all the return codes existing in the Ghost Solution Suite Database. You can add, modify, and delete the codes and their values so that setting codes for other tasks is easier.

**Add**

This lets you add a new custom return code for the task. You can also add the return code to the Master Return Codes list.

**Modify**

This lets you modify the return codes listed in the Other return codes field. The changes you make do not update the Master Return Codes list.

**Delete**

This lets you delete return codes listed in the Other return codes field, but not from the Master Return Codes list.

**To set up master return codes**

The Master Return Code List dialog lets you:

- Add, modify, and remove return codes in the master list.
- Select return codes for the current job from the drop-down list.

**To add master return codes**

1. Select a job from the Jobs pane.
2. Click Add in the right pane to add a task. Select the task. The Task dialog appears.

   **Note:** You can add Master Return Codes for all tasks except Get Inventory.

3. Click Next until the Return Codes page appears.
5. Click Add. The Add Return Code dialog appears.
6. Enter the return code in the Code field and click OK. The code is added to the master list.
To modify Master Return Codes

1. Click Modify. The Modify Return Code dialog appears.
2. Enter data in the Response, Result, and Status fields and click OK. The code is modified.

To delete master return codes

1. Select the code you want to delete and click Delete. A warning message appears to confirm the deletion.
2. Click Yes. The selected return code is deleted from the Master list.

Note: The OK and Cancel options in the Master Return Code List dialog apply to the return codes selected. If no return codes are selected, or none exist in the list, OK is disabled. Click OK on the Master Return Code List dialog to add the selected return codes to the current job.

To set up return codes, you need to determine how to respond to the Ghost Solution Suite Server success return code (zero) in the Success field, how to respond to a failure return code (a non-zero) in the Default field, and how to respond to a custom or externally generated return code defined in the Other return codes field.

The following example describes how to set up a simple process to deal with custom and system return codes, and how to interpret the status of user-defined return codes:

To set up return codes

1. In the Success drop-down list on the Return Codes page, keep the default value Continue. This lets the job continue running additional tasks in the job after successfully completing this task.
2. Click Add to add custom return codes. The Add Return Code dialog appears.
3. In the Code field, enter a value of 10 (ten).
4. Click the Response drop-down arrow and select Continue from the list.
5. Click the Result drop-down arrow and select Success from the list. Even if the return code was not zero, which is success by default, the task is considered a success as per the user’s choice.
6. Enter a description for the return code in the Status field. This is the message that appears when the task within a selected job runs.
7 Select the **Add to Master return code list** check box to add the custom code to the master return code list. The code is listed in both the Other return codes and Master Return Codes lists. This is useful if you want to use the return code again. Click **OK**.

8 If the code you added already exists, a message dialog displays the return code and asks if you want to replace it. Click **Yes** to replace the return code, and click **No** to return to the **Add Return Code** dialog.

9 Select the **Select a job** option from the **Default** drop-down list to select a job to run when a default condition is reached. The **Select a Job** dialog appears, letting you select an existing job that runs if the task returns a failed system return code (non-zero) or a return code not defined as a custom return code.

---

**Note:** The status of the tasks executed in a job also appears in the history of a computer.

---

### Sample jobs

Sample jobs are installed with each Ghost Solution Suite Server system, letting you quickly modify or add parameters, or to run the sample jobs as they are. During installation, jobs are automatically imported from the samples.bin file to the Ghost Solution Suite Server system where they can be viewed in the **Samples** folder in the **Jobs** area of the Ghost Solution Suite Console. Click each job and identify its features in the **Description** field of the **Details** pane.

Jobs in each folder marked with an asterisk (*) require input parameters or other minor modifications added before running on your system. These modifications let you add parameters to the job, such as user name and password or other required data for the job to be functional. Jobs requiring input parameters or customizing do not function properly if you do not edit the job with the information specific to your environment.

All files without an asterisk (*) can be used to perform the identified functions without modification. However, if the job conditions are not met or are not consistent with the computer type, you may get an error.

---

**Note:** When upgrading versions of Ghost Solution Suite, we recommend that you copy and rename modified sample jobs to avoid overwriting by new sample jobs.
Symantec Backup Exec System Recovery (BESR) sample jobs

Ghost Solution Suite includes several BESR sample jobs.

For more information on BESR, see http://www.symantec.com and search for Symantec Backup Exec System Recovery.

Initial deployment

Initial Deployment is a default job designed to help in the process of setting up computers that do not exist in the Ghost Solution Suite Database. Initial Deployment lets you define how computers are initially set up after being identified by the Ghost Solution Suite Server.

You can define various computer configuration sets and deployment jobs for the user during startup, letting the user select the computer settings and hard disk images, software, and personality settings for their specific needs and environment. New computers appear in the New Computers group in the Computers pane of the Ghost Solution Suite Console.

To access Initial Deployment, double-click Initial Deployment from the Jobs pane or right-click Initial Deployment and click Properties. The Properties of Initial Deployment dialog appears.

Initial Deployment is ideal for small-scale deployments, from 1 to 10 computers. We do not recommend this feature for large deployments -- from 10 to 100 computers -- or mass deployments -- from 100 to 5000 computers. We also do not recommend this feature where you use virtual computers, customized jobs, and the computer import feature.

Although Initial Deployment is commonly used on computers that support PXE, you can also configure a boot disk to run Initial Deployment. In this case, the image you deploy must include automation pre-boot environment so that post imaging tasks can run successfully. Installing an Automation Partition on the client computer’s hard disk ensures that future imaging deployment jobs run successfully.

Note: To completely deploy and configure a computer using Initial Deployment, you must define at least one Configuration and one Job.

Initial Deployment consists of a dialog with the following tabs with separate features to deploy new computers:

- Configurations
Click the **Configurations** tab on the Initial Deployment dialog to configure different sets of computer properties. Each configuration set is presented to the user as a menu. The user can select the configuration set designed for their environment. Compare the Configurations tab with the Jobs tab. See Jobs.

**Note:** If you do not create any configuration sets, the deployment process automatically sets TCP/IP information to use DHCP and names the computer to match the computer’s asset tag, serial number or MAC address -- in that order, depending on what is available.

---

**To create configurations**

1. Double-click **Initial Deployment** in the **Jobs** pane drop-down list. The **Properties of Initial Deployment** dialog appears.
2. Click the **Configurations** tab.
3. Click **Add**. A configuration set appears in the **Configurations menu** field. The **Configuration** page of the New Job Wizard appears.
4. Enter values to set computer and network properties for new computers. See Modifying configuration for a list of property categories.
5. Click **Add** again to configure another set of property settings. You can add multiple configuration sets for the user to select from a menu after connecting to Ghost Solution Suite Server. You can modify, rename, or delete a selected configuration set.
6. After setting the properties, click **Apply**.
7. From the **Default Menu choice** drop-down list, select a configuration set as the default.
8. Click the **Timeout after ____ seconds** and proceed check box and specify the time after which you want to run the default job.
9. Click **OK**, or click the **Jobs** tab to define a task.
Advanced Configuration

Click Advanced on the Configurations tab to open the Advanced Configuration dialog. This dialog lets you set advanced configuration settings for client computers and provides different options for processing jobs for client computers.

- Select **Process this job as each client becomes active**. This job is processed only when clients become active.
- Select **Process this job in batch mode**. This job is processed for a batch of clients for the Minimum clients specified and after the specified Timeout in minutes.
- Select **Hold all clients until this time**. You can specify the Start time for this job, which runs for all clients at the specified time.
- Click **OK**.

Jobs

Click the Jobs tab on the Initial Deployment dialog to add existing jobs or create new jobs to run on the new computer. The jobs you add or build using this dialog are listed in a menu and presented to the user during startup. The user can select the deployment jobs to image the computer and install applications and personality settings. Compare the Jobs tab with the Configurations tab. See “Configurations” on page 229..

To create Initial deployment job

1. Click Initial Deployment in the Jobs pane drop-down list. The Properties of Initial Deployment dialog appears.
2. Click the Jobs tab.
3. Click **New** to build a new job. The Select a job dialog appears. See “Building new jobs” on page 167. Select a folder in which you want to create the job. Click **OK**. The Job Properties dialog appears.
4. Click **Add Existing** to add an existing job.
5. From the Default menu choice drop-down list, select a job as the default.
6. Click the **Timeout after ____ seconds** and proceed check box and specify the time after which you want to run the default job. The default setting is 60 seconds.
7. Click **OK**, or click the Advanced tab to stop servers or workstations from running configuration task sets and jobs automatically. See also Sample jobs.
Advanced

Click the Advanced tab to set options to stop Initial Deployment from automatically running the default configuration task sets and jobs. This avoids accidental re-imaging or overwriting of data and applications for either workstations, such as desktop and laptop computers, or servers, such as Web and network servers identified by Ghost Solution Suite Server.

When a computer not yet identified by the Ghost Solution Suite Database is first detected, it is placed in the New Computers group and an Initial Deployment configuration set and job is run. However, in many cases you do not want Web or network servers to be automatically re-imaged without confirmation from IT personnel.

- Select Servers to stop servers from automatically running Initial Deployment configuration jobs. Servers are identified as the managed computers running multiple processors or identified as a specific server model from specific manufacturers. Example: Both an HP Proliant computer and a Dell computer with multiple processors are identified as servers. Identifying a computer as a server by the operating system cannot be accomplished for new computers until the server operating system has been installed.

- Select Workstations/Clients to force desktop and laptop computers to stop before automatically running Initial Deployment.